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Cisco MetroPlanner による
ネットワーク設計

Cisco MetroPlanner には、ソフトウェアのカスタマイズ、ネットワークの作成および分析、Bill of

Material（BoM; 部品表）の作成を行うためのさまざまなツールが用意されています。Cisco

MetroPlanner を使用すると、次の作業を行うことができます。

• 2.1　Cisco MetroPlanner の起動（p.2-2）

• 2.2　Cisco MetroPlanner オプションの設定（p.2-7）

• 2.3　プロジェクトの作成（p.2-25）

• 2.4　ネットワークの分析（p.2-41）

• 2.5　ネットワーク レポートの表示（p.2-42）

• 2.6　プロジェクトの編集（p.2-70）

• 2.7　ネットワーク設計の管理（p.2-90）

• 2.8　BoM の作成（p.2-94）

• 2.9　価格表の管理（p.2-100）

（注） Cisco MetroPlanner を実行するには、Java 2 Platform Standard Edition（J2SE）のバージョン 1.4.2_04
または 1.5 Java Runtime Environment（JRE; Java ランタイム環境）をインストールする必要がありま

す。両方ともサポートされますが、1.5 を推奨しています。1.5 は次の URL からダウンロードでき

ます。

http://java.sun.com/j2se/1.5.0/download.jsp
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第 2 章      Cisco MetroPlanner によるネットワーク設計

2.1　Cisco MetroPlanner の起動
2.1　Cisco MetroPlanner の起動
Cisco MetroPlanner Release 7.0.1 を起動する手順は、次のとおりです。

（注） Cisco MetroPlanner Release 7.0 に初めてログインする前に、すべての登録ユーザが新しいパスワード

を取得している必要があります。

ステップ 1 Cisco MetroPlanner R7.0 のアイコンをダブルクリックして、Cisco MetroPlanner を起動します。Cisco

MetroPlanner 7.0 Login ダイアログボックスが表示されます（図 2-1）。

図 2-1 Cisco MetroPlanner 7.0 Login ダイアログボックス

ステップ 2 Login フィールドにユーザ名を入力します。

ステップ 3 Password フィールドにパスワードを入力します。

Cisco MetroPlanner では、正しいパスワードを入力する機会が 3 回あります。最初の 2 回について

は、無効なパスワードを入力すると、「Incorrect Password or Login. Please try again」というエラー メッ

セージが表示されます。3 回めも無効だった場合は、「Failed to provide correct password or login, exiting

application」というエラー メッセージが表示され Cisco MetroPlanner が終了します。

ステップ 4 Cisco MetroPlanner にユーザ ログイン名およびパスワードを保存させる場合は、Remember login and

password を選択します。
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第 2 章      Cisco MetroPlanner によるネットワーク設計

2.1　Cisco MetroPlanner の起動
ステップ 5 Choose a profile type ドロップダウン リストから、次のいずれかのプロファイルを選択します。

• Network Designer

• Base Network Designer

『Cisco MetroPlanner DWDM オペレーション ガイド』の手順はすべて、Network Designer のアクセス

権があるユーザを想定して書かれています。プロファイルおよび対応する機能の詳細については、

表 2-4 を参照してください。

ステップ 6 [OK] をクリックして Cisco MetroPlanner を開きます。Cisco MetroPlanner ウィンドウの右下に、ログ

イン プロファイル タイプが表示されます。

2.1.1　プロジェクトの開き方

既存の Cisco MetroPlanner プロジェクトを開く手順は、次のとおりです。新規プロジェクトを作成

する場合は、「2.3　プロジェクトの作成」（p.2-25）を参照してください。

ステップ 1 Tasks Pane で Open の下のプロジェクト名をクリックします（図 2-2）。プロジェクトが開きます。リ

ストのプロジェクト名が表示されない場合は、ステップ 2 に進みます。

ステップ 2 Tasks Pane または File メニューで、Project の下の [Open] をクリックします。

図 2-2 Tasks Pane からプロジェクトを開く方法

ステップ 3 Open Project ダイアログボックスで、目的のディレクトリに移動してプロジェクトを選択します。

[Open] をクリックします。Cisco MetroPlanner プロジェクトが表示されます。
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第 2 章      Cisco MetroPlanner によるネットワーク設計

2.1　Cisco MetroPlanner の起動
2.1.2　ネットワークのロードおよびアンロード

プロジェクトの各ネットワークにメモリが必要です。メモリ節約のため、Cisco MetroPlanner はプロ

ジェクトを開くときに、すべてのネットワークを Unloaded ステートにします。Project Explorer で

は、アンロードされたネットワークはネットワーク ID の横に「U」が示されます（図 2-3）。アン

ロードされたネットワークをロードするには、Project Explorer でネットワーク フォルダをダブルク

リックするか、またはネットワークを右クリックして、ショートカット メニューから Load を選択

します。

図 2-3 Project Explorer におけるアンロードされたネットワーク

Project Explorer では、ロードされたネットワークはネットワーク ID の横に「L」が示されます（図

2-4）。ロードされたネットワークをアンロードするには、Project Explorer でネットワーク アイコン

を右クリックし、ショートカット メニューから Unload を選択します。

図 2-4 Project Explorer におけるロードされたネットワーク

2.1.3　プロジェクトの保存

プロジェクトを保存する手順は、次のとおりです。

ステップ 1 次のいずれかを選択します。

• 同じファイル名で既存プロジェクトを保存する場合は、File > Save の順に選択します。この手

順は、これで完了です。

• 新しいプロジェクトを保存する場合は、File > Save の順に選択し、ステップ 2 に進みます。

• 既存プロジェクトを別のファイル名で保存する場合は、File > Save As の順に選択して、ステッ

プ 2 に進みます。

ステップ 2 Save Project ダイアログボックスで、目的のディレクトリに移動してファイル名を入力します。[Save]

をクリックします。拡張子 MPZ の付いた zip ファイルとしてプロジェクトが保存されます。
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第 2 章      Cisco MetroPlanner によるネットワーク設計

2.1　Cisco MetroPlanner の起動
2.1.4　Cisco MetroPlanner Release 2.5 プロジェクトのインポート

Cisco MetroPlanner Release 2.5 のプロジェクトをインポートする手順は、次のとおりです。

ステップ 1 File メニューから Import 2.5.x project を選択します。

ステップ 2 Open Project ダイアログボックスで、目的のディレクトリに移動してプロジェクトを選択します。

Cisco MetroPlanner Release 2.5 プロジェクトのファイル拡張子は CMZ です。

ステップ 3 [Open] をクリックします。Import <R2.5 プロジェクト名 > ダイアログボックスが表示されます（図

2-5）。

図 2-5 Import <R2.5 プロジェクト名 > ダイアログボックス

ステップ 4 次のいずれかを選択します。

• Import only inputs ― このオプションは、Cisco MetroPlanner 2.5x プロジェクトの入力データをす

べてインポートする場合に選択します。Cisco MetroPlanner 7.0x がネットワークの分析時に、

サービス アグリゲーション、サービスのルーティング、増幅器、および DCU を定義します。

• Import outputs as forcings ― このオプションは、光の成績およびインストール パラメータ以外、

Cisco MetroPlanner 2.5x のあらゆる入出力データをインポートする場合に選択します。Cisco
MetroPlanner 7.0x でネットワーク アナライザを実行しても、インポートされた出力データのパ

ラメータは変更されません。ネットワーク アナライザでは、インポートされた値を強制パラ

メータとして取り扱います。
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第 2 章      Cisco MetroPlanner によるネットワーク設計

2.1　Cisco MetroPlanner の起動
ステップ 5 Target system Release エリアで、該当するリリースを選択します。Release 4.7、Release 5.0、または

Release 7.0 です。

ステップ 6 Import outputs as forcings を選択した場合は、インポートする出力を選択します。

• Import OADM units（OADM 装置をインポート）

• Import Amplifier units and parameter（増幅器およびパラメータをインポート）

• Import traffic constraints（トラフィック制約をインポート）

• Import client SFP modules（クライアント SFP モジュールをインポート）

• Generate aggregation groups（アグリゲーション グループを作成）

ステップ 7 [OK] をクリックします。Cisco MetroPlanner Release 2.5 プロジェクトが表示されます。

2.1.5　プロジェクトの終了

Cisco MetroPlanner プロジェクトを終了する手順は、次のとおりです。

ステップ 1 File メニューから Close を選択します。

ステップ 2 Save Project ダイアログボックスで、保存する場合は [Yes]、変更を保存しないで終了する場合は [No]

をクリックします。

ステップ 3 Yes をクリックし、それまでプロジェクトを保存していなかった場合は、Save Project ダイアログ

ボックスが表示されます。プロジェクト名を入力し、[Save] をクリックしてください。プロジェク

トが終了します。

ステップ 4 Cisco MetroPlanner を終了する場合は、File メニューから Exit を選択します。
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第 2 章      Cisco MetroPlanner によるネットワーク設計

2.2　Cisco MetroPlanner オプションの設定
2.2　Cisco MetroPlanner オプションの設定
Cisco MetroPlanner には、ツールや設計をカスタマイズするためのオプションが多数あります。

（注） 次の手順では、Tools メニューを使用してオプションを設定しますが、これが適用されるのはプロ

ジェクト作成時の新規プロジェクトの場合です。既存（オープン）プロジェクトを変更する場合

は、Project Explorer ペインの Subnets フォルダで該当するアイテムをクリックし、Properties ペイン

でパラメータを編集します。

2.2.1　グラフィック表示の設定

Cisco MetroPlanner のグラフィック表示を設定する手順は、次のとおりです。

ステップ 1 Tools メニューから Options を選択します。

ステップ 2 Options Explorer ダイアログボックス（図 2-6）で、Graphic フォルダを右クリックし、ショートカッ

ト メニューから Expand を選択します。

図 2-6 Options Explorer ダイアログボックス

ステップ 3 Cisco MetroPlanner のカラー スキームを変更するには、Look & Feel をクリックし、ドロップダウン

リストから適切なスキームを選択します。
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第 2 章      Cisco MetroPlanner によるネットワーク設計

2.2　Cisco MetroPlanner オプションの設定
ステップ 4 Project Explorer ツリーの外観を変更するには、Project Explorer をクリックし、必要な情報を入力し

ます。

• Alarm Mode ― アイテムの条件だけを報告する場合は、アラーム アイコンに対応する Single を
選択します。アイテムとその子の最も重要なアラームを要約する場合は、アラーム アイコンに

対応する Cumulated を選択します。

• Bottom Right Icon ― （表示のみ）Project Explorer でロックされた各アイテムの右下にロック ア
イコンを表示することを意味する、表示ロックです。

• Top Right Icon ― （表示のみ）Project Explorer で各アラーム アイテムの右上にアラーム アイコ

ンを表示することを意味する、表示アラームです。アラーム アイコンはグリーン、イエロー、

オレンジ、またはレッドになり、アラームの重大度を表します。

ステップ 5 NtView < 名前 > タブの外観を変更するには、Network View をクリックして、必要な情報を入力し

ます。

• Site エリアで、次の情報を入力します。

－ Color、Selection Color、および Highlight Color ― サイトの色を変更するには、Site リストで

Color、Selection Color、または Highlight Color フィールドを選択するか、またはすべての

フィールドを選択します。ドロップダウンの矢印をクリックすると、色見本のポップアッ

プ ウィンドウが表示されます。適切な色をクリックします。

－ Show Name ― NtView < 名前 > タブで、サイト名を表示する場合に選択します。

－ Show Amplifiers ― NtView < 名前 > タブで、サイト用の増幅器アイコンを表示する場合に

選択します。

－ Show Forced Amplifiers ― NtView Net# タブで、サイト用の強制増幅器アイコンを表示する

場合に選択します。

• Fiber エリアで、必要な情報を入力します。図 2-7 に、次の詳細をすべて指定したダクトの例を

示します。

－ Color および Selection Color ― 光ファイバの色を変更する場合は、Fibre リストで Color
フィールド、Selection Color フィールド、またはその両方をクリックし、さらにドロップダ

ウンの矢印をクリックします。

－ Show Spans ― NtView < 名前 > タブで、光ファイバ スパンを表示する場合に選択します。

－ Show Length ― NtView < 名前 > タブで、光ファイバ長を表示する場合に選択します。

－ Show total SOL Loss ― Ntview < 名前 > タブで Start Of Life（SOL）損失を表示する場合に選

択します。

－ Show total EOL Loss ― Ntview < 名前 > タブで End Of Life（EOL）損失を表示する場合に選

択します。

－ Show CD C-band ― NtView < 名前 > タブで C バンド Chromatic Dispersion（CD; 波長分散）

を表示する場合に選択します。

－ Show CD L-band ― NtView < 名前 > タブで L バンド CD を表示する場合に選択します。

• NtView < 名前 > タブでトラフィック デマンドの色を変更するには、Point To Point、P-Ring、お

よび Any To Any エリアで、Color および Selection Color フィールドをクリックし、さらにドロッ

プダウン矢印をクリックして、色見本のポップアップ ウィンドウを表示します。適切な色をク

リックします。

図 2-7 NTView < 名前 > タブに表示されるダクトの詳細
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第 2 章      Cisco MetroPlanner によるネットワーク設計

2.2　Cisco MetroPlanner オプションの設定
ステップ 6 Network Mgmt Tree タブの外観を変更するには、必要に応じて次の作業を行います。

• Network エリアで、Color フィールドおよび Selection フィールドをクリックします。ドロップ

ダウンの矢印をクリックすると、色見本のポップアップ ウィンドウが表示されます。適切な色

をクリックします。

• Link エリアで、次の情報を入力します。

－ リンクの色を変更するには、Link リストの Color フィールドをクリックし、さらにドロッ

プダウンの矢印をクリックします。ドロップダウン リストから適切な色を選択します。

－ リンクの外観を変更するには、Link リストの Stroke フィールドをクリックし、さらにド

ロップダウンの矢印をクリックします。ドロップダウン リストから適切なラインの外観を

選択します。

ステップ 7 [Ok] をクリックします。

2.2.2　デフォルト プラットフォーム値の設定

次の手順で、特定のプラットフォームおよびシステム リリースに対応するデフォルトのトラフィッ

ク マッピング、Dense Wavelength Division Multiplexing（DWDM; 高密度波長分割多重）の設計、お

よびデフォルトのレイアウト値を設定します。デフォルトの設定値は、プロジェクトの作成時に表

示されます。

ステップ 1 Tools メニューから Options を選択します。

ステップ 2 Options Explorer ダイアログボックス（図 2-6）で、Platform を右クリックし、ショートカット メ

ニューから Expand を選択します。

ステップ 3 適切な System Release フォルダをクリックし、必要な情報を入力します。

（注） デフォルトの変更が適用されるのは、指定したシステム リリースに限られます。

• Band ― デフォルトの帯域として C-Band または L-Band を選択します。

• Scalable C/L ― （System Release 7.0 の場合のみ）プロジェクト作成時のデフォルト値としてス

ケーラブルな C バンドおよび L バンドを設定する場合に選択します。選択すると、同一システ

ム上で C バンドと L バンドがサポートされる、スケーラブルな設計になります。

• Scalable C/50GHz ― （System Release 7.0 の場合のみ）プロジェクト作成時のデフォルト値とし

てスケーラブルな C バンド 50 GHz を設定する場合に選択します。選択すると、C バンドで 50
GHz のチャネル スペーシングがサポートされる、スケーラブルな設計になります。

ステップ 4 Restricted List フォルダをクリックします。カードを制限するには、そのカードの Restricted カラム

でチェックボックスを選択します。設定を無制限に戻すには、チェックボックスの選択を解除しま

す。

ステップ 5 Traffic Mapping フォルダをクリックし、必要な情報を入力します。

• General エリアで、C-Band Rules または L-Band Rules（あるいはその両方）のドロップダウン リ
ストから、適切なデフォルト値を選択します。
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第 2 章      Cisco MetroPlanner によるネットワーク設計

2.2　Cisco MetroPlanner オプションの設定
－ C バンドの場合、オプションは C 64Chs 50Ghz（+2dBm/Ch）の形式で示されます。使用で

きるチャネル数は 64、32、16、または 8 です。チャネル パワーごとの基準に関して使用で

きるオプションは、–1 dBm、2 dBm、5 dBm、および 8 dBm です。使用できるスペーシン

グ オプションは 100 GHz または 50 GHz です。

－ L バンドの場合、オプションは L 32 Chs 100Ghz（+5dBm/Ch）の形式で示されます。使用

できるチャネル数は 64、32、16、または 8 です。チャネル パワーごとの基準に関して使用

できるオプションは、–1 dBm、2 dBm、5 dBm、および 8 dBm です。使用できるスペーシ

ング オプションは 100 GHz または 50 GHz です。

• Fixed traffic エリアで、ドロップダウン リストからデフォルトのルーティング方式を選択しま

す。

－ Auto

－ Unprotected optimum optical path（非保護最適光路） ― ノード ペアごとに接続を 1 つずつ使

用して接続されます。非保護最適光路の場合は、必要な光増幅器の数が最小になります。

－ Unprotected minimum hop count（非保護最小ホップ数） ― トラフィック グループのノード

ペアごとに、接続を 1 つずつ使用して接続されます。非保護最小ホップ数の場合、トラ

フィック グループのノード間に設置できるチャネル数が最小になります（非保護トラ

フィック タイプのみ）。

ステップ 6 DWDM Design Rules フォルダをクリックし、必要な情報を入力します。

• No Tilt Design ― Cisco MetroPlanner に、傾きが生じない利得範囲内で増幅器を動作させる場合

に選択します。このオプションを使用すると、チャネルが常に基準パワー レベルにあるよう

に、ネットワークのすべての中間点が設定されます。

（注） 長距離（挿入損失が 25 dB を超える）はサポートできない場合があります。

• No In-Line Bulk Attenuator Design ― インライン バルク減衰器を使用しないでネットワークを設

計する場合に選択します。外部インライン減衰器を使用しないと設計できないネットワークの

場合、Cisco MetroPlanner によって、「Unfeasible Network design. Site X should require usage of in-line
attenuator. Leave unchecked to allow inline bulk attentuators.」というエラー メッセージが表示され

ます。

• No TXT/Line-Card Bulk Attenuator Design ― トランスポンダまたはライン カード上で外部受信

（Rx）バルク減衰器を使用しないでネットワークを設計する場合に選択します。Rx バルク減衰

器を必要とするクライアントが存在する場合は、関連チャネルが作業条件（レッド、オレンジ、

またはイエローのフラグ）とともに表示されます。Rx バルク減衰器がレポート（光チャネル成

績、内部接続、BoM など）に示されることはありません。バルク減衰器を使用する場合は、未

選択のままにします。

• Prevent Use of E-LEAF Dispersion ― Cisco MetroPlanner がネットワーク全体で、E-LEAF スパン

に E-LEAF Dispersion Compensation Unit（DCU; 分散補償装置）を使用しないようにする場合に

選択します。アルゴリズムに E-LEAF DCU の使用を自動的に最適化させる場合は、未選択のま

まにします。

• Allow Not Supported Fibers ― Cisco MetroPlanner がサポートしない光ファイバ タイプをネット

ワーク設計で選択できるようにする場合に選択します。すべての光ファイバ タイプまたは光

ファイバ タイプの組み合わせがネットワーク分析に合格するわけではありません。選択した光

ファイバ タイプがサポートされない場合は、ネットワーク分析時に、「Current Design Rules
cannot support Fiber Types in the network. Please contact the Custom Design Team」というエラー メッ

セージが表示されます。Allow Not Supported Fibers を選択しなかった場合、Cisco MetroPlanner
はネットワーク設計時に矛盾する光ファイバ タイプの選択を認めません。
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2.2　Cisco MetroPlanner オプションの設定
ステップ 7 シェルフ コンフィギュレーション パラメータを定義する場合は、Layout フォルダをクリックし、

次の作業を行います。

• Place AIC ― 各サイトの最初のシェルフで、スロット 9 に AIC カードを搭載することを Cisco
MetroPlanner に指示する場合に選択します。

• Place FibreStorage ― ラック内で光シェルフの下に光ファイバ ストレージを配置することを

Cisco MetroPlanner に指示する場合に選択します。

ステップ 8 [Ok] をクリックします。

ステップ 9 制限リストの変更をオープン プロジェクトに適用する場合は、次の手順を実行します。

a. 更新するネットワークのフォルダを右クリックし、ショートカット メニューから Expand を選

択します。

b. Project Explorer の RestrictedEqptListFolder の下で、適切なプラットフォームおよびリリース フォ

ルダを右クリックし、ショートカット メニューから Edit List を選択します。Restricted Eqpt list
for MSTP 454 DWDM[release 7.0] ダイアログボックスが表示されます。

c. [Update] をクリックします。

d. [Ok] をクリックして、ダイアログボックスを閉じます。

2.2.3　デフォルト プロジェクト値の設定

デフォルトのプロジェクト値および修理時間を設定する手順は、次のとおりです。デフォルトの設

定値は、プロジェクトの作成時に表示されます。

ステップ 1 Tools メニューから Options を選択します。

ステップ 2 Options Explorer ダイアログボックス（図 2-6）で、Project をクリックし、Project Creation ウィザー

ドに表示されるデフォルト値を次のように設定します。

• Customer ― デフォルトのカスタマー名（最大 128 文字）を入力します。

• Created by ― デフォルトのユーザ名（最大 128 文字）を入力します。

• Units ― ドロップダウン リストから、適切なデフォルト スパン長の単位を選択します。Km ま
たは Miles のどちらかです。

• Price List ― 適切なデフォルトの価格表を選択します。

• Layout ― ドロップダウン リストから ANSI（American National Standards Institute; 米国規格協会）

または ETSI（European Telecommunications Standards Institute; 欧州通信規格協会）のどちらかを

選択します。

ステップ 3 General をクリックして、次の情報を入力します。

• MTTR（hours） ― ネットワークのすべてのサイトについて、Mean Time To Repair（MTTR; 平均

修理時間）を入力します。これはネットワークのあらゆるサイトに適用されます。サイトの作

成後、MTTR 値を変更した場合、新しい値が適用されるのは、変更後に作成したサイトだけに

なります。

• Restocking Time（days） ― メンテナンス センタに装置を戻すために必要な日数（輸送時間を含

む）を入力します。

• Confidence Level（%） ― メンテナンス センタでスペア装置を見つける際の信頼度を選択します

（50、75、95、または 99 %）。
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2.2　Cisco MetroPlanner オプションの設定
ステップ 4 [Ok] をクリックします。

2.2.4　光ファイバ タイプのデフォルト値の設定

光ファイバ タイプのデフォルト値を設定する手順は、次のとおりです。変更は現在のプロジェクト

には適用されません。光ファイバ タイプの値を設定したあとで、データベースの変更をファイルに

エクスポートし、改めてファイルをインポートする必要があります。詳細については、「2.2.6　ファ

イルのエクスポート」（p.2-18）および「2.2.7　ファイルのインポート」（p.2-20）を参照してください。

ステップ 1 Tools メニューから Options を選択します。

ステップ 2 Options Explorer ダイアログボックスで Fiber をクリックします。

ステップ 3 デフォルト値を変更するために、必要な情報を入力します。

• Span Label Tag ― 適切なスパン ラベルを入力します。デフォルトのラベルは Duct です。

• Span Length ― スパン長を入力します。表示される単位は、Span Measurements Units フィールド

から取得されます。

• EOL Ageing loss [dB] ― EOL エージング損失の値を入力します。スパン当りの EOL 損失値は、

ネットワークの光ファイバごとに、End Of Life（EOL; 耐用命数）に加算されます（たとえば、

スプライスの場合は EOL マージンを加算）。

• EOL Ageing Factor ― 光ファイバの老朽化を係数処理するときに使用する値を入力します。この

係数に、コネクタを含まない SOL 総スパン損失を掛け合わせます。

（注） EOL Ageing Factor または EOL Ageing loss のどちらか一方に値を入力します。両方の

フィールドに値を入力する必要はありません。

• Connector loss [dB] ― スパンの終わりの集中損失を入力します。

• Length Based Loss ― 選択した場合は、Span Length（スパン長）* Loss Factor（損失係数）によっ

て光ファイバ損失が決定されます。このチェックボックスを選択しなかった場合は、スパンの

総損失を入力する必要があります。

• Tot SOL loss w/o conn [dB] ― コネクタ集中損失を含まない、各スパンにおける SOL リンク光

ファイバ損失を入力します。コネクタを含まない総 SOL 損失は、損失係数に長さを掛け合わせ

た値になります。Length Based モデルでは、この値が自動的に計算されます。

ステップ 4 [Ok] をクリックします。
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2.2　Cisco MetroPlanner オプションの設定
2.2.5　サードパーティ製 DWDM インターフェイスの定義

Cisco MetroPlanner では、プロジェクトの作成に使用するサードパーティ製の DWDM インターフェ

イスを定義できます。サードパーティ製の DWDM インターフェイスを定義すると、トラフィック

デマンドの作成時にそれらのインターフェイスを選択できます。サードパーティ製インターフェイ

スの定義の詳細については、付録 D「サードパーティ製 DWDM 波長インターフェイスのモデル」

を参照してください。

（注） サードパーティ製のインターフェイスを使用してネットワーク設計を作成し、なおかつ他のユーザ

と設計を共有する場合は、保存したネットワークの MPZ ファイルだけではなく、サードパーティ

製インターフェイスの定義が収められている、エクスポートしたデータベース ファイルも提供す

る必要があります。このプロジェクトを表示する場合、他のユーザはサードパーティ製インター

フェイスの値が指定されたデータベースを先にインポートする必要があります。

サードパーティ製 DWDM インターフェイスを定義する手順は、次のとおりです。

ステップ 1 Tools > DB Parts Mgmmt の順にクリックします。DB Parts Manager ダイアログボックスが表示され

ます。

（注） プロジェクトが開いている場合、DB Parts Manager を開くことはできません。

ステップ 2 Platform Parts を右クリックし、ショートカット メニューから Expand を選択します。

ステップ 3 Group を右クリックし、ショートカット メニューから New Group を選択します。Group の下およ

び parts DB の下の各システム リリースに新しいグループが表示されます。

ステップ 4 Group Editor ダイアログボックスで次の情報を入力します。

• Name of group ― 新しいデータベースの名前を入力します。

• Version of group ― グループの最初のバージョンであることを示す 1.0 が表示されます。

• Owner ― グループの所有者名を入力します。

• Note ― （任意）グループの説明を入力します。

ステップ 5 該当するシステム リリースの parts DB で、作成したグループをクリックします。

ステップ 6 DB Parts Manager ダイアログボックスの Parts タブで、Client を右クリックして選択し、ショート

カット メニューから Alien を選択します。Parts タブにクライアント ハードウェアに対応する新し

いローが表示されます。

ステップ 7 ローをダブルクリックして、Alien ダイアログボックスを開きます（図 2-8）。
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2.2　Cisco MetroPlanner オプションの設定
図 2-8 Alien Card ダイアログボックス
 

ステップ 8 Alien ダイアログボックスの General タブで、Name フィールドにカード名を入力します。

ステップ 9 Istance タブをクリックし、次の情報を入力します。

• Ansi PID ― 必要に応じて、ANSI システムの製品 ID を入力します。ANSI PID を入力し、この

サードパーティ製インターフェイスが認識される BoM を選択した場合は、BoM にサードパー

ティ製インターフェイスが関連する製品 ID とともに組み込まれます。

• Etsi PID ― 必要に応じて、ETSI システムの製品 ID を入力します。ETSI PID を入力し、この

サードパーティ製インターフェイスが認識される BoM を選択した場合は、BoM にサードパー

ティ製インターフェイスが関連する製品 ID とともに組み込まれます。

• TAG ― （表示のみ）内部用

• SYS.NAME ANSI ― サードパーティ製インターフェイスには該当しません。

• SYS.NAME ETSI ― サードパーティ製インターフェイスには該当しません。

• WL START ― ドロップダウン メニューから、サードパーティ製インターフェイスがサポート

する波長の開始範囲を選択します。

• WL END ― ドロップダウン メニューから、サードパーティ製インターフェイスがサポートす

る波長の終了範囲を選択します。

ステップ 10 Physical Ports タブをクリックし、Label カラムに各ポートのラベルを入力します。

CTC Ports タブおよび TLI Ports タブは、サードパーティ製インターフェイスには適用されません。

ステップ 11 [Ok] をクリックします。
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2.2　Cisco MetroPlanner オプションの設定
ステップ 12 DB Parts Manager ダイアログボックスの Parts タブで、Software を右クリックして選択し、ショート

カット メニューから Alien を選択します。Parts タブにクライアント ソフトウェアに対応する新し

いローが表示されます。

ステップ 13 ローをダブルクリックして、AlienSoft ダイアログボックスを開きます。

ステップ 14 General タブで、次の情報を入力します。

• Name ― Name フィールドに名前を入力します。

• Related Item ― ステップ 7 ～ 11 で作成したクライアント カードを選択します。

ステップ 15 Default - OCh タブをクリックします（図 2-9）。

図 2-9 Alien Software ダイアログボックス

ステップ 16 次の情報を入力します（サポートされる値の組み合わせについては、表 2-1 ～ 表 2-3 を参照）。

• Rules エリアで、Design Rule ドロップダウン リストから C- or L-band design rule を選択します。

• Technology エリアで、次の情報を入力します。

－ Modulation Format ― NRZ（Non Return to Zero）または Duo Binary を選択します。

－ Transmitter Type ― MZ（Mach Zehnder）、DML（Direct Modulated Laser）、または EML
（Electro-absorption Modulated Laser）を選択します。

－ Receiver Threshold ― Optimal（最小 BER）または Average （平均受信パワー）を選択します。
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2.2　Cisco MetroPlanner オプションの設定
－ Regeneration Type ― 3R または 2R の再生モードを選択します。

－ FEC Mode ― FEC（Forward Error Correction; 前方エラー訂正）、no FEC、または E-FEC
（Enhanced FEC）を選択します。

－ Transmitter Stability ― 最大許容波長エラー（pm）を選択します。値は 12.5、25、50、また

は 100 pm です。

• Bit Rate ― ドロップダウン リストから適切なビット レートを選択します。

• TX Power Range エリアに次の情報を入力します。

－ TX Max Power ― 最大出力レベル（dBm）を入力します。

－ TX Min Power ― 最小出力レベル（dBm）を入力します。

• Back to Back Receiver Sensitivity エリアに、必要な情報を入力し、バックツーバックの場合の現

用インターフェイス エリアを定義します。「バックツーバック」は、レシーバーがトランスミッ

タの前に配置されていて、その両者の間に他の装置が存在しない構成です。バックツーバック

は、TX と RX のペアの特性を測定する場合に使用します。図 2-10 に、インターフェイスの動

作エリアを示します。

－ Overload Power [dBm] ― 過負荷パワー レベルを入力します。

－ OL_Power [dBm] ― Optical Signal-to-Noise Ratio（OSNR; 光信号対雑音比）制限範囲の最小

パワー レベルを入力します。

－ OL_OSNR [dBm] on 0.5 nm RBW ― OSNR 制限範囲（0.5 単位で測定）の最小 OSNR レベル

を入力します。

－ PL_Power [dBm] ― パワー制限範囲の最小パワー レベルを入力します。

－ PL_OSNR [dBm] on 0.5 nm RBW ― OSNL 制限範囲（0.5 nm の帯域幅単位で測定）の最小パ

ワー レベルを入力します。

• Chromatic Dispersion エリアに、必要な情報を入力します。

－ Customize CD Robustness ― 必要に応じて、CD Robustness フィールドを選択してオンにし

ます。Chromatc Dispersion（CD; 波長分散）は、光ファイバ上を一定距離伝送後の光パルス

の拡大を意味します。

－ CD Robustness [ps/(nm*km)] ― Customize CD Robustness を選択した場合は、インターフェイ

スが許容できる最大正分散、Dmax_pos [ps/(nm*km)] を選択します。0dB、1dB、1.5dB、2dB、
または 3dB です。

• Customize Penalties ― 必要に応じて、Gaussian Cross-Talk Penalties、Single-Interfering Cross-Talk
Penalties、および Scale Q factors の各フィールドを選択してオンにします。

• Customize Penalties を選択した場合は、必要に応じて A_GXt および B_GXt フィールドに、ガウ

ス クロス トーク ペナルティを決定する値を入力します。ガウス クロス トークは、信号に干渉

するランダム パワーを意味します。A_GXt および B_GXt の値は、分散マージンが加算された

インターフェイス モデルの OL および PL 領域におけるガウス クロス トーク レベルの P ペナ

ルティ（PL）、P ペナルティ（OL）、OSNR ペナルティ（PL）、および OSNR ペナルティ（OL）
を見積もる指数曲線の係数です（図 2-10 を参照）。公式は Penalty(GXt) = A_GXt * exp(B_GXt
*GXt) です。

• Customize Penalties を選択した場合は、必要に応じて A_SIXt および B_SIXt フィールドに、　単

一干渉クロス トーク ペナルティを決定する値を入力します。単一干渉クロス トークは、単一

信号が引き起こす干渉を意味します。A_SIXt および B_SIXt の値は、分散マージンが加算され

たインターフェイス モデルの OL および PL 領域における単一干渉クロス トークの P ペナル

ティ（PL）、P ペナルティ（OL）、OSNR ペナルティ（PL）、および OSNR ペナルティ（OL）を

見積もる指数曲線の係数です（図 2-10 を参照）。公式は Penalty(IXt) = A_SIXt* exp(B_SIXt* IXt)
です。

• Customize Penalties を選択した場合は、必要に応じて、F-P（PL）、F-P（OL）、F-OSNR（PL）、
および F-OSNR（OL）フィールドに「スケール Q」値を入力します。スケール係数では、信号

歪みの回復に関して、カードがどれだけ効率的かを判断します。Q 係数曲線対 OSNR または RX
パワーの傾きによって、OSNR、パワー、またはその両方（カードが位置する OSNR/ パワー動

作ポイントによる）の上昇にしたがって BER の上昇をどの程度回復できるかが決まります。ス

ケール係数は通常、インターフェイス モデルの各動作ポイント OL および PL に対して 2 つず
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つ（OSNR と パワーに 1 つずつ）の値になります（図 2-10 を参照）。F-P（PL）、F-P（OL）、
F-OSNR（PL）、および F-OSNR（OL）値は、Q ペナルティ（すなわち BER の上昇）をパワー

および OSNR ペナルティに変換します。公式は次のとおりです。

－ P ペナルティ（PL）= Q ペナルティ * F-P（PL）

－ P ペナルティ（OL）= Q ペナルティ * F-P（OL）

－ OSNR ペナルティ（PL）= Q ペナルティ * F-OSNR（PL）

－ OSNR ペナルティ（OL）= Q ペナルティ * F-OSNR（OL）

F-P（PL）および F-OSNR（PL）は、PL 動作領域で評価されるのに対して、F-P（OL）および
F-OSNR（OL）は、分散マージンを加算した曲線の OL 動作領域で評価されます。

図 2-10 インターフェイス動作可能エリア

表 2-1 に、40 Gbs のサードパーティ製インターフェイスでサポートされる組み合わせを示します。
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表 2-1 40 Gbs のサードパーティ製インターフェイスでサポートされる組み合わせ

変調形式 TX タイプ
RX スレッシュ
ホールド FEC

TX の安定性
[pm]

波長分散ペナルティ [dBm]

P ペナルティ
（OL）

OSNR ペナル
ティ（OL）

P ペナルティ
（PL）

OSNR ペナル
ティ（PL）

Duo Binary MZ Optimal E-FEC ± 12 0 1 0 1
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2.2　Cisco MetroPlanner オプションの設定
表 2-2 に、10 Gbs のサードパーティ製インターフェイスでサポートされる組み合わせを示します。

表 2-3 に、2.5 Gbs のサードパーティ製インターフェイスでサポートされる組み合わせを示します。

ステップ 17 [Ok] をクリックします。

2.2.6　ファイルのエクスポート

ユーザ オプション、価格表、メンテナンス契約、および部品データベース ファイルをエクスポー

トする手順は、次のとおりです。Export コマンドを使用すると、作成したすべてのファイルを含む

ZIP ファイルが作成されます。

ステップ 1 Tools メニューから Export を選択します。Export ダイアログボックスが表示されます（図 2-11）。

表 2-2 10 Gbs のサードパーティ製インターフェイスでサポートされる組み合わせ

変調形式 TX タイプ
RX スレッシュ
ホールド FEC

TX の安定性
[pm]

波長分散ペナルティ [dBm]

P ペナルティ
（OL）

OSNR ペナル
ティ（OL）

P ペナルティ
（PL）

OSNR ペナル
ティ（PL）

NRZ MZ Optimal E-FEC ± 25 0 2 1 0

NRZ MZ Optimal FEC ± 25 0 1.5 1 0

NRZ MZ Average no FEC ± 25 2 0 2 0

NRZ EML Average no FEC ± 100 0 3 3 0

表 2-3 2.5 Gbs のサードパーティ製インターフェイスでサポートされる組み合わせ

変調形式 TX タイプ
RX スレッシュ
ホールド FEC

TX の安定性
[pm]

波長分散ペナルティ [dBm]

P ペナルティ
（OL）

OSNR ペナル
ティ（OL）

P ペナルティ
（PL）

OSNR ペナル
ティ（PL）

NRZ DML Average FEC ± 25 0 2 2 0

NRZ DML Average no FEC ± 25 0 2 2 0

NRZ DML Average no FEC ± 25 3 0 3 0

NRZ DML Average no FEC ± 25 3 3 3 3

NRZ EML Average no FEC ± 25 0 2 2 0

NRZ DML Average no FEC ± 100 0 3 3 0
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2.2　Cisco MetroPlanner オプションの設定
図 2-11 Export ダイアログボックス

ステップ 2 Export ダイアログボックスで file name フィールドにファイル パスと名前を入力します。既存ファ

イルにエクスポートする場合は、... ボタンをクリックし、適切なディレクトリおよびファイルに移

動します。[Select] をクリックしてファイルを選択します。

ステップ 3 エクスポートするアイテムを選択するために、必要な情報を入力します。

• User Option ― Tools > Options コマンドで設定したユーザ オプションをエクスポートする場合

に選択します。

• PartsDB ― 適切なプラットフォームを選択します。

• PriceDB ― すべての価格表をエクスポートする場合は All Price DB を選択します。または All
Price DB を展開して、エクスポートする個々の価格表を選択します。

ステップ 4 [Ok] をクリックします。
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2.2.7　ファイルのインポート

ユーザ オプション、価格表、メンテナンス契約、および部品データベース ファイルをインポート

する手順は、次のとおりです。エクスポートした複数のアイテムからなる ZIP ファイルをインポー

トすることも、個々の TXT ファイルをインポートすることもできます。

ステップ 1 Tools メニューから Import を選択します。Import ダイアログボックスが表示されます（図 2-12）。

図 2-12 Import ダイアログボックス

ステップ 2 Import ダイアログボックスで ... ボタンをクリックし、適切なディレクトリおよびファイルに移動し

ます。[Select] をクリックしてインポートするファイルを選択します。

ステップ 3 [load] をクリックします。

ステップ 4 TXT ファイルを 1 つだけ選択した場合は、このステップを省略してステップ 5 に進みます。エクス

ポートした複数のオプションからなる ZIP ファイルを選択した場合は、必要に応じて次の情報を入

力します。

• User Option ― Tools > Options コマンドで設定されたユーザ オプションの含まれているファイ

ルをインポートする場合は、選択しておきます。

• PartsDB ― 目的のプラットフォームに対応する部品データベースをインポートする場合は、選

択しておきます。

• PriceDB ― すべての価格表をインポートする場合は、All Price DB を選択しておきます。また

は、選択を解除して、該当する個々の価格表を選択します。

ステップ 5 [Ok] をクリックします。

ステップ 6 確認用ダイアログボックスで、[Ok] をクリックします。
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2.2　Cisco MetroPlanner オプションの設定
2.2.8　デフォルト レイアウトのリセット

グラフィック レイアウトの設定値は、Cisco MetroPlanner の終了時に保存されます。次回、Cisco

MetroPlanner を起動したときには、終了時と同じレイアウトが表示されます。デフォルトのグラ

フィック レイアウトには、ペインを表示するか、削減するかといった項目が含まれます。

Cisco MetroPlanner のデフォルト レイアウトに戻すには、View メニューから Default Layout を選択

します。ユーザが変更したレイアウトを復元するには、View メニューから My Default View を選択

します。

2.2.9　プラグインの追加

Cisco MetroPlanner にプラグインを追加する手順は、次のとおりです。プラグインは Cisco

MetroPlanner とは別個にリリースされます。プラグインを使用すると、リリース バージョンの Cisco

MetroPlanner をカスタマイズできます。

ステップ 1 Documents and Settings\username\Desktop\MP7\plugins フォルダにプラグイン ファイルをコピーしま

す。

ステップ 2 File メニューから Exit を選択して [Yes] をクリックするか、[No] をクリックして既存プロジェクト

を保存します。

ステップ 3 Cisco MetroPlanner を起動します。詳細については、「2.1　Cisco MetroPlanner の起動」（p.2-2）を参

照してください。

ステップ 4  Tools > Plug-In > View Plugin registry の順に選択します。PlugIn Registry ダイアログ ボックスが表

示されます（図 2-13）。

図 2-13 PlugIn Registry ダイアログボックス
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ステップ 5 PlugIn Tree で、新しいプラグイン フォルダを右クリックし、ショートカット メニューから Expand

を選択します。

ステップ 6 新しいプラグインを右クリックし、ショートカット メニューから Run at start を選択します。

ステップ 7 [Ok] をクリックします。

ステップ 8 確認用ダイアログボックスで、[Ok] をクリックします。

ステップ 9 Cisco MetroPlanner が終了し、再起動します。新しいプラグインが File メニューの下のコマンドとし

て表示されます。

2.2.10　プラグインの管理

プラグインを表示して管理する手順は、次のとおりです。プラグインの追加については、「2.2.9　

プラグインの追加」（p.2-21）を参照してください。

ステップ 1  Tools > Plug-In > View Plugin registry の順に選択します。PlugIn Registry ダイアログ ボックスが表

示されます（図 2-13）。

ステップ 2 PlugIn Tree で、プラグイン フォルダを右クリックし、ショートカット メニューから Expand を選択

します。

ステップ 3 プラグインをクリックして、関連情報を表示します。PlugIn Registry ダイアログボックスの右ペイ

ンに、プラグイン情報が表示されます。

• PlugIn Regstry ダイアログボックスの General エリアで、次の情報を確認します。

－ Name ― （表示のみ）プラグインの名前が表示されます。

－ Path ― （表示のみ）プラグインの保管場所が表示されます。

－ Version ― （表示のみ）プラグインのバージョンが表示されます。

－ Provider ― プラグインの提供元の名前が表示されます。

－ Text ― （表示のみ）プラグインの簡単な説明が表示されます。

－ Exclusion ― （表示のみ）除外ラベルが表示されます。除外属性は、プラグインの除外ルー

ルを定義するタグです。所定の除外タグを指定して、複数のプラグインを同時に実行する

ことはできません。

• PlugIn Registry ダイアログボックスの State エリアで、プラグインの現在の状態および制限事項

を確認します。

－ Current State ― （表示のみ）プラグインの状態が示されます。

－ Can be stopped ― （表示のみ）True の場合、現在の Cisco MetroPlanner セッション中に、プ

ラグインを無効にできます。プラグインは File メニューに表示されなくなります。停止さ

せたプラグインを再開するには、Cisco MetroPlanner を終了して再起動する必要がありま

す。False の場合は、Cisco MetroPlanner のアクティブ セッション中にプラグインを停止で

きません。

－ Can be suspend ― （表示のみ）True の場合、現在の Cisco MetroPlanner セッション中に、プ

ラグインを無効にできます。プラグインは File メニューに表示されなくなります。中断し

たプラグインを再開するには、PlugIn Regstry ダイアログボックスで Resume を選択します。
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Cisco MetroPlanner の終了して再起動する必要はありません。False の場合は、Cisco
MetroPlanner のアクティブ セッション中にこのプラグインを一時停止してから再開するこ

とはできません。

• PlugIn Registry ダイアログボックスの Run Information エリアに、Can be deactivated の状態が表

示されます。True の場合は、プラグインを停止状態にできますが、停止を有効にするには、

Cisco MetroPlanner を終了して再起動する必要があります。Cisco MetroPlanner を再起動すると、

File メニューにプラグインが表示されなくなります。False の場合は、このプラグインを停止状

態にできません。

ステップ 4 プラグインを無効にする、または一時停止するには、プラグインを右クリックし、ショートカット

メニューから次のいずれかを選択します。

• Do not run at start ― Cisco MetroPlanner の次回起動時に、プラグインを無効にする場合に選択し

ます。

• Suspend/Resume ― Cisco MetroPlanner を再起動しないで、プラグインをただちに無効にする場

合は、Suspend を選択します。一時停止したプラグインを使用可能にするには、Resume を選

択します。

ステップ 5 [Ok] をクリックします。

ステップ 6 確認用ダイアログボックスで、[Ok] をクリックします。

ステップ 7 Do not run at start を選択した場合は、プラグインを無効にするために、Cisco MetroPlanner を終了し

て再起動します。

2.2.11　ユーザ プロファイルの追加

ユーザ プロファイルは、Cisco MetroPlanner を実行する場合に使用する一連の権限です。プロファ

イルごとに異なる機能を提供します。Cisco MetroPlanner のパッケージには、Network Designer およ

び Base Network Designer というプロファイルが含まれていますが、シスコが提供しているその他の

ユーザ プロファイルをユーザ側で追加できます。『Cisco MetroPlanner DWDM Operations Guide』の

手順はすべて、Network Designer のアクセス権があるユーザを想定して書かれています。

表 2-4 に、ユーザ プロファイル Network Designer と Base Network Designer 間で異なる権限を示しま

す。その他のコマンドおよびオプションはすべて、どちらのユーザ プロファイルも同じ権限です。

表 2-4 Network Designer および Base Network Designer 間で異なる権限

Cisco MetroPlanner コマンド / オプション Network Designer Base Network Designer

Tools > Parts Database > New group 可 不可

Tools > View Plug-in registry 可 可

Tools > Options > Platform Options > 

Restricted Equipment list
可 読み取り専用

Tools > Price List Mgmt > Master Price Database 可 読み取り専用

Tools > Export 可 可

Tools > Import 可 可
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Cisco MetroPlanner にユーザ プロファイルを追加する手順は、次のとおりです。

ステップ 1 Documents and Settings\username\Desktop\MP7\profiles フォルダにプロファイル JAR ファイルをコ

ピーします。

ステップ 2 Cisco MetroPlanner を起動します。詳細については、「2.1　Cisco MetroPlanner の起動」（p.2-2）を参

照してください。Choose a profile type ドロップダウン リストに新しいプロファイルが表示されま

す。

2.2.12　スクリプトの実行

スクリプトを実行する手順は、次のとおりです。スクリプトは、BSH ファイル形式の一連のコマン

ドであり、Cisco MetroPlanner の追加機能を提供します。シスコシステムズでは、Cisco MetroPlanner

ソフトウェアのカスタマイズに役立つ有効なスクリプトを用意しています。

（注） この手順を実行する前に、シスコシステムズから有効なスクリプトを入手しておく必要がありま

す。

ステップ 1 Script メニューから Run Script を選択します。

ステップ 2 Choose the script to run ダイアログボックスで、適切なスクリプトをクリックし、[Open] をクリック

します。スクリプトが実行されます。

ステップ 3 スクリプトを再実行する場合は、Run Again > スクリプト名の順に選択します。

2.2.13　Script メニューの更新

Cisco MetroPlanner スクリプト ディレクトリにある共通スクリプトは、Script > Common menu で表

示され、あらゆるユーザが実行できます。

C:/Documents And Settings/<user-home>/MP_<version>/scripts のユーザ スクリプトは、Script > User

menu で表示されます。

いずれかのディレクトリでスクリプトの追加または削除を行ったときは、必ず Refresh Dirs を選択

し、Script メニューに変更が反映されるようにしてください。Remove Dirs コマンドを使用すると、

Script > Run Again メニューからスクリプト名が削除され、Script > Common メニューおよび User メ

ニューが更新されます。
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2.3　プロジェクトの作成
プロジェクトは、分析および比較の対象となる単一ネットワークまたは複数のネットワークで構成

されています。プロジェクトでは、同じカスタマー入力データで、単一ネットワークのコピーを複

数使用できますが、複数のソリューションを検討するために、コピーごとに異なるオプションを使

用します。

プロジェクトにネットワークを 1 つ作成する手順は、次のとおりです。新しいネットワークは

Design ステート（状態）になります。各種ネットワーク ステートの詳細については、「2.7　ネット

ワーク設計の管理」（p.2-90）を参照してください。

ステップ 1 File メニューから New を選択します。Project Creation ウィザードが表示されます（図 2-14）。

図 2-14 Project Creation ウィザード

ステップ 2 Project ページで次の情報を入力します。

• Created By ― ユーザのログイン名が表示されます。このフィールドは変更可能です（最大 128
文字）。

• Costomer Name ― このネットワーク設計を要求しているカスタマーの名前を入力します（最大

128 文字）。

• Network Platform Layout ― ドロップダウン リストから ANSI（北米の規格）または ETSI（国際

規格）を選択し、プラットフォーム タイプを指定します。ANSI ネットワークの場合は、SDH
（ETSI）サービス デマンドを定義できません。ETSI ネットワークの場合は、SONET（ANSI）
サービス デマンドを定義できません。

• Span Measurement Units ― ドロップダウン リストから Km（キロメートル）または Miles を選

択し、スパン長の計測単位を設定します。

• Price List ― ドロップダウン リストから価格表を選択します。
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ステップ 3 [Next] をクリックします。

ステップ 4 Platform ページで、適切なプラットフォームを選択し、[Next] をクリックします。

ステップ 5 Release ページでネットワーク設計に対応する適切なソフトウェア リリースを選択し、[Next] をク

リックします。デフォルトは最新リリースです。この属性によって、特定のリリースではサポート

されないことが理由で、設計に使用できないハードウェア部品のリストが定義されます。

ステップ 6 Subnet ページで次の情報を入力します（図 2-15）。

• Traffic mapping ― ONS 15454 Release 7.0 バージョンのインターフェイスおよび波長ルーティン

グ最適化アルゴリズムをネットワーク設計で使用する場合に選択します。Release 7.0 は下位互

換性があるので、Software Release 4.7、5.0、および 7.0 を管理できます。

• Metro Core ― ONS 15454 Release 7.0 バージョンのアルゴリズムを使用して、サブネットワーク

内の増幅器および DCU の配置を最適化する場合に選択します。Release 7.0 は下位互換性があ

るので、Software Release 4.7、5.0、および 7.0 を管理できます。

• Layout ― サブネットワーク内の各サイトのレイアウトを作成するときに使用する、ONS 15454
Release 7.0 バージョンのアルゴリズムを定義する場合に選択します。Release 7.0 は下位互換性

があるので、Software Release 4.7、5.0、および 7.0 を管理できます。

• Bands ― C-Band または L-Band を選択します。L-Band を使用できるのは、Release 7.0 のネッ

トワークに限られます。

• Scalable C/L Bands ― Yes または No を選択して、同一システム上で C バンドと L バンドの両方

をサポートできるスケーラビリティを設計に与えるかどうかを指定します。このオプションを

使用できるのは、Release 7.0 ネットワークに限られ、さらに C-Band を選択している場合です。

• Scalable C-band/50GHz ― Yes または No を選択して、C バンドで 50 GHz のチャネル間隔をサ

ポートできるスケーラビリティを設計に与えるかどうかを指定します。このオプションを使用

できるのは、Release 7.0 ネットワークに限られ、さらに C-Band を選択している場合です。

• C-band Rules ― ネットワーク設計における、チャネル当りの最大パワーおよびチャネル間隔に

なるオプションを選択します。このオプションを使用できるのは、C バンドを選択した場合で

す。C バンドの場合、オプションは C 64Chs 50Ghz（+2dBm/Ch）の形式で示されます。使用で

きるチャネル数は 64、32、16、または 8 です。チャネル パワーごとの基準に関して使用でき

るオプションは、–1 dBm、2 dBm、5 dBm、および 8 dBm です。使用できるスペーシング オプ

ションは 100 GHz または 50 GHz です。

• L-band Rules ― ネットワーク設計における、チャネル当りの最大パワーおよびチャネル間隔に

なるオプションを選択します。このオプションを使用できるのは、L バンドを選択した場合で

す。L バンドの場合、オプションは L 32 Chs 100Ghz（+5dBm/Ch）の形式で示されます。使用

できるチャネル数は 64、32、16、または 8 です。チャネル パワーごとの基準に関して使用で

きるオプションは、–1 dBm、2 dBm、5 dBm、および 8 dBm です。使用できるスペーシング オ
プションは 100 GHz または 50 GHz です。
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図 2-15 Project Creation ウィザードの Subnet ページ

ステップ 7 [Next] をクリックします。

ステップ 8 次のいずれかの手順を実行します。

• Network Creation ウィザードを実行する場合は、Run the Network Wizard Now チェックボック

スを選択し、[Finish] をクリックします。ステップ 9 に進みます。

• 空のプロジェクトを作成し、手動でサイトと光ファイバを追加する場合は、Run the Network
Wizard Now チェックボックスの選択を解除し、[Finish] をクリックします。Project ウィザード

によってプロジェクト、空のネットワークおよびサブネットワークが作成され、そこに手動で

サイトおよび光ファイバを追加できます。この場合、残りの手順を省略します。サイトを手動

で追加する手順については、「2.3.1　サイトの追加」（p.2-31）を参照してください。

ステップ 9 Network Creation ウィザードの Topology ページ（図 2-16）で、Topologies のドロップダウン リスト

から Ring または Linear を選択し、[Next] をクリックします。
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図 2-16 Network Creation ウィザードの Topology ページ

ステップ 10 Configuration ページで、Site number フィールドにサイト数を入力し、[Next] をクリックします。ネッ

トワーク設計当りの最大サイト数は 60、デフォルトのサイト数は 3 です。

ステップ 11 Site Management ページで次の情報を入力します（図 2-17）。

• Shelf Management ― シェルフ管理の設定を選択します。

－ Multi Shelf Integrated Switch ― Multi Service Transport Platform（MSTP）光カード（オプティ

カル Add/Drop マルチプレクサ [OADM] および増幅器）はすべて、LAN によって接続され

た、それぞれ異なるシェルフに配置されます。LAN は MSTP シェルフに接続されたスイッ

チで実装されます。このオプションを選択すると、Multi-Shelf Integrated Switch Card
（MS-ISC）を使用してマルチシェルフ構成がサポートされます。

－ Multi Shelf External Switch ― すべての MSTP 光カード（OADM および増幅器）は、LAN で
接続されたそれぞれ異なるシェルフに配置されます。LAN は MSTP シェルフの外部スイッ

チで実装されます（Cisco Catalyst 2950）。このオプションを選択した場合は、2 つの外部

イーサネット スイッチを使用して、マルチシェルフ構成をサポートします。

－ Individual Shelf ― すべての MSTP 光カード（OADM および増幅器）が同じシェルフに配置

されます。このオプションを選択した場合、マルチシェルフ管理はサポートされません。

シェルフごとに独立したシェルフとして管理します。

• Node Protection ― Same Shelf（単一シェルフ構成）または Separated Shelves（マルチシェルフ

構成）を選択します。Same Shelf 構成では、すべての OADM/ROADM 装置が 1 つのシェルフに

配置され、シェルフ レベルではノードにどのような保護も提供しません。Separated Shelves 構
成では、西向きと東向きの OADM/ROADM 装置がノード内で別々のシェルフに配置されます。

このオプションを選択できるのは、Multishelf 管理を選択した場合だけです。

• Hybrid Node ― 構成されたすべてのノードをハイブリッド MSTP/Multi Service Provisioning
Platform（MSPP）ノードとして作成する場合に選択します。Hybrid Node を使用できるのは、

Shelf Management タイプとして Individual Shelf を選択した場合だけです。
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• Osmine Compliant ― このオプションは、Operations Systems Modifications of Intelligent Network
Elements（OSMINE）配置規則に基づいて、シェルフに DWDM 装置を配置する場合に選択しま

す。

• DCC chain ― DCC を使用する各サイトの各シェルフで、スロット 12 に TXP(P)_MR_2.5G カー

ドを搭載する場合に選択します。

• Max ShelfNum ― サイトのレイアウト作成時に、サイトの各ラックに配置できる（光カードま

たは TXP/MXP カードを装備した）ANSI または ETSI シェルフの最大数（1 ～ 4）を選択します。

図 2-17 Network Creation ウィザードの Site Management ページ

ステップ 12 [Next] をクリックします。

ステップ 13 Span Parameters で、次の情報を入力します（図 2-18）。

• Span Label Tag ― 適切なスパン ラベルを入力します。

• Span Fibre Type ― ネットワークの各スパンについて、光ファイバ タイプを選択します。

• Span Length ― スパン長を入力します。表示される単位は、Span Measurements Units フィールド

から取得されます。

• EOL Ageing Factor ― 光ファイバの老朽化を係数処理するときに使用する値を入力します。この

係数に、コネクタを含まない SOL 総スパン損失を掛け合わせます。

• EOL Ageing loss [dB] ― EOL エージング損失の値を入力します。スパン当りの EOL 損失値は、

ネットワークの光ファイバごとに、EOL に加算されます（たとえば、スプライスの場合は EOL
マージンを加算）。

（注） EOL Ageing Factor または EOL Ageing loss のどちらか一方に値を入力します。両方の

フィールドに値を入力する必要はありません。
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• Connector loss [dB] ― スパンの終わりの集中損失を入力します。

• CD factor [pm/nm/km] ― 光ファイバの波長分散（CD）係数を入力します。デフォルト値は、選

択した光ファイバ タイプによって異なります。このフィールドに入力した値は、光ファイバ タ
イプを変更するたびに消去されます。波長分散は必ず、ps/nm/km 形式で入力します。光ファイ

バの波長分散は、波長帯域の中央で定義されます。C バンドは 1545.3 nm で定義され、L バン

ドは 1590.4 nm で定義されます。

• PMD factor [ps/sqrt(km)] ― Polarization Mode Dispersion（PMD; 偏波モード分散）係数を入力しま

す。デフォルト値は、選択した光ファイバ タイプによって異なります。このフィールドに入力

した値は、光ファイバ タイプを変更するたびに消去されます。PMD は必ず、キロメートル単

位で入力します。

• Length Based Loss ― 選択した場合は、Span Length（スパン長）* Loss Factor（損失係数）によっ

て光ファイバ損失が決定されます。このチェックボックスを選択しなかった場合は、スパンの

総損失を入力する必要があります。

• このチェックボックスを選択しなかった場合は、ユーザ側でスパンの総損失を挿入する必要が

あります。

• Loss factor [dB/km] ― ネットワークの各スパンの損失を計算するときに使用する、キロメート

ル当りの SOL 光ファイバ損失値を入力します。光ファイバ損失係数は必ず、dB/km の形式で入

力します。

• Tot SOL loss w/o conn [dB] ― コネクタ集中損失を含まない、各スパンにおける SOL リンク光

ファイバ損失を入力します。コネクタを含まない総 SOL 損失は、損失係数に長さを掛け合わせ

た値になります。Length Based モデルでは、この値が自動的に計算されます。

図 2-18 Network Creation ウィザードの Site Parameters ページ

ステップ 14 [Finish] をクリックします。Cisco MetroPlanner によって、光ファイバ係数値の妥当性が検証されま

す。光ファイバ係数値が有効範囲内（表 2-5）の場合は、ネットワークが視覚化されます。値が範

囲外の場合は、警告が表示され、入力値の確認が求められます。
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2.3.1　サイトの追加

既存のネットワークに新しいサイトを追加する手順は、次のとおりです。サイトとは、建物内部の

ラックに任意の装置を共存させることのできる、顧客施設内の場所です。Design ステートに限り、

ネットワークに新規サイトを追加できます。

（注） 設計に追加された新規サイトはすべて、Multi-Shelf Integrated Switch with Same Shelf protection（同一

シェルフが保護されるマルチシェルフ統合スイッチ）として自動的に設定されます。これを変更す

るには、ネットワーク設計にサイトを追加したあとで、サイトのプロパティを編集します。「2.6.3
　サイト パラメータの編集」（p.2-71）を参照してください。

（注） Cisco MetroPlanner がサポートするサイトは、最大 60 です。Optical Service Channel（OSC; オプティ

カル サービス チャネル）終端位置の最大数は 20 です。分岐挿入（add/drop）位置の最大数は 16 です。

ステップ 1 Project Explorer でネットワーク フォルダを右クリックし、ショートカット メニューから Expand を

選択します。

ステップ 2 Sites フォルダを右クリックし、ショートカット メニューから New Site を選択します。Site Creation

ウィザードが表示されます。または、ネットワーク設計にサイトがすでに存在している場合は、

NtView < 名前 > タブを開き、ツールバーの Create a new site アイコンをクリックします。Cisco

MetroPlanner のアイコンの詳細については、付録 A「GUI 情報およびショートカット」を参照して

ください。

表 2-5 光ファイバ係数値の有効範囲

光ファイバの
タイプ パラメータ 最小エラー値 最小警告値 デフォルト値 最大警告値 最大エラー値 単位

ITU-T 

G.652-SMF
損失係数 0 0.2 — 0.4 10 dB/km

波長分散係数 @ 

1545.3 nm（C バンド）

0 16.2 16.7 17.1 30 ps/nm/km

波長分散係数 @ 

1590.4 nm（L バンド）

0 18.53 19.03 19.43 30 ps/nm/km

PMD 係数 0 ps/ 0.0 0.1 0.5 10

ITU-T 

G.655-E-LEAF
損失係数 0 0.2 — 0.4 10 dB/km

波長分散係数 @ 
1545.3 nm

0 3.4 3.80 4.2 10 ps/nm/km

PMD 係数 0 0 0.1 0.5 10

ITU-T 

G.655-True 

Wave

損失係数 0 0.2 — 0.4 10 dB/km

波長分散係数 @ 
1545.3 nm

0 3.8 4.19 4.6 10 ps/nm/km

PMD 係数 0 0 0.1 0.5 10

ITU-T 

G.652-DS（分

散シフト型）

損失係数 0 0.2 — 0.4 10 dB/km

波長分散係数 @ 

1590.4 nm（L バンド）

0 2.43 2.83 3.23 30 ps/nm/km

PMD 係数 0 0 0.1 0.5 10
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ステップ 3 インターフェイス タイプを選択します。

• Line ― ノードで終端する 2 組の光ファイバ ペア

• Terminal ― ノードで終端する 1 組の光ファイバ ペア

• Line+ ― 2 組の光ファイバ ペアがノードで終端しますが、光ファイバの数を増やせます。MMU
カード（トポロジー アップグレード）を搭載する必要があります。

• Terminal+ ― 1 組の光ファイバ ペアがノードで終端しますが、光ファイバの数を増やせます。

MMU カード（トポロジー アップグレード）を搭載する必要があります。

ステップ 4 [Finish] をクリックします。

2.3.2　光ファイバ スパンの追加

サイト間に光ファイバ スパンを手動で追加する手順は、次のとおりです。光ファイバ スパンは、2

つのサイト間の光ファイバ ペア（一方は送信、もう一方は受信）で構成されています。NetView

Net# タブでは、光ファイバ ダクトでスパンを表します。光ファイバ ダクト内に複数の光ファイバ

ペアを存在させることができます。Design ステートに限り、ネットワークに新しい光ファイバを追

加できます。

（注） 各サイトがサポートできる光ファイバ スパン数は、サイト プロパティで定義します。「2.3.1　サイ

トの追加」（p.2-31）または「2.6.3　サイト パラメータの編集」（p.2-71）を参照してください。

ステップ 1 NtView < 名前 > タブで、ツールバーの Create a new duct アイコンをクリックします。

Cisco MetroPlanner のアイコンの詳細については、付録 A「GUI 情報およびショートカット」を参照

してください。

ステップ 2 光ファイバ スパンと接続するサイトの 1 つをクリックします。このサイトがあとでネットワーク分

析を行うときに、出力の送信元サイトになります。

ステップ 3 宛先サイトをクリックします。光ファイバ スパンは、2 つのサイト間に表示されます。このサイト

があとでネットワーク分析を行うときに、出力の宛先サイトになります。

最初のスパンでは、送信元サイトを East、宛先サイトを West として設定します。その他のスパン

に関しては、Cisco MetroPlanner が East と West を自動的に調整します。

2.3.3　ポイントツーポイント デマンドの作成

ポイントツーポイント トラフィック デマンドを追加する手順は、次のとおりです。

ステップ 1 NtView < 名前 > タブで、ツールバーの Create a new P2P demand アイコンをクリックします。Cisco

MetroPlanner のアイコンの詳細については、付録 A「GUI 情報およびショートカット」を参照して

ください。
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ステップ 2 デマンドの送信元サイトをクリックします。

ステップ 3 デマンドの宛先サイトをクリックします。Point to Point Demand Creation ウィザードが表示されます

（図 2-19）。

図 2-19 Point to Point Demand Creation ウィザード

ステップ 4 General Parameters エリアで、次の情報を入力します。

• Label ― デマンド名を入力します。

• Source ― （表示のみ）送信元サイト名が表示されます。

• Destination ― （表示のみ）宛先サイト名が表示されます。

• Service Type ― ドロップダウン リストからサービス タイプを選択します。サービスの一覧につ

いては、「1.2.6　サービス サポート」（p.1-4）を参照してください。

• Present # ch ― 作成するチャネル数を入力します。このフィールドに入力した値で、Forecast #
ch フィールドが自動的に更新されます。

• Forecast # ch ― 後日導入するチャネル数を入力します。この値には、Present # ch の値が含まれ

ます。たとえば、Present # ch の値として 4 を入力していて、将来 2 つのチャネルを追加する場

合は、6 を入力します。

ステップ 5 [Next] をクリックします。

ステップ 6 Platform Parameters エリアで、次の情報を入力します。

• Protection ― ドロップダウン リストから保護タイプを選択します。Y-Cable Protected、Client
1+1、Fiber Switched、または Unprotected です。保護タイプの詳細については、「1.2.5　保護方

式サポート」（p.1-4）を参照してください。
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• Path ― （非保護の場合のみ）ドロップダウン リストからルーティング タイプを選択します。

－ Auto ― チャネルのルーティングに関して、最大限の柔軟性が得られます。

Cisco MetroPlanner は、他の制約に与えるコストを可能な限り最小限にして、チャネルを

ルーティングします。

－ E ― 送信元サイトの東側からすべてのチャネルをルーティングします。

－ W ― 送信元サイトの西側からすべてのチャネルをルーティングします。

• Optical Bypass ― （非保護の場合のみ）現在のデマンドに対応するチャネルのオプティカル バ
イパスを行うサイトを選択します。オプティカル バイパスのチャネルは、ノードの片側で廃棄

され、同じノードの反対側で追加され、将来、そのノードを分岐挿入（add/drop）位置として

使用できるようにします。

ステップ 7 Interface Parameters エリアの次のフィールドに入力します。使用できるオプションは、ステップ 4

で選択したサービス タイプによって決まります。

• Transponder ― クリックして展開し、カード タイプのチェックボックスを選択し、サービス チャ

ネルの終端サイトでカードを選択します。

• Line Card ― クリックして展開し、カード タイプのチェックボックスを選択し、サービス チャ

ネルの終端サイトでカードを選択します。

• Alien Card ― 「2.2.5　サードパーティ製 DWDM インターフェイスの定義」（p.2-13）で説明し

たように、サードパーティ製のインターフェイスを作成した場合に限って表示されます。ク

リックして展開し、カード タイプのチェックボックスを選択し、サービス チャネルの終端サ

イトでカードを選択します。

• Pluggable Card ― クリックして展開し、カード タイプのチェックボックスを選択し、サービス

チャネルの終端サイトでカードを選択します。

ステップ 8 Client Interface エリアで、Source および Destination のドロップダウン リストから、送信元および宛

先のクライアント インターフェイス タイプ（SR、IR、または LR）を定義します。このオプション

を使用できるのは、プラガブル クライアント インターフェイスを備えたトランスポンダおよび

マックスポンダ インターフェイスの場合であり、選択したサービス タイプおよびカード タイプ

よって異なります。

ステップ 9 [Finish] をクリックします。Edit Point to Point Demand ダイアログボックスに、現在および将来の

チャネルが示されます。

デマンドは NtView < 名前 > タブおよび Service Demands > Point To Point フォルダの Project Explorer

ツリーに表示されます。デマンドは、選択されている場合は実線、選択されていない場合は点線に

なります。線の上の数字は、存在するチャネル数を表します。図 2-20 に、サイト 1 とサイト 2 間で

選択されている、5 チャネルのポイントツーポイント デマンドを示します。

（注） デマンド パラメータを変更する場合は、「2.6.6　ポイントツーポイント デマンドの編集」（p.2-77）
を参照してください。変更しない場合は、[Cancel] をクリックして Edit Point to Point Demand ダイ

アログボックスを閉じます。

図 2-20 2 つのサイト間のポイントツーポイント デマンド
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2.3.4　保護リング デマンドの作成

P リング トラフィック デマンドの作成手順は、次のとおりです。

ステップ 1 「2.3　プロジェクトの作成」（p.2-25）の手順を使用するか、またはリング構成に手動でサイトを配

置することによって、リング ネットワークを作成します。

ステップ 2 Native Net# タブで、ツールバーの Create a new P-Ring demand アイコンをクリックします。P-Ring

Creation ウィザードが表示されます（図 2-21）。Cisco MetroPlanner のアイコンの詳細については、付

録 A「GUI 情報およびショートカット」を参照してください。

図 2-21 P-Ring Creation ウィザード

ステップ 3 General Parameters エリアで、次の情報を入力します。

• Label ― デマンド名を入力します。

• Service Type ― ドロップダウン リストからサービス タイプを選択します。サービスの一覧につ

いては、「1.2.6　サービス サポート」（p.1-4）を参照してください。

• Present # ch ― 作成するチャネル数を入力します。このフィールドに入力した値で、Forecast #
ch フィールドが自動的に更新されます。

• Forecast # ch ― 後日導入するチャネル数を入力します。この値には、Present # ch の値が含まれ

ます。たとえば、Present # ch の値として 4 を入力していて、将来 2 つのチャネルを追加する場

合は、6 を入力します。

ステップ 4 [Next] をクリックします。
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ステップ 5 Protection Sites エリアで、Ctrl を押し、P リングに追加するサイトをクリックします。P リングには

3 つ以上のサイトが必要です。右矢印ボタンをクリックします。リストに追加したサイトを削除す

る場合は、サイトをクリックし、左矢印ボタンをクリックします。

ステップ 6 Optical Bypass エリアで、Ctrl を押し、P リングに追加するサイトをクリックします。右矢印ボタン

をクリックします。リストに追加したサイトを削除する場合は、サイトをクリックし、左矢印ボタ

ンをクリックします。

ステップ 7 [Next] をクリックします。

ステップ 8 次のインターフェイス パラメータを入力します。使用できるオプションは、ステップ 3 で選択した

サービス タイプによって決まります。

• Transponder ― クリックして展開し、カード タイプのチェックボックスを選択し、サービス チャ

ネルの終端サイトでカードを選択します。

• Line Card ― クリックして展開し、カード タイプのチェックボックスを選択し、サービス チャ

ネルの終端サイトでカードを選択します。

• Alien Card ― 「2.2.5　サードパーティ製 DWDM インターフェイスの定義」（p.2-13）で説明し

たように、サードパーティ製のインターフェイスを作成した場合に限って表示されます。ク

リックして展開し、カード タイプのチェックボックスを選択し、サービス チャネルの終端サ

イトでカードを選択します。

• Pluggable Card ― クリックして展開し、カード タイプのチェックボックスを選択し、サービス

チャネルの終端サイトでカードを選択します。

ステップ 9 Client Interface エリアで、Source および Destination のドロップダウン リストから、送信元および宛

先のクライアント インターフェイス タイプ（SR、IR、または LR）を定義します。このオプション

を使用できるのは、プラガブル クライアント インターフェイスを備えたトランスポンダおよび

マックスポンダ インターフェイスの場合であり、選択したサービス タイプおよびカード タイプ

よって異なります。

ステップ 10 [Finish] をクリックします。Edit P-Ring Demand ダイアログボックスが表示されます。

デマンドは NtView < 名前 > タブおよび Service Demands > P-Rings フォルダの Project Explorer ツリー

に表示されます。デマンドは、選択されている場合は実線、選択されていない場合は点線になりま

す。ラインの上の数字は、存在するチャネル数を表します。図 2-22 に、サイト 1、2、3、および 5

間で選択されている 1 チャネル P リングおよびサイト 4 のオプティカル バイパスを示します。

（注） デマンド パラメータを変更する場合は、「2.6.7　P リング デマンドの編集」（p.2-78）を参照してく

ださい。変更しない場合は、[Cancel] をクリックして Edit P-Ring Demand ダイアログボックスを閉

じます。
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図 2-22 P リング デマンド

2.3.5　ROADM デマンドの作成

ROADM トラフィック グループおよびデマンドの作成手順は、次のとおりです。

ステップ 1 Project Explorer で、Groups フォルダを右クリックし、ショートカット メニューから Expand を選

択します。

ステップ 2 ROADM フォルダを右クリックし、ショートカット メニューから Create new ROADM group を選

択します。ROADM Group Creation ウィザードが表示されます。

ステップ 3 Group Name フィールドに ROADM トラフィック グループ名を入力します。

ステップ 4 適切なサイトを選択します。

ステップ 5 [Finish] をクリックします。Project Explorer の ROADM フォルダの下に、新しい ROADM トラフィッ

ク グループが表示されます。

ステップ 6 新しい ROADM トラフィック グループを右クリックし、ショートカット メニューから Create new

ROADM demand を選択します。Create ROADM Demand ダイアログボックスが表示されます（図

2-23）。
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図 2-23 Create ROADM Demand ダイアログボックス

ステップ 7 Demand Name フィールドにデマンド名を入力します。

ステップ 8 Traffic Type ドロップダウン リストからトラフィック パターン タイプ（Hub または Meshed）を選

択します。Hub を選択した場合は、First Site ドロップダウン リストが使用可能になります。Meshed

を選択した場合は、ステップ 10 に進みます。

ステップ 9 トラフィック タイプが Hub の場合、First Site ドロップダウン リストから起点サイトを選択します。

ステップ 10 Connectivity type ドロップダウン リストから接続タイプを選択します。Protected、Unprotected

Minimum Hop、Unprotected Optimum Path、または Unprotected Subnet です。選択肢の詳細につ

いては、「1.5.3　ROADM トラフィック デマンド」（p.1-11）を参照してください。Unprotected Subnet

を選択した場合は、次の手順に進みます。それ以外を選択した場合は、ステップ 12 に進んでくだ

さい。

ステップ 11 Unprotected Subnet を選択した場合は、ドロップダウン リストから開始サイトおよびリングの進行

方向を選択します。

ステップ 12 Service Types リストで、ROADM デマンドに対応するクライアント サービス タイプのボックスを 1

つ以上選択します。各サービス タイプをサポートするクライアント インターフェイスが Service

Types リスト右側の表に表示されます。

ステップ 13 クライアント インターフェイスの詳細を定義するために、表に示されたクライアント インター

フェイスごとに、次のオプションを入力します。グレー表示のチェックボックスは選択できません。

• Yes/No ― このカードでサービス タイプを実装する場合に選択します。

• Client Interface ― （表示のみ）選択したサービス タイプに対応するカード タイプが表示されま

す。

• Y Protected ― 接続タイプが Protected であり、Y 字型ケーブルで保護する場合に選択します。

• 1+1 Protected ― 接続タイプが Protected であり、1+1 方式で保護する場合に選択します。

• Fiber Switched ― 接続タイプが Protected であり、光ファイバ スイッチングによって保護する場

合に選択します。

• Supported Service ― （表示のみ）カードでサポートされるサービス タイプが表示されます。
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同じサービス タイプをサポートするクライアント インターフェイスを複数選択できます。デフォ

ルトでは、Cisco MetroPlanner によって、各サービスのサポートに最適なクライアント インターフェ

イスが選択されます。

ステップ 14 [Ok] をクリックしてデマンドを作成します。

2.3.6　ネットワークの削除

プロジェクトからネットワークを削除する場合は、Network Mgmt Tree タブでネットワークをクリッ

クし、Tasks Pane から Delete を選択します。プロジェクトで唯一のネットワークを削除することは

できません。

2.3.7　プロジェクトへの注釈の追加

Project Explorer の任意のアイテムに注釈を追加する手順は、次のとおりです。各ネットワークは、

Project Explorer に Notes フォルダがあります。注釈を作成すると、そのネットワークの Notes フォ

ルダに注釈が表示されます。

ステップ 1 Project Explorer で該当するアイテムを右クリックし、ショートカット メニューから Edit Notes を選

択します。

ステップ 2 Edit Note 作成ボックスに適切なテキストを入力します。

ステップ 3 Edit Note 作成ボックスを閉じて注釈を保存するには、ウィンドウ右上の X をクリックします。

ステップ 4 注釈を表示するには、Notes フォルダをダブルクリックします。Notes ウィンドウが表示されます。

表 2-6 に、Notes ウィンドウの各カラムを示します。

ステップ 5 Notes ウィンドウを閉じるには、ウィンドウ右上の X をクリックします。

表 2-6 Notes ウィンドウ

カラム 内容

Header 注釈のテキストが表示されます。注釈全体を表示する場合は、ヘッダーの横の

プラス（+）記号をクリックして、テキストを展開します。

Action Go をクリックし、注釈が作成された Project Explorer のアイテムを開きます。

Source 注釈の保存場所が表示されます。例：ProjectManager.Nets.Net2.Sites.Site2.W
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2.3.8　注釈の削除

Project Explorer の任意のアイテムから注釈を削除する手順は、次のとおりです。

ステップ 1 Notes フォルダをダブルクリックします。

ステップ 2 Notes ウィンドウで、削除する注釈に対応する Action カラムの [Go] をクリックします。Project

Explorer でそのアイテムが反転表示されます。

ステップ 3 Project Explorer でアイテムを右クリックし、ショートカット メニューから Delete Note を選択しま

す。
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2.4　ネットワークの分析
目的のサイト、光ファイバ スパン、およびサービス デマンドを作成したあとで、ネットワークを

分析し、ネットワーク パフォーマンスを調べる必要があります。ネットワークを分析するには、

ネットワーク ステートが Design、Install、または Upgrade でなければなりません。Cisco MetroPlanner

は設計を自動的に最適化して、光伝送のパフォーマンスを要約します。設計に問題があった場合は、

Analyzer Messages ペインに問題とその説明が表示されます。

ネットワークの分析手順は、次のとおりです。

ステップ 1 Networks Mgmt Tree タブをクリックし、分析するネットワークをクリックします。

ステップ 2 ツールバーの Analyze Network アイコンをクリックします。Cisco MetroPlanner アイコンの詳細につ

いては、付録 A「GUI 情報およびショートカット」を参照してください。または、Tasks Pane で

Analyze をクリックします。

MetroPlanner のアナライザ ステータス ウィンドウに進行状況が表示されます。Cisco MetroPlanner

の分析ステータス バーで、ネットワーク分析が完了したことがわかります。

ステップ 3 分析中に問題が発生した場合は、Analyzer タブをクリックすると、Analyzer Messages ペインに結果

が表示されます。Summary レポートが表示されます。詳細については、「2.5.1　Summary レポート

の表示」（p.2-42）を参照してください。警告およびエラー メッセージを手がかりに、現在の設計に

関連する問題を突き止めることができます。すべてのシステム メッセージを網羅したリストについ

ては、付録 C「システム メッセージ」を参照してください。

ステップ 4 必要に応じて、Summary レポートに示された問題を解決してください。ネットワークの問題を解決

すると、ネットワークを再度分析できます。

（注） Design -Analyzed ステートのネットワークを Design ステートに戻すと、変更を続けることができま

す。Networks Mgmt Tree でネットワークのアイコンをクリックし、Tasks Pane で Design をクリック

します。
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2.5　ネットワーク レポートの表示
Cisco MetroPlanner は、表 2-7 のレポートを提供します。レポートのアベイラビリティは、ネット

ワークが分析済みなのか、それとも Install または Upgarde ステートなのかによって異なります。サ

イトでもレポートを利用できます。レポート アベイラビリティの詳細については、表 2-7 を参照し

てください。

（注） 次の手順では、Tasks Pane を使用してレポートにアクセスしますが、Project Explorer ツリーの Reports
フォルダで目的のレポートをクリックすることによって、レポートにアクセスすることもできま

す。

Bill of Materials レポートの詳細については、「2.8　BoM の作成」（p.2-94）を参照してください。さ

らに Reports Diff ツールを使用すると、Bill of Material、Internal Connections、および Installation

Parameters のレポートを比較できます。

ここで説明する各手順を実行するには、プロジェクトを開き、ネットワークをロードしておく必要

があります。「2.1.1　プロジェクトの開き方」（p.2-3）および「2.1.2　ネットワークのロードおよび

アンロード」（p.2-4）を参照してください。

2.5.1　Summary レポートの表示

Summary レポートには、設計情報、光の成績、設計コスト、およびアナライザ メッセージの要約

が含まれます。Summary レポートは、ネットワークを分析する前後に表示できます。ネットワーク

を分析すると、自動的に表示されます。それ以外の時点でレポートを表示する手順は、次のとおり

です。

ステップ 1 次のいずれかの手順を実行します。

• ネットワークの Summary レポートを表示するには、Networks Mgmt Tree タブをクリックし、

さらにネットワークをクリックします。

• サイトの Summary レポートを表示するには、NtView < 名前 > タブをクリックし、さらにサイ

トをクリックします。

表 2-7 レポートのアベイラビリティ

レポート ネットワークに関するアベイラビリティ サイトに関するアベイラビリティ

NE Update Analyzed —

Installation Parameters Analyzed Analyzed 

Traffic Matrix Analyzed Analyzed 

Layout Install、Upgrade、および Analyzed Install、Upgrade、および Analyzed

Link Availability Analyzed Analyzed 

Internal Connections Analyzed —

Optical Results Analyzed Analyzed 

Wavelength Routing Analyzed —

Summary Install、Upgrade、および Analyzed Install、Upgrade、および Analyzed

Bill of Material Install、Upgrade、および Analyzed Install、Upgrade、および Analyzed
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ステップ 2 Tasks Pane で Summary をクリックします。Summary タブが表示されます（図 2-24）。

図 2-24 Summary タブ

表 2-8 に、Summary タブのカテゴリおよび内容を示します。
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2.5.2　NE Update ファイルの保存

Cisco MetroPlanner によるネットワーク分析が完了すると、コンフィギュレーション ファイルを作

成できます。システム リリースが 7.0 の場合は、ネットワークの全サイトのパラメータがすべて含

まれた XML ファイルが 1 つ 作成されます。システム リリースが 4.7 または 5.0 の場合は、ネット

ワークのサイトごとに TXT ファイルが 1 つずつ作成されます。このファイルは、CTC の NE Update

機能を使用して直接インポートできます。CTC ではこのファイルを使用して、ノードの事前プロビ

ジョニングを行います。

各ファイルにはデフォルトで、サイト名の文字列を使用した名前が付けられます。報告されるイン

ストール パラメータのリストは、設計しているネットワークで選択されたシステム リリースに

よって異なります。通常、Install ネットワークの分析後にこのファイルを保存します。

NE Update ファイルを保存する手順は、次のとおりです。

ステップ 1 Networks Mgmt Tree タブをクリックし、分析するネットワークをクリックします。

ステップ 2 Tasks Pane で NE Update をクリックします。Network Element Update File ダイアログボックスが表示

されます。

表 2-8 Summary タブのカテゴリ

カテゴリ 内容

Design info 次の情報が表示されます。

• Version ― Cisco MetroPlanner ソフトウェア リリースのバージョンが表示さ

れます。

• Customer name ― このネットワーク設計を要求しているカスタマーの名前

が表示されます。

• Created By ― ユーザのログイン名が表示されます。

• Release ― Cisco MetroPlanner ソフトウェア リリース番号が表示されます。

Optical results ネットワークに含まれているデマンド数、各デマンドのアラームの数および重

大度が示されます。

Design cost info 次の情報が表示されます。

• Price list ― 使用する価格表が表示されます。

• Currency ― 価格表に対して選択されている通貨が表示されます。

• BoM total discounted ― 値引き適用後のネットワーク製品（スペア部品を除

く）の合計価格が表示されます。

• Spare total discounted ― 値引き適用後のネットワーク スペア部品の合計価

格が表示されます。

• BoM + Spare total discounted ― 値引き適用後のネットワーク製品（スペア部

品を含む）の合計価格が表示されます。

Messages ネットワーク分析の結果として生じたアナライザ メッセージが表示されます。

警告およびエラー メッセージを手がかりに、現在の設計に関連する問題を突き

止めることができます。すべてのシステム メッセージを網羅したリストについ

ては、付録 C「システム メッセージ」を参照してください。
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ステップ 3 Include wavelenght parameters チェックボックスを選択して、NE Update XML ファイルにトランク

の波長事前プロビジョニングを含めます。NE Update ファイルのインポート先ネットワークが

System Release 7.0.0 を使用している場合は、このチェックボックスを選択しません。このオプショ

ンを選択すると、現在のトラフィック デマンドをサポートするために必要なすべての TXP および

MXP 装置に対して、CTC でトランクの波長が事前プロビジョニングされます。

（注） プロジェクトの作成時に、MSTP-Release 7.0 を選択すると、System Release 7.0.0 および 7.0.x
対応のプロジェクトを作成できます。しかし、System Release 7.0.0 を使用しているノードに

NE Update ファイルをインポートしても、Include wavelength parameters が選択されていると、

ノードは NE Update XML ファイルを判読できません。

ステップ 4 Destination フォルダ以外のディレクトリにファイルを保存する場合は、Change をクリックし、適

切なディレクトリに移動します。[Save] をクリックします。

ステップ 5 [Finish] をクリックします。

ステップ 6 [Cancel] をクリックすると、コンフィギュレーション セットアップ ファイルを保存しないまま、

ウィンドウが閉じます。

2.5.3　Installation Parameters の表示

Installation Parameters レポートには、ネットワークの各サイトについて、インストール時に設定（プ

ロビジョニング）された値が示されます。これらのパラメータは、NE Update ファイルの保存時に

エクスポートされ、CTC を使用してノードを自動プロビジョニングするために使用されます。

ネットワークの分析後に、インストール パラメータを表示する手順は、次のとおりです。

ステップ 1 次のいずれかの手順を実行します。

• ネットワークの Installation Parameters レポートを表示するには、Networks Mgmt Tree タブをク

リックし、さらにネットワークをクリックします。

• サイトの Installation Parameters レポートを表示するには、NtView < 名前 > タブをクリックし、

さらにサイトをクリックします。

ステップ 2 Tasks Pane で Installation Parameters をクリックします。Installation Parameters タブが表示されます

（図 2-25）。デフォルトでは ANS view サブタブが表示されます。このタブには、Automatic Node Setup

（自動ノード設定）情報が表示されます。
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2.5　ネットワーク レポートの表示
図 2-25 Instalation Parameters タブの ANS view サブタブ

表 2-9 で、Installation Parameters レポートの ANS view タブのカラムについて説明します。

ステップ 3 ANP view タブをクリックすると、Automatic Node Provisioning（自動ノード プロビジョニング）情

報が表示されます。表 2-10 で、Installation Parameters レポートの ANP view タブのカラムについて

説明します。

表 2-9 Installation Parameters レポート ANS view タブのカラム

カテゴリ 内容

Name サイト名が表示されます。

Side ノード インターフェイスが表示されます。T（終端）、E（東）、または W（西）

です。

Position パッチコードの起点となるカードのラック、シェルフ、およびスロット位置

が表示されます。

Unit カード名が表示されます。

Port # パッチコードの起点となるポート番号が表示されます。

Port ID ポート ID が表示されます。

Port Label ポート名が表示されます。

Parameter RX Power Low など、設定されているパラメータ名が表示されます。

Value 設定されている値の名前が表示されます。

Measurement Unit dBm など、関連するインストール パラメータ値の計測単位が表示されます。

Manual Set CTC インターフェイスを使用して手動でパラメータを設定する必要性の有無

が示されます。
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2.5　ネットワーク レポートの表示
ステップ 4 PP view タブをクリックすると、Provisioning Parameters（プロビジョニング パラメータ）情報が表

示されます。表 2-11 で、Installation Parameters レポートの PP view タブのカラムについて説明します。

ステップ 5 Installation Parameters レポートを閉じるには、Installation Parameters タブ右上の X をクリックします。

2.5.4　Internal Connections の表示

ネットワークの分析後に、ネットワーク内部接続を表示する手順は、次のとおりです。

この手順で、トランスポンダと Y 字型ケーブル保護モジュール間のパッチコード接続を表示するこ

ともできます。Y 字型ケーブル保護の位置は、ラックおよびシェルフ番号で定義します。スロット

は、シェルフに配置できる 4 つのモジュールごとに、左から右の順に番号が付けられます。

ステップ 1 Networks Mgmt Tree タブをクリックし、分析するネットワークをクリックします。

ステップ 2 Tasks Pane で Internal Connections をクリックします。Internal Connections タブが表示されます（図

2-26）。

表 2-10 Installation Parameters レポート ANP view タブ

カテゴリ 内容

Name サイト名が表示されます。

Shelf ID シェルフ ID が表示されます。

Rack number ラック番号が表示されます。

Rack position シェルフ内のラック位置が示されます。

Slot position カードに対応するシェルフ内のスロット位置が示されます。

Equipment type カード タイプが表示されます。

表 2-11 Installation Parameters レポート PP view タブ

カテゴリ 内容

Name サイト名が表示されます。

Shelf ID シェルフ ID が表示されます。

Slot position PPM を装備したカードのスロット番号が表示されます。

Port position ポート番号が表示されます。

Ppm position カード上の PPM の位置が表示されます。

Pp name PPM 名が表示されます。

value インストール パラメータ値が表示されます。
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2.5　ネットワーク レポートの表示
図 2-26 Internal Connections タブ

表 2-12 に、Internal Connections タブのカラムおよび内容を示します。カラムをクリックすると、そ

のカラムに基づいて表の情報が並べ替えられます。

• Patchcord installation view サブタブをクリックし、インストーラがサイト内でカードの各種

ポート間を機械的に接続しなければならない、すべてのパッチコード接続を表示します。

• SQ Provisioning view サブタブをクリックし、ローカル Cisco Transport Controller（CTC）イン

ターフェイス上のパッチコード表示を確認します。このサブタブには、ノード上で動作してい

るソフトウェアが自動的に生成するデフォルトの接続に対して、手動で設定または削除するす

べての接続が含まれています。
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2.5　ネットワーク レポートの表示
ステップ 3 外部ファイルに情報をエクスポートする場合は、[Export] をクリックします。Internal connections

export ダイアログボックスに、ファイル名を入力し、適切なフォルダに移動します。[Save] をクリッ

クします。

ステップ 4 Internal Connections タブを閉じるには、タブの右隅の X をクリックします。

2.5.5　Traffic Matrix Report の表示

Traffic Matrix レポートには、ポイントツーポイント、P リング、および ROADM チャネルのデータ

が表示されます。Traffic Matrix レポートを表示する手順は、次のとおりです。

ステップ 1 次のいずれかの手順を実行します。

• ネットワークの Traffic Matrix レポートを表示するには、Networks Mgmt Tree タブをクリック

し、さらにネットワークをクリックします。

• サイトの Traffic Matrix レポートを表示するには、NtView < 名前 > タブをクリックし、さらに

サイトをクリックします。

ステップ 2 Tasks Pane の Reports の下で Traffic Matrix をクリックします。Traffic Matrix タブが表示されます。

デフォルトのクエリーが開きます。

表 2-12 Internal Connections タブのカラム

カラム名 内容

Name サイト名が表示されます。SW provisioning view サブタブでは、このカラムは

CTC インターフェイスを使用して接続を手動で設定または削除するかどうか

を示します。

Position-1 パッチコードの起点となるカードのラック、シェルフ、およびスロット位置

が表示されます。

Unit-1 カード名が表示されます。

Port Num （SW Provisioning view サブタブのみ）パッチコードが終端するポートの番号

が表示されます。

Port ID-1 （SW provisioning view サブタブのみ）ポート ID が表示されます。

Port label-1 ポート名が表示されます。

Attenuator 指定されている場合は、この接続に装備されるバルク減衰器の製品 ID です。

プリアンプの DC-TX および DC-RX ポート間に内部減衰器を設置しなければ

ならない場合（DCU を装備しない場合）にも報告されます。

Position-2 パッチコードの終点となるカードのラック、シェルフ、およびスロット位置

が表示されます。

Unit-2 カード名が表示されます。

Port Num （SW Provisioning view サブタブのみ）パッチコードが終端するポートの番号

が表示されます。

Port ID-2 （SW provisioning view サブタブのみ）ポート ID が表示されます。

Port Label-2 ポート名が表示されます。

P/F 接続が現在の回線に関連するのか、将来の回線に関連するかのかが示されま

す。
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2.5　ネットワーク レポートの表示
図 2-27 Traffic Matrix タブ

タブの各ローは、光路のパフォーマンスを示します。表 2-18 で、カラムの情報について説明しま

す。Traffic Matrix レポートでは、光チャネルの TX 方向と RX 方向で別々のローが表示されます。

（注） レポートにカラムを追加するには、カラムを右クリックし、ショートカット メニューから

カラム名を選択します。ショートカット メニューでチェックマークの入っているカラム名

がレポートに含まれます。カラムを削除する場合は、カラムを右クリックし、ショートカッ

ト メニューからチェックマーク付きのカラムを選択します。

表 2-13 Traffic Matrix タブのカラム

カラム ラベル 内容

Service Demand 各デマンド タイプが分類されます（ポイントツーポイント、P リング、

および ROADM）。デマンド タイプの横のプラス（+）記号をクリック

して展開し、光チャネルを表示します。

Service Circuit 光チャネルのラベル（Site1-Site2 など）が表示されます。

OCH CC Source 光チャネルの起点となるサイト名が表示されます。

OCH CC Source Position 光チャネルの起点に対応するラック、シェルフ、およびスロット ID が

表示されます。フィールドの形式は Rack.Shelf.Slot です。

OCH CC Source Unit 光チャネルの起点となる装置名が表示されます。

OCH CC Source Port 光チャネルの起点となるポートが表示されます（Client RX など）。

OCH CC Dst 光チャネルの終点となるサイト名が表示されます。

OCH CC Dst Position 光チャネルの終点に対応するラック、シェルフ、およびスロット ID が

表示されます。フィールドの形式は Rack.Shelf.Slot です。

OCH CC Dst Unit 光チャネルの終点となる製品 ID が表示されます。

OCH CC Dst Port 光チャネルの終点となるポートが表示されます（Client TX など）。
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2.5　ネットワーク レポートの表示
ステップ 3 新しいクエリーを作成する場合は、[New Query] をクリックして Query Dialog（図 2-28）を開きま

す。Query Dialog を使用すると、各種パラメータおよびテンプレートを使用して、光の成績をフィ

ルタリングできます。

A/D Source 分岐挿入（add/drop）チャネルの起点となるサイト名が表示されます。

A/D Source Position 分岐挿入（add/drop）チャネルの起点に対応するラック、シェルフ、お

よびスロット ID が表示されます。フィールドの形式は Rack.Shelf.Slot

です。

A/D Source Unit 分岐挿入（add/drop）チャネルの起点となる装置名が表示されます。

A/D Source Port 分岐挿入（add/drop）チャネルの起点となるポートが表示されます

（Client RX など）。

A/D Dst 分岐挿入（add/drop）チャネルの終点となるサイト名が表示されます。

A/D Dst Position 分岐挿入（add/drop）チャネルの終点に対応するラック、シェルフ、お

よびスロット ID が表示されます。フィールドの形式は Rack.Shelf.Slot

です。

A/D Dst Unit 分岐挿入（add/drop）チャネルの終点となる製品 ID が表示されます。

A/D Dst Port 分岐挿入（add/drop）チャネルの終点となるポートが表示されます

（Client TX など）。

Cl. Serv. Type デマンドのクライアント サービス タイプ（OC-48 など）が表示されま

す。

Protection デマンドの保護タイプ（P-ring、Y-cable など）が表示されます。

Wavelength 光チャネルの波長が表示されます。

Opt Bypass TXP または MXP カードで終端しない場合に、光チャネルが廃棄され

て再挿入される位置（オプティカル バイパス）を示します。Op Bypass

カラムに「none」が表示された場合、その光チャネルにはオプティカ

ル バイパスが定義されていません。

DWDM Interface Type 光チャネルに使用する DWDM インターフェイス タイプを示します。

• Transponder は、光チャネルに MSTP トランスポンダ、MSTP マッ

クスポンダ、または DWDM プラガブル ポート モジュールを使用

することを表します。

• Line Card は、光チャネルに ITU ライン カードを使用することを表

します。

DWDM Card Type 光チャネルに使用するトランスポンダまたはライン カードのタイプを

示します。

表 2-13 Traffic Matrix タブのカラム（続き）

カラム ラベル 内容
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2.5　ネットワーク レポートの表示
図 2-28 Query Dialog 

ステップ 4 個々のパラメータを使用してクエリーを実行する場合は、Query Definition エリアのドロップダウン

リストから該当するパラメータを選択します。画面最下部の Query Preview エリアに選択したパラ

メータが表示されます。表 2-14 で、Query Dialog の各フィールドについて説明します。

表 2-14 Query Dialog のフィールド

カラム ラベル 内容

Group 選択したグループのデータだけが含まれるように、レポートをフィルタリン

グできます。Project Explorer ビューのネットワーク フォルダのところでグ

ループを表示することもできます。

Demand 選択したデマンドのデータだけが含まれるように、レポートをフィルタリン

グできます。デマンド フィールドを使用できるのは、特定のトラフィック グ

ループを選択した場合だけです。

DWDM Card Type 選択した DWDM カード タイプのデータだけが含まれるように、レポートを

フィルタリングできます。

Source 特定の起点サイトとの間の着信サービスまたは発信サービスの結果だけが含

まれるように、レポートをフィルタリングできます。

Destination 特定の終点サイトとの間の着信サービスまたは発信サービスの結果だけが含

まれるように、レポートをフィルタリングできます。

Wavelength 指定した波長を使用するサービスだけが含まれるように、レポートをフィル

タリングできます。

Alarm グリーン、イエロー、オレンジ、またはレッド表示のフラグ付きサービスだ

けが含まれるように、レポートをフィルタリングできます。

P/F 現在のサービスだけ、将来のサービスだけ、または両方が含まれるように、

レポートをフィルタリングできます。

Virtual Optical Results Table に仮想チャネルが含まれるように、または仮想チャネル

が除外されるように、レポートをフィルタリングできます。
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ステップ 5 必要に応じて、次のいずれかを選択します。

• [Run Query] をクリックします。ウィンドウが閉じ、Traffic Matrix タブにクエリー結果が表示

されます（図 2-27）。ボタン バーのすぐ下、水平エリアにクエリーのパラメータが表示されます。

• [Reset Query] をクリックして、Query Dialog での選択を消去します。

• [Close] をクリックして、クエリーを実行しないでウィンドウを閉じます。

ステップ 6 Traffic Matrix レポートを閉じるには、タブの右隅の X をクリックします。

2.5.6　Layout の表示

分析対象ネットワークの各サイトをグラフィック表示する手順は、次のとおりです。

ステップ 1 NtView < 名前 > タブをクリックして、目的のサイトをクリックします。

ステップ 2 Tasks Pane で Layout をクリックします。Layout タブが表示されます（図 2-29）。サイトを変更する

には、ドロップダウン リストから適切なサイトを選択します。

図 2-29 Layout レポート（ラック ビュー）
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2.5　ネットワーク レポートの表示
ステップ 3 Site のドロップダウン リストから、レイアウト レポートに表示するネットワーク サイトを選択し

ます。

ステップ 4 タブ左側のツリー ビューで、ラックを右クリックし、Expand を選択して、ラック内のすべてのシェ

ルフおよびカードを示したリストを表示します。

ステップ 5 適切なラックまたはシェルフをクリックして、レイアウト グラフィックとして表示します。図 2-30

に、シェルフ ビューを示します。

図 2-30 Layout レポート（シェルフ ビュー）

ステップ 6 カードの詳細を表示するには、カードをダブルクリックします。クライアント情報を示した Details

ダイアログボックスが開きます。

• Label ― カード名が表示されます。

• Product ID ― カードの製品 ID が表示されます。

• Service Category ― 将来の使用

• Description ― カードの機能について簡単な説明が表示されます。

• Price ― プロジェクト作成時に選択した価格表に基づいて、カードの価格が表示されます。

• ITU Channel ― カードの ITU チャネル波長が表示されます。
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トランスポンダおよびマックスポンダ カードについては、Details ダイアログボックスの Modules

サブタブをクリックすると、各 TXP/MXP 装置に使用するプラガブル ポート モジュールが表示され

ます。

• P/F ― P は現在のクライアント デマンドをサポートするプラガブル ポート モジュールを表し

ます。F は将来のクライアント デマンドをサポートするプラガブル ポート モジュールを表し

ます。

• Module PID ― プラガブル ポート モジュールの製品 ID が表示されます。

• Ch# ― 装置のポート番号が表示され、プラガブル ポート モジュールの取り付け位置が指定さ

れます。

[Close] をクリックして、Details ダイアログボックスを閉じます。

ステップ 7 レイアウト表示をフィルタリングするには、ドロップダウン リストから次のいずれか 1 つを選択し

ます。

• Any ― 現在および将来の両方のトラフィック デマンドに関連するカードがすべて表示されま

す。

• Present ― 現在のトラフィック デマンドに関連するカードだけが表示されます。

• Locked & Unlocked ― レイアウト内でロックされているカードおよびロック解除されている

カードが強調表示されます。

• Alarmed ― レイアウト内でアラームのあるカードが強調表示されます。

ステップ 8 ネットワーク分析後は、すべてのアイテムがロック モードになります。カードのロックを解除し、

ネットワーク解析時に、Cisco MetroPlanner がレイアウトを再調整して、スロットの使用が最適化さ

れるようにするには、ラック ツリーでロックされているカードを右クリックし、Unlock を選択し

ます。

（注） ロックを解除できるのは、Design ステートの Upgrade ネットワークに限られます。

ステップ 9 レイアウトのグラフィック表示を JPEG フォーマットでエクスポートするには、[Export] をクリッ

クします。Layout export ダイアログボックスに、ファイル名を入力し、適切なフォルダに移動しま

す。[Save] をクリックします。

ステップ 10 レイアウト グラフィックを縮小または拡大するには、Zoom In アイコンおよび Zoom Out アイコン

をそれぞれクリックします。Cisco MetroPlanner のアイコンの詳細については、付録 A「GUI 情報お

よびショートカット」を参照してください。

ステップ 11 Layout レポートを閉じるには、タブの右隅の X をクリックします。

2.5.7　Layout レポートからの消費電力の表示

サイト内の装置ごとに消費電力を表示する手順は、次のとおりです。消費電力は、Layout レポート

からレポート形式で確認できます。

ステップ 1 NtView < 名前 > タブをクリックして、目的のサイトをクリックします。

ステップ 2 Tasks Pane で Layout をクリックします。Layout タブが表示されます（図 2-29）。サイトを変更する

には、ドロップダウン リストから適切なサイトを選択します。
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2.5　ネットワーク レポートの表示
ステップ 3 レポート ツールバーの View layout as table アイコンをクリックします。Layout Table レポートが表

示されます（図 2-31）。

図 2-31 消費電力

表 2-15 で、各カラムの情報について説明します。

表 2-15 Layout Table（消費電力）のカラム

カラム ラベル 内容

Name サイトの機器が表示されます。

Position 該当する装置のラック、シェルフ、またはスロット位置が示さ

れます。

Description 各装置タイプの説明が表示されます。

Max Power Consumption (W) 各装置の最大消費電力が表示されます。

（注） プラガブル ポート モジュールを装備したトランスポン
ダ / マックスポンダ カードの場合、表示される最大消費
電力は、最大数のプラガブル ポート モジュールを装備
したフル搭載ボードの値です。

Average Power Consumption (W) 該当する装置の平均消費電力が表示されます。

（注） プラガブル ポート モジュールを装備したトランスポン
ダ / マックスポンダ カードの場合、表示される平均消費
電力は、最大数のプラガブル ポート モジュールを装備
したフル搭載ボードの値です。
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2.5　ネットワーク レポートの表示
ステップ 4 消費電力のデータをエクスポートするには、[Export] をクリックします。Layout table export ダイア

ログボックスが表示されます。ファイル名を入力し、適切なフォルダに移動します。[Save] をク

リックします。

ステップ 5 [Close] をクリックして Layout Table レポートを閉じます。

2.5.8　Link Availability レポートの表示

Cisco MetroPlanner は、装置故障率および修理時間に基づいて、リンクのアベイラビリティを判断し

ます。Link Availability レポートを表示する手順は、次のとおりです。

ステップ 1 次のいずれかの手順を実行します。

• ネットワークの Link Availability レポートを表示するには、Networks Mgmt Tree タブをクリッ

クし、さらにネットワークをクリックします。

• サイトの Link Availability レポートを表示するには、NtView < 名前 > タブをクリックし、さら

にサイトをクリックします。

ステップ 2 Tasks Pane で Link Availability をクリックします。Link Availability タブが表示されます（図 2-32）。

図 2-32 Link Availability レポート
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2.5　ネットワーク レポートの表示
タブの各ローは、光路のパフォーマンスを示します。表 2-16 で、カラムの情報について説明します。

ステップ 3 [New Query] をクリックして Query Dialog を開きます（図 2-28）。Query Dialog を使用すると、各種

パラメータを使用して、リンク アベイラビリティをフィルタリングできます。

ステップ 4 個々のパラメータを使用してクエリーを実行する場合は、Query Definition エリアのドロップダウン

リストから該当するパラメータを選択します。画面最下部の Query Preview エリアに選択したパラ

メータが表示されます。表 2-17 で、Query Dialog の各フィールドについて説明します。

表 2-16 Link Availability タブのカラム

カラム ラベル 内容

Group 各デマンド タイプが分類されます（ポイントツーポイント、P リ

ング、および ROADM）。デマンド タイプの横のプラス（+）記号

をクリックして展開し、光チャネルを表示します。

Serv.Circuit 光チャネルのラベル（Site1-Site2 など）が表示されます。

P/F チャネルが現在および将来（P/F）なのか将来（F）なのかを示し

ます。

DWDM Card Type 光チャネルに使用するトランスポンダまたはライン カードのタ

イプを示します。

Protection デマンドの保護タイプ（P-ring、Y-cable など）が表示されます。

Cl. Serv. Type デマンドのクライアント サービス タイプ（OC-48 など）が表示さ

れます。

Source 光チャネルの起点となるサイト名が表示されます。

Destination 光チャネルの終点となるサイト名が表示されます。

Link Availability (% Complete) リンク アベイラビリティの割合が表示されます。リンク アベイラ

ビリティは、故障率および修理時間に基づいて算出されます。

表 2-17 Query Dialog のフィールド

カラム ラベル 内容

Group 選択したグループのデータだけが含まれるように、レポートをフィルタリン

グできます。Project Explorer ビューのネットワーク フォルダのところでグ

ループを表示することもできます。

Demand 選択したデマンドのデータだけが含まれるように、レポートをフィルタリン

グできます。デマンド フィールドを使用できるのは、特定のトラフィック グ

ループを選択した場合だけです。

DWDM Card Type 選択した DWDM カード タイプのデータだけが含まれるように、レポートを

フィルタリングできます。

Source 特定の起点サイトとの間の着信サービスまたは発信サービスの結果だけが含

まれるように、レポートをフィルタリングできます。

Destination 特定の終点サイトとの間の着信サービスまたは発信サービスの結果だけが含

まれるように、レポートをフィルタリングできます。

Wavelength 指定した波長を使用するサービスだけが含まれるように、レポートをフィル

タリングできます。

P/F 現在のサービスだけ、将来のサービスだけ、または両方が含まれるように、

レポートをフィルタリングできます。
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2.5　ネットワーク レポートの表示
ステップ 5 必要に応じて、次のいずれかを選択します。

• [Run Query] をクリックします。ウィンドウが閉じ、Link Availability タブにクエリー結果が表

示されます。ボタン バーのすぐ下、水平エリアにクエリーのパラメータが表示されます。

• [Reset Query] をクリックして、Query Dialog での選択を消去します。

• [Close] をクリックして、クエリーを実行しないでウィンドウを閉じます。

ステップ 6 Link Availability レポートを閉じるには、タブの右隅の X をクリックします。

2.5.9　Optical Results の表示

作成および分析したネットワークの光成績を表示する手順は、次のとおりです。

ステップ 1 次のいずれかの手順を実行します。

• ネットワークの Optical Results レポートを表示するには、Networks Mgmt Tree タブをクリック

し、さらにネットワークをクリックします。

• サイトの Optical Results レポートを表示するには、NtView < 名前 > タブをクリックし、さらに

サイトをクリックします。

ステップ 2 Tasks Pane で Optical Reslts をクリックします。Optical Results タブが表示されます（図 2-33）。

図 2-33 Optical Results タブ
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2.5　ネットワーク レポートの表示
タブの各ローは、光路のパフォーマンスを示します。表 2-18 で、カラムの情報について説明します。

表 2-18 Optical Results タブのカラム

カラム ラベル 内容

Name チャネルが設計に入力された順に、各パスに自動的に割り当てられた識

別番号が表示されます。

Group 光チャネルのデマンド グループが表示されます。

Protect チャネルの保護タイプが表示されます。保護チャネルの場合、両方のパ

スが表示されます。起点の東側から出るパスが先に示されます。

SOL 実行した分析結果の要約が Start of Life 光ファイバ損失値として表示さ

れます。インジケータは、双方向 Optical Chanel Trail（OCH Trail）の方

向ごとに、光のパフォーマンスを示します。グリーンは成功、イエロー

は境界障害リスク（0 ～ 16%）を意味します。オレンジはチャネル障害

のリスクが高い（16 ～ 50%）ことを表し、レッドは障害を表します。

EOL 実行した分析結果の要約が End of Life 光ファイバ損失値として表示され

ます。インジケータは、双方向 Optical Chanel Trail（OCH Trail）の方向

ごとに、光のパフォーマンスを示します。インジケータは、光ファイバ

の寿命時点でのパスの光パフォーマンスを示します。グリーンは成功、

イエローは境界障害リスク（0 ～ 16%）を意味します。オレンジはチャ

ネル障害のリスクが高い（16 ～ 50%）ことを表し、レッドは障害を表し

ます。

SE 設計の分析に影響を与える可能性のある、システム関連エラーの存在を

示します。

このインジケータがレッドの場合は、分析の最後にレポートされたメッ

セージを確認して、問題のある装置またはサイトを特定してください。

Chr. Disp. [ps/nm] 波長分散検査の値が表示されます。グリーンは、波長分散検査に合格し

たことを意味します。レッドは、波長分散検査に不合格だったことを意

味します。

Penalty 各種フィルタ タイプ（OADM、ROADM、および Arrayed Wavelength

Graging [AWG]）がもたらしたペナルティの値およびステータスが表示さ

れます。グリーンは、ペナルティ チェックに合格したことを意味します。

レッドは、ペナルティ チェックに不合格だったことを意味します。

Wavelength 光路に割り当てられた波長が表示されます。

P/F 現在 / 将来のサービス表示です。

Source 起点サイト名およびサイドが表示されます（Site 1-E など）。

Destination 終点サイト名およびサイドが表示されます（Site 1-E など）。

Span (km) このパスの総スパン長（起点から終点）がキロメートル単位で表示され

ます。

Tx Type 特定の OCH Trail に使用する DWDM 装置またはプラガブル ポート モ

ジュールのタイプが表示されます。

BER target このチャネルの光インターフェイスの能力に基づいて、チャネルが目標

とする BER（ビット エラー レート）が表示されます。Forward Error

Correction（FEC; 前方エラー訂正）を使用するインターフェイスの場合

は 1.0E-15、FEC を使用しないインターフェイスでは 1.0E-12 です。

SOL OSNR (dB) 寿命の最初の時点での、レシーバーにおける平均 Optical Signal-to-Noise

Ratio（OSNR; 光信号対雑音比）が表示されます。OSNR は、選択された

Resolution Bandwidth（RBW; 分解能帯域幅）を表します。
2-60
Cisco MetroPlanner DWDM オペレーション ガイド

OL-10358-01-J



第 2 章      Cisco MetroPlanner によるネットワーク設計

2.5　ネットワーク レポートの表示
ステップ 3 [New Query] をクリックして Query Dialog を開きます（図 2-28）。Query Dialog を使用すると、各種

パラメータを使用して、光の成績をフィルタリングできます。

ステップ 4 個々のパラメータを使用してクエリーを実行する場合は、Query Definition エリアのドロップダウン

リストから該当するパラメータを選択します。画面最下部の Query Preview エリアに選択したパラ

メータが表示されます。表 2-19 で、Query Dialog の各フィールドについて説明します。

EOL OSNR (dB) 寿命の最後の時点でのレシーバーにおける平均 OSNR 値が表示されま

す。OSNR は、選択された RBW 帯域幅を意味します。

SOL OSNR Margin (dB) SOL OSNR マージンの計算が表示されます。これは、レシーバー クライ

アントの動作ポイントの一定のパワーにおける OSNR 値と動作エリア境

界の差です。

EOL OSNR Margin (dB) EOL OSNR マージンの計算が表示されます。これは、レシーバー クライ

アントの動作ポイントの一定のパワーにおける OSNR 値と動作エリア境

界の差です。

SOL RX (dBm) 終点サイトにおける、SOL 受信平均パワーが dBm で表示されます。

EOL RX (dBm) 終点サイトにおける、EOL 受信平均パワーが dBm で表示されます。

SOL Power margin (dB) レシーバーにおける SOL パワー バジェット マージンがデシベル単位で

表示されます。これは、レシーバー動作ポイントとマージンを含む BER

曲線間のオフセットとして定義されます。値が正の場合は、パワーに問

題はありません。

EOL Power margin (dB) レシーバーにおける EOL パワー バジェット マージンがデシベル単位で

表示されます。これは、レシーバー動作ポイントとマージンを含む BER

曲線間のオフセットとして定義されます。値が正の場合は、パワーに問

題はありません。

SOL Overload (dB) レシーバーにおける SOL 過負荷マージンがデシベル単位で表示されま

す。値が正の場合は、過負荷の問題はありません。

EOL Overload (dB) レシーバーにおける EOL 過負荷マージンがデシベル単位で表示されま

す。値が正の場合は、過負荷の問題はありません。

RX atten レシーバーの入力での減衰量が表示されます。

PMD (ps) 回線ごとに計算された総 PMD が表示されます。この合計値には、パス

上の光ファイバおよび DWDM 装置を含め、OCH Trail のすべての PMD

コンポーネントが含まれます。リンク全体の PMD が許容最大値を上回っ

た場合は、PMD 値がレッドで表示されます。許容最大値は、クライアン

ト インターフェイスによって異なります。このような特殊なケースで

は、代理店の光が専門のセールス エンジニアに連絡し、手動でネット

ワークを解決する必要があります。

Latency 現在の回線の遅延時間が表示されます。この値には、パス上の光ファイ

バおよび DWDM 装置を含め、OCH Trail のすべての遅延コンポーネント

が含まれます。

表 2-18 Optical Results タブのカラム（続き）

カラム ラベル 内容
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2.5　ネットワーク レポートの表示
ステップ 5 必要に応じて、次のいずれかを選択します。

• [Run Query] をクリックします。ウィンドウが閉じ、Optical Results タブにクエリー結果が表示

されます。ボタン バーのすぐ下、水平エリアにクエリーのパラメータが表示されます。

• [Reset Query] をクリックして、Query Dialog での選択を消去します。

• [Close] をクリックして、クエリーを実行しないでウィンドウを閉じます。

ステップ 6 Optical Results レポートを閉じるには、タブの右隅の X をクリックします。

2.5.10　Wavelength Routing の表示

分析対象ネットワークの波長ルーティング マップを表示する手順は、次のとおりです。

ステップ 1 Networks Mgmt Tree タブをクリックし、分析するネットワークをクリックします。

ステップ 2 Tasks Pane で Wavelength Routing をクリックします。Wavelentgh Routing タブが表示されます（図

2-34）。プラットフォームがサポートする波長ごとに 1 行ずつ表示されます。

（注） ROADM（Any-to-Any）デマンドは、このレポートには含まれません。

表 2-19 Query Dialog のフィールド

カラム ラベル 内容

Group 選択したグループのデータだけが含まれるように、レポートをフィルタ

リングできます。Project Explorer ビューのネットワーク フォルダのとこ

ろでグループを表示することもできます。

Demand 選択したデマンドのデータだけが含まれるように、レポートをフィルタ

リングできます。デマンド フィールドを使用できるのは、特定のトラ

フィック グループを選択した場合だけです。

DWDM Card Type 選択した DWDM カード タイプのデータだけが含まれるように、レポー

トをフィルタリングできます。

Source 特定の起点サイトとの間の着信サービスまたは発信サービスの結果だけ

が含まれるように、レポートをフィルタリングできます。

Destination 特定の終点サイトとの間の着信サービスまたは発信サービスの結果だけ

が含まれるように、レポートをフィルタリングできます。

Wavelength 指定した波長を使用するサービスだけが含まれるように、レポートを

フィルタリングできます。

Alarm グリーン、イエロー、オレンジ、またはレッド表示のフラグ付きサービ

スだけが含まれるように、レポートをフィルタリングできます。

P/F 現在のサービスだけ、将来のサービスだけ、または両方が含まれるよう

に、レポートをフィルタリングできます。

Virtual Optical Results Table に仮想チャネルが含まれるように、または仮想チャ

ネルが除外されるように、レポートをフィルタリングできます。
2-62
Cisco MetroPlanner DWDM オペレーション ガイド

OL-10358-01-J



第 2 章      Cisco MetroPlanner によるネットワーク設計

2.5　ネットワーク レポートの表示
図 2-34 Wavelength Routing タブ

ステップ 3 ドロップダウン リストから、Any（将来と現在の両方のルーティングを表示する場合）、Present（現

在のルーティングだけを表示する場合）、または Forecast（将来のルーティングだけを表示する場

合）のいずれか 1 つを選択します。Any を選択した場合、Forecast デマンドはグレー地で表示され

ます。

表 2-20 で、各カラムの情報について説明します。

表 2-20 Wavelength Routing タブのカラム

カラム ラベル 内容

wl プラットフォームがサポートする波長が表示されます。

Site # ネットワーク内のサイトです。Site カラムの色は、サイトのそれぞれの側の

SOL/EOL チャネル ステータスを表します。グリーンは成功、イエローは境界

障害リスク（0 ～ 16%）を意味します。オレンジはチャネル障害のリスクが高

い（16 ～ 50%）ことを表し、レッドは障害を表します。

Duct # ネットワーク内のダクトです。

W サイトの西側を意味します。

E サイトの東側を意味します。

Couple サイトの光ファイバ ペアを表します。
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2.5　ネットワーク レポートの表示
（注） このレポートでは、ツールのヒントが利用できます。Site カラムにカーソルを置くと、回線

情報、カード名、および製品 ID が得られます。Duct/Couple カラムにカーソルを置くと、損

失、長さ、および光ファイバのタイプが得られます。

ステップ 4 レイアウトのグラフィック表示を JPEG フォーマットでエクスポートするには、[Export] をクリッ

クします。Wavelength Routing export ダイアログボックスに、ファイル名を入力し、適切なフォルダ

に移動します。[Save] をクリックします。

ステップ 5 WaveLength Routing レポートを閉じるには、ウィンドウ右上の X をクリックします。

2.5.11　レポートの相違の表示

2 つのネットワークで BoM レポート、Internal Connections レポート、および Installation Parameters

レポートを比較できます。これは、基準ネットワークと Install または Upgrade ネットワーク間の相

違を確認する場合に便利です。

• BoM Diff レポートには、BoM に対して追加または削除された装置が表示されます。

• Internal Connection Diff レポートには、変更された接続が表示されます。内部接続の 2 つのエン

ド ポイントのうち、少なくとも 1 つが異なっている場合、Cisco MetroPlanner は内部接続が変

更されたことをレポートします。レポートには、基準ネットワークに存在していて、最終ネッ

トワークにはないすべての内部接続、および基準ネットワークには存在しないが最終ネット

ワークには存在しているすべての内部接続が示されます。

• Installation Parameters Diff レポートには、基準ネットワークと最終ネットワーク間で変更された

パラメータが表示されます。

ネットワークを比較する手順は、次のとおりです。

ステップ 1 Reports Diff アイコンをクリックします。Cisco MetroPlanner アイコンの詳細については、付録 A

「GUI 情報およびショートカット」を参照してください。Report Diff ダイアログボックスが表示さ

れます。図 2-35 に、プロジェクトに分析対象のネットワークが 2 つ以上ある場合の Reports Diff ダ

イアログボックスの例を示します。
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2.5　ネットワーク レポートの表示
図 2-35 Reports Diff ダイアログボックス

ステップ 2 Compare networks エリアで、左側のドロップダウン リストから基準ネットワークを選択します。右

側のドロップダウン リストから、比較するネットワークを選択します。

ステップ 3 表示するレポートをクリックします。分析対象外のネットワークを選択した場合、表示できるのは

Bill of Material の相違を示したレポートだけです。

• Bill of Material ― （図 2-36）カラムの説明については、表 2-21 を参照してください。

• Installation Parameters ― （図 2-37）カラムの説明については、表 2-22 を参照してください。

• Internal Connections ― （図 2-38）カラムの説明については、表 2-23 を参照してください。

ステップ 4 [Ok] をクリックします。

図 2-36 に、BoM Diff レポートを示します。

図 2-36 BoM Diff レポート
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BoM Diff Report タブの上部セクションに、ネットワークごとに次の情報が表示されます。

• BoM total discounted ― BoM に含まれるアイテムごとに、（スペア部品を除く）ネットワーク全

体の価格が表示されます。Use global discount を選択した場合は、Global discount percentage
フィールドの割り引きが合計に含まれます。

• Spare total discounted ― ネットワーク全体について、すべてのメンテナンス センタのすべての

推奨スペア部品に相当する価格が表示されます。これは、割り引き価格を使用した、各スペア

アイテムの合計です。合計が表示されるのは、Spare Part Report チェックボックスを選択してか

らです。

• BoM + Spare total discounted ― BoM の合計割り引き価格とスペアの合計割り引き価格を合算し

た値が表示されます。

• Price List ― プロジェクト用に選択した価格表データベースの名前が表示されます。

• Currency ― 選択した価格表データベースで指定されている、各価格の通貨が表示されます。

表 2-21 で、BoM Diff レポートにおける各カラムの情報について説明します。カラムをクリックす

ると、そのカラムに基づいて表の情報が並べ替えられます。

表 2-21 BoM Diff レポートのカラム

カラム ラベル 内容

Name サイトおよび装置の名前が表示されます。

(Diff Summary) 2 つのネットワークの BoM 間に相違があることを示します。

=（等号） ― 2 つのネットワーク間に相違がないことを意味します。

 （打ち消された等号） ― そのアイテムは両方のネットワークに存在

しているが、ネットワークごとに数が異なることを意味します。

1 ― このアイテムが最初のネットワークにあって、2 番めのネットワー

クにはないことを意味します。

2 ― このアイテムが 2 番めのネットワークにあって、最初のネットワー

クにはないことを意味します。

PID 製品の ID 文字列が表示されます。PID を表示するには、装置名の横のプ

ラス（+）記号をクリックして展開します。

Quantity BoM における特定の製品の数量が表示されます。ネットワーク間で数量

が異なる場合、Cisco MetroPlanner は次の形式で、両方の値をレッドで表

示します。

最初のネットワークの数量 /2 番めのネットワークの数量

Unit Price 各装置の価格が表示されます。装置価格を表示するには、装置名の横の

プラス（+）記号をクリックして展開します。

Total Price 割り引き適用前の、製品の合計価格が表示されます。ネットワーク間で

数量が異なる場合、Cisco MetroPlanner は次の形式で、両方の値をレッド

で表示します。

最初のネットワークの合計価格 /2 番めのネットワークの合計価格

Discounted Total Price 割り引き適用後の、製品の合計価格が表示されます。ネットワーク間で

数量が異なる場合、Cisco MetroPlanner は次の形式で、両方の値をレッド

で表示します。

最初のネットワークの割り引き後の合計価格 /2 番めのネットワークの割

り引き後の合計価格
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2.5　ネットワーク レポートの表示
図 2-37 に、Installation Parameters Diff レポートを示します。

図 2-37 Installation Parameters Diff レポート

表 2-22 で、Installation Parameters Diff レポートのカラムについて説明します。カラムをクリックす

ると、そのカラムに基づいて表の情報が並べ替えられます。

ネットワーク間の相違は次の形式を使用して、レッドで表示されます。

基準ネットワークの値 / 最終ネットワークの値

表 2-22 Installation Parameters Diff レポートのカラム

カテゴリ 内容

Name サイト名が表示されます。

(Diff Summary) 2 つのネットワークの BoM 間に相違があることを示します。

=（等号） ― 2 つのネットワーク間に相違がないことを意味します。

 （打ち消された等号） ― そのアイテムは両方のネットワークに存在

しているが、ネットワークごとに数が異なることを意味します。

1 ― このアイテムが最初のネットワークにあって、2 番めのネットワー

クにはないことを意味します。

2 ― このアイテムが 2 番めのネットワークにあって、最初のネットワー

クにはないことを意味します。

Side ノード インターフェイスが表示されます。T（終端）、E（東）、または W

（西）です。

Position パッチコードの起点となるカードのラック、シェルフ、およびスロット

位置が表示されます。

Unit カード名が表示されます。

Port # パッチコードの起点となるポート番号が表示されます。

Port ID ポート ID が表示されます。
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2.5　ネットワーク レポートの表示
図 2-26 に、Internal Connections Diff レポートを示します。

図 2-38 Internal Connection Diff レポート

表 2-23 に、Internal Connections Diff レポートのカラムおよび内容を示します。カラムをクリックす

ると、そのカラムに基づいて表の情報が並べ替えられます。

ネットワーク間の相違は次の形式を使用して、レッドで表示されます。

基準ネットワークの値 / 最終ネットワークの値

Port Label ポート名が表示されます。

Parameter RX Power Low など、設定されているパラメータ名が表示されます。

Value 設定されている値の名前が表示されます。

Measurement Unit dBm など、関連するインストール パラメータ値の計測単位が表示されま

す。

Manual Set CTC インターフェイスを使用して手動でパラメータを設定する必要性

の有無が示されます。

表 2-22 Installation Parameters Diff レポートのカラム（続き）

カテゴリ 内容
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2.5　ネットワーク レポートの表示
表 2-23 Internal Connections タブのカラム

カラム名 内容

Name サイト名が表示されます。SW provisioning view サブタブでは、このカラ

ムは CTC インターフェイスを使用して接続を手動で設定または削除す

るかどうかを示します。

(Diff Summary) 2 つのネットワークの BoM 間に相違があることを示します。

=（等号） ― 2 つのネットワーク間に相違がないことを意味します。

 （打ち消された等号） ― そのアイテムは両方のネットワークに存在

しているが、ネットワークごとに数が異なることを意味します。

1 ― このアイテムが最初のネットワークにあって、2 番めのネットワー

クにはないことを意味します。

2 ― このアイテムが 2 番めのネットワークにあって、最初のネットワー

クにはないことを意味します。

Position パッチコードの起点となるカードのラック、シェルフ、およびスロット

位置が表示されます。

Unit カード名が表示されます。

Port label ポート名が表示されます。

Attenuator 指定されている場合は、この接続に装備されるバルク減衰器の製品 ID で

す。プリアンプの DC-TX および DC-RX ポート間に内部減衰器を設置し

なければならない場合（DCU を装備しない場合）にも報告されます。

Position パッチコードの終点となるカードのラック、シェルフ、およびスロット

位置が表示されます。

Unit カード名が表示されます。

Port Label ポート名が表示されます。

P/F 接続が現在（P/F）の回線に関連するのか、将来（F）の回線に関連する

のかが示されます。
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2.6　プロジェクトの編集
2.6　プロジェクトの編集
Cisco MetroPlanner を使用すると、ネットワーク分析の前後どちらでも、プロジェクトを編集できま

す。ネットワーク分析中に発生したエラー メッセージは、1 つ以上のネットワーク コンポーネント

を編集しないかぎり、解消されないことがよくあります。

ここで説明する各手順を実行するには、プロジェクトを開き、ネットワークをロードしておく必要

があります。「2.1.1　プロジェクトの開き方」（p.2-3）および「2.1.2　ネットワークのロードおよび

アンロード」（p.2-4）を参照してください。

2.6.1　プロジェクト パラメータの編集

プロジェクト パラメータを編集する手順は、次のとおりです。

ステップ 1 Project Explorer で [Project] をクリックします。

ステップ 2 Properties ペインに、必要な情報を入力します。

• Costomer ― このネットワーク設計を要求しているカスタマーの名前を入力します（最大 128 文
字）。

• Created by ― ユーザ名（最大 128 文字）を入力します。

• Units ― スパンの計測単位が表示されます。Km（キロメートル）または Miles です。

• Price List ― ドロップダウン リストから価格データベースを選択します。

• Layout ― プラットフォーム タイプを表す ANSI（北米の規格）または ETSI（国際規格）が表

示されます。ANSI ネットワークの場合は、SDH（ETSI）サービス デマンドを定義できません。

ETSI ネットワークの場合は、SONET（ANSI）サービス デマンドを定義できません。

2.6.2　ネットワーク パラメータの編集

ネットワーク パラメータを編集する手順は、次のとおりです。

ステップ 1 Project Explorer または Networks Mgmt Tree でネットワークをクリックします。

ステップ 2 Properties ペインに、必要な情報を入力します。

• Name ― ネットワーク名を入力します（最大 128 文字）。

• Position ― オブジェクトの位置をピクセルで入力します。

• Created by ― ユーザ名（最大 128 文字）を入力します。

• Status ― ネットワークの状態（Design、Design-Analyzed、Install など）が表示されます。

• Use MSM Buldles ― BoM の作成時に、個々のアイテムではなく、Multishelf Management Integrated
Kit バンドルを使用する場合に選択します。

• Use Spare Parts ― ネットワークに必要なスペア部品を判別する場合に選択します。ネットワー

クが Upgrade ステートの場合、実装するサービスおよび新しく追加された現在のサービスをサ

ポートするために必要な部品が含まれます。スペア部品のレポートを作成するには、ネット

ワーク分析の前に、ネットワーク内のサイトとメンテナンス センタを対応付ける必要がありま

す。

• Use Global Discount ― ネットワーク全体にグローバル ディスカウントを適用する場合に選択し

ます。グローバル ディスカウントは、BoM のすべてのコンポーネントに適用されます。
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• Global Discount ― 新しいグローバル ディスカウントをパーセントで入力します。

• Service Level ― ドロップダウン リストからサービス レベル（契約）の識別子を選択します。

• Service Length ― ドロップダウン リストからメンテナンス サービス レベルの長さ（年数）を選

択します。

• Include SW Licenses ― BoM にソフトウェア ライセンスを含める場合に選択します。

• Include Paper Documentation ― BoM に印刷形式のマニュアルを含める場合に選択します。

• Include CD Documentation ― BoM に CD 形式のマニュアルを含める場合に選択します。

• Hide Bom/price discount ― BoM の Unit Price カラムにグローバル ディスカウントを表示しない

場合に選択します。

• Dimension ― ネットワーク サイズをピクセル単位で入力します。

• Background color ― ネットワークの背景色を選択する場合にクリックします。

• Background image ― 該当する場合、背景として使用する JPEG または GIF ファイルの名前が表

示されます。ネットワークの背景グラフィックとして JPEG または GIF ファイルを選択する場

合は、下向きの矢印をクリックし、適切なディレクトリに移動します。

2.6.3　サイト パラメータの編集

サイト パラメータを編集すると、現在のサイト構成を変更できます。Project Explorer のサイト フォ

ルダに、インターフェイス ノード情報が表示されます。図 2-39 に、ネットワーク分析前の Project

Explorer におけるサイトを示します。図 2-40 に、ネットワーク分析後の Project Explorer におけるサ

イトを示します。

図 2-39 Project Explorer におけるサイト
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図 2-40 Project Explorer における分析後のサイト

分析後のネットワーク設計を表すサイト フォルダには、次のアイテムも含まれ、その多くが編集可

能です。

• E、W、T ― Line または Line+ サイトの場合、Project Explorer の Site フォルダの下に、W（West）
および E（East）というラベルのインターフェイス ノードが 2 つ表示されます。Terminal また

は Terminal+ サイトの場合、表示されるのは 1 つのインターフェイス ノード（T）だけです。

• C-Band または L-Band ― サイド（E、W、または T インターフェイス）でサポートされるバン

ドが表示されます。

• Amplifiers ― 各バンドおよび各サイド（E、W、または T インターフェイス）の増幅器および

すべての関連カードが表示されます。

• Add/Drop ― バンドおよびサイド（E、W、または T インターフェイス）の分岐挿入（add/drop）
および関連カードがすべて表示されます。

• Site Type Parameters ― 選択すると、Properties ペインにサイトの機能およびタイプが表示されま

す。

• Band Parameters ― 選択すると、Properties ペインに出力が表示されます。

• Clietn ― クライアント カードが表示されます。

サイト パラメータを編集する手順は、次のとおりです。サイトを削除するには、「2.6.4　サイトの

削除」（p.2-76）を参照してください。
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ステップ 1 Project Explorer で、ネットワーク フォルダを右クリックし、ショートカット メニューから Expand

を選択します。

ステップ 2 適切なサイト フォルダをクリックします。Properties ペインにサイト パラメータが表示されます。

ステップ 3 必要に応じて次の情報を入力し、Properties ペインのサイト パラメータを変更します。

• Name ― 適切なサイト名を入力します。

• Position ― 該当するサイトのピクセル位置を入力します。たとえば、NtView < 名前 > タブの左

上に Site アイコンを配置する場合は、0,0 を入力します。

• Structure ― ドロップダウン リストから構造タイプを選択します。

－ Line ― ノードで終端する 2 組の光ファイバ ペア

－ Terminal ― ノードで終端する 1 組の光ファイバ ペア

－ Line+ ― 2 組の光ファイバ ペアがノードで終端しますが、MMU カード（トポロジー アッ

プグレード）を搭載すると、光ファイバの数を増やせます。このノードに MMU を搭載す

ると、いつでもこのノードをマルチディグリー ノードに拡張できます。

－ Terminal+ ― 1 組の光ファイバ ペアがノードで終端しますが、MMU カード（トポロジー

アップグレード）を搭載すると、光ファイバの数を増やせます。このノードに MMU を搭

載すると、いつでもこのノードをマルチディグリー ノードに拡張できます。

次の構造変更が可能です。

－ Line から Line+

－ Line+ から Line

－ Terminal から Terminal+

－ Terminal+ から Terminal

その他の構造変更（Line から Terminal への変更など）を行う場合は、サイトを削除し、改めて
追加する必要があります。

• MTTR（hours） ― ネットワークのすべてのサイトについて、Mean Time To Repair（MTTR; 平均

修理時間）を入力します。これはネットワークのあらゆるサイトに適用されます。サイトの作

成後、MTTR 値を変更した場合、新しい値が適用されるのは、変更後に作成したサイトだけに

なります。

• Maintenance Center ― ドロップダウン リストからメンテナンス センタ名を選択します。メンテ

ナンス センタを作成する場合は、「2.6.5　メンテナンス センタの作成」（p.2-77）を参照してく

ださい。

• IP Address ― ノードの IP アドレスを入力します。

• Shelf Config ― ドロップダウン リストからシェルフ構成のタイプを選択します。

－ Multi Shelf Integrated Switch ― Multi Service Transport Platform（MSTP）光カード（OADM お
よび増幅器）はすべて、LAN によって接続された、それぞれ異なるシェルフに配置されま

す。LAN は MSTP シェルフに接続されたスイッチで実装されます。このオプションを選択

すると、Multi-Shelf Integrated Switch Card（MS-ISC）を使用してマルチシェルフ構成がサ

ポートされます。

－ Multi Shelf External Switch ― すべての MSTP 光カード（OADM および増幅器）は、LAN で
接続されたそれぞれ異なるシェルフに配置されます。LAN は MSTP シェルフの外部にある

スイッチで実装されます。このオプションを選択した場合は、2 つの外部イーサネット ス
イッチを使用して、マルチシェルフ構成をサポートします。

－ Individual Shelf ― すべての MSTP 光カード（OADM および増幅器）が同じシェルフに配置

されます。このオプションを選択した場合、マルチシェルフ管理はサポートされません。

シェルフごとに独立したシェルフとして管理します。

• Node Protection ― ドロップダウン リストからノード保護のタイプを選択します。Same Shelf ま
たは Separated Shleves です。
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• DCC Shelves Management ― 選択した場合は、各サイトの各シェルフ上で、スロット 12 に
TXP(P)_MR_2.5 G カードを搭載することを意味します。

• TXP/MXP OSMINE placement ― 選択した場合は、OSMINE 配置ルールに従って、トランスポン

ダ / マックスポンダ カードをシェルフに配置することを意味します。

• Hbrid MSTP/MSPP Node ― 選択した場合は、すべてのノードがハイブリッド MSTP/MSPP ノー

ドとして構成されることを意味します。

• Max Number of Shelves/Bay ― サイトのレイアウト作成時に、サイトの各ラックに配置できる

（光カードまたはトランスポンダ / マックスポンダ カードを装備した）ANSI または ETSI シェ

ルフの最大数（1 ～ 4）を選択します。

• Functionality ― ドロップダウン リストからサイトの機能を選択します。表 2-24 に、サイト設計

ルールの概要を示します。サイトのアイコンは、機能に応じて変わります。サイト アイコンに

ついては、付録 A「GUI 情報およびショートカット」を参照してください。

－ Auto ― ネットワークの作成に関して、最大限の柔軟性が得られます。Cisco MetroPlanner
は、他の制約に与えるコストを可能な限り最小限にして、サイトを設計します。

－ Pass Through ― このサイトには装置を配置しないことを意味します。

－ Line amplifier ― このサイトでは、あらゆる分岐挿入（add/drop）トラフィックが禁止され

ます。

－ OSC site ― MSTP ネットワーク管理のために Optical Service Channel（OSC; オプティカル

サービス チャネル）にアクセスする可能性を前提に、ネットワーク通信対応としてサイト

を設計することを意味します。デフォルトでは、このサイトに増幅器は組み込まれません。

しかし、Cisco MetroPlanner がネットワークに増幅器が必要であると判断した場合は、この

位置に自動的に配置できます。Cisco MetroPlanner では、OSC Site ノードの各方向に、プリ

アンプおよびブースタ増幅器を設定（強制）できます。

－ Add/Drop ― このサイトに分岐挿入（add/drop）能力があることを意味します。このサイト

で分岐挿入（add/drop）が可能なのは、ポイントツーポイント回線および P リング回線だ

けです。

－ Hub ― （西側と東側の両方で）すべてのチャネルを分岐挿入（add/drop）できるように、こ

のサイトにフィルタを装備することを意味します。ハブ構成では、すべての高速パスがオー

プンになります。

－ Gain equalizer ― このサイトでは WSS カードを使用して、発生する傾きを制御し、非再生

距離を延長することを意味します。このサイトは、デマルチプレクサ カードを使用しない

ROADM サイトとして実現されます。

－ R-OADM ― このサイトが Any-to-Any とともに Fixed（ポイントツーポイントおよび P リン

グ）トラフィック タイプもサポートすることを意味します。

• Type ― ドロップダウン リストからサイト タイプを選択します（表 2-24 を参照）。

－ Auto ― ネットワークの作成に関して、最大限の柔軟性が得られます。Cisco MetroPlanner
は、他の制約セットに与えるコストを可能な限り最小限にして、サイトを設計します。

－ Glass Through ― プライオリティの低い増幅サイトを意味します。

－ Line ― プライオリティの高い増幅サイトを意味します。

－ OADM ― 個別チャネル フィルタ（1、2、4 チャネル、1、4 バンド）を使用する分岐挿入

（add/drop）チャネルを装備したサイトを意味します。

－ 32-WSS ― 32DMX または 32DMX-O を装備したサイトを意味します。このオプションを使

用すると、特定の ROADM 装置を強制的に使用できます。

（注） 32-WSS を選択できるのは、System Release 7.0.x に限られます。

－ Mux/Demux ― 32MUX-O および 32DMX-O カードを使用し、両側のすべてのチャネルを分

岐挿入（add/drop）する、Full Multiplexer/Demultiplexer（FMD）サイトを意味します。オプ

ティカル バイパスを使用できます。
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• Anti ASE ― サイトのすべての高速チャネルが光学的に分岐されて再挿入されるようにサイト

を設定する場合は、Yes を選択します。さらに、West セクションと East セクション間のすべて

のパッチコードが取り外されます。Anti-Amplified Spontaneous Emissions（Anti-ASE）としてサ

イトを設定するかどうかを Cisco MetroPlanner に決定させる場合は、Auto を選択します。サイ

ト設計ルールの概要については、表 2-24 を参照してください。

ステップ 4 バンド パラメータを変更するには、適切なサイト インターフェイスに対応する Project Explorer で、

C-Band または L-Band をクリックします。Properties ペインに、適切な出力を入力します。

ステップ 5 増幅器のパラメータを変更するには、適切なサイト インターフェイスに対応する Project Explorer

で、C-Band Amplifiers  または L-Band Amplifiers  をクリックします。Auto 以外の値を選択すると、

装置にその設定値が強制的に適用されます。詳細については、「1.6　Auto、Forced、および Locked

パラメータ」（p.1-12）を参照してください。

a. Properties ペインの From Fibre エリアに、必要な情報を入力します。

• PRE ― ドロップダウン リストから適切なプリアンプ（None、Auto、OPT-PRE [C-band]、
または OPT-AMP-L [L-band]）を選択します。

表 2-24 サイト設計ルール

構造 機能 タイプ カード オプション

C バンド 
32/16 
チャネル 
100 GHz

C バンド
8 チャネル
100 GHz

C バンド
64 チャネル 
50 GHz

L バンド 
32 チャネル
100 GHz

Line Pass Through — — Yes Yes Yes Yes

Line amplifier Line amplifier — Yes Yes Yes Yes

Glass Through — Yes Yes Yes Yes

OSC Site — — Yes Yes Yes Yes

Add/Drop OADM

（Anti-ASE）

OADM カード Yes Yes No No

Mux/Demux — Yes Yes No No

Hub Mux/Demux — Yes Yes No No

WSS 32DMX-O Yes Yes Yes No

32DMX Yes Yes Yes Yes

Gain equalizer WSS 32DMX Yes No Yes Yes

ROADM WSS 32DMX-O Yes No Yes No

32DMX Yes No Yes Yes

Line+ ROADM WSS 32DMX-O Yes No No No

32DMX Yes No No Yes

Hub WSS 32DMX-O Yes No No No

32DMX Yes No No Yes

Terminal Add/Drop OADM

（Anti-ASE）

OADM カード Yes Yes No No

Mux/Demux — Yes Yes No No

ROADM WSS 32DMX-O Yes Yes Yes No

32DMX Yes Yes Yes Yes

Terminal+ ROADM WSS 32DMX-O Yes No No No

32DMX Yes No No Yes
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• DCU 1/2 ― ドロップダウン リストから適切な DCU を選択します。

• Attenuator ― ドロップダウン リストから適切な減衰器を選択します。

• Output power ― 適切な出力を入力します。

• Tilt ― 適切な傾き値を入力します。

• Attenuator ― ドロップダウン リストから減衰器を選択します。

b. Properties ペインの To Fibre エリアに、必要な情報を入力します。

• BST ― ドロップダウン リストから適切なブースタ（None、Auto、OPT-BST [C-band]、
OPT-BST-E [C-band]、OPT-AMP-L [L-band]、または OPT-BST-L [L-band]）を選択します。

• DCU 1/2 ― ドロップダウン リストから適切な DCU を選択します。

• Output power ― 適切な出力を入力します。

• Tilt ― 適切な傾き値を入力します。

c. Properties ペインの General エリアで、ドロップダウン リストから OSC を選択します（OSC-CSM
または OSCM）。

ステップ 6 OADM パラメータを変更する場合は、該当するサイト インターフェイスに対応する Project Explorer

で Add/Drop をクリックします。Properties ペインに、必要な情報を入力します。

• Line/OADM エリアで、ドロップダウン リストから適切な減衰器を選択します。

• Mux/Demux WSS エリアに、必要な情報を入力します。

－ Patch Panel ― ドロップダウン リストからパッチ パネルを選択します。

－ Demux ― ドロップダウン リストからデマルチプレクサ（Auto、32DMX-O、または 32-DMX）

を選択します。

2.6.4　サイトの削除

ネットワークからサイトを削除する手順は、次のとおりです。サイトを削除できるのは、サイトが

Unlocked ステートにあり、トラフィック デマンドが設定されていない場合です。サイトを削除で

きるのは、Design ステートのネットワークからだけです。

ステップ 1 Project Explorer ペインで、サイトが Unlocked ステートになっていることを確認します。詳細につい

ては、「2.7.4　ネットワーク設計のパラメータ ロック解除」（p.2-93）を参照してください。

ステップ 2 トラフィック デマンドがある場合には、削除します。詳細については、「2.6.9　トラフィック デマ

ンドの削除」（p.2-81）を参照してください。

ステップ 3 NtView < 名前 > タブで、Site アイコンをクリックし、Tasks Pane から Delete を選択します。Cisco

MetroPlanner アイコンの詳細については、付録 A「GUI 情報およびショートカット」を参照してく

ださい。または、Tasks Pane で Delete をクリックします。確認メッセージが表示され、サイトの削

除について確認が求められます。

ステップ 4 [Yes] をクリックして、サイトを削除します。
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2.6.5　メンテナンス センタの作成

障害発生時にネットワークにスペア部品を供給するメンテナンス センタを追加する手順は、次のと

おりです。この機能を使用すると、メンテナンス センタの数およびアベイラビリティに基づいて、

購入するスペアの数量を決定できます。メンテナンス センタは、Project Explorer のサイトの下、

Maintenance Center フォルダに表示されます。

ステップ 1 Project Explorer で、ネットワーク フォルダを右クリックし、ショートカット メニューから Expand

を選択します。

ステップ 2 Project Explorer を下にスクロールして、Maintenance Center フォルダを右クリックし、ショートカッ

ト メニューから New Maintenance Center を選択します。

ステップ 3 Project Explorer で新しいメンテナンス センタを反転表示します。

ステップ 4 Properties ペインに、必要な情報を入力します。

• Confidence Level ― メンテナンス センタで必要なスペア部品を探すときの必須条件となる信頼

度（パーセント）を選択します。50、75、95、または 99 パーセントです。

• Restocking time (days) ― メンテナンス センタに部品を補充するための所要時間（輸送時間を含

む）を入力します。

ステップ 5 メンテナンス センタとサイトの対応付けについては、「2.6.3　サイト パラメータの編集」（p.2-71）

を参照してください。

2.6.6　ポイントツーポイント デマンドの編集

ポイントツーポイント デマンドを編集する手順は、次のとおりです。

ステップ 1 Project Explorer で、ネットワーク フォルダを右クリックし、ショートカット メニューから Expand

を選択します。

ステップ 2 Project Explorer で、ポイントツーポイント デマンドを右クリックし、ショートカット メニューから

Edit を選択します。Edit Point to Point Demand ダイアログボックスが表示されます（図 2-41）。

図 2-41 Edit Point to Point Demand ダイアログボックス
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ステップ 3 各チャネルの情報を変更する場合は、必要な情報を入力します。

• Forecast ― 現在のチャネルを将来のチャネルに変更する場合に選択します。

• Srv.Type ― ドロップダウン リストから適切なサービス タイプを選択します。あるチャネルの

サービス タイプを変更すると、すべてのチャネルのサービス タイプが自動的に変更されます。

• Protection ― ドロップダウン リストから適切な保護タイプを選択します。あるチャネルの保護

タイプを変更すると、すべてのチャネルの保護タイプが自動的に変更されます。

• Path ― ドロップダウン リストから W（西から東）または E（東から西）を選択します。

• Wavelength ― ドロップダウン リストから適切な波長タイプを選択します。Auto を選択した場

合は、他の制約に与えるコストが最小になるように、Cisco MetroPlanner がチャネルに波長を割

り当てます。

• Optical Bypass ― ドロップダウン メニューからオプティカル バイパス対応サイトを選択しま

す。

• WDM Intf.Type ― ドロップダウン リストから適切なカード インターフェイス タイプを選択し

ます。

• WDM Card Type ― ドロップダウン リストから適切なカード タイプを選択します。使用できる

オプションは、選択したカード インターフェイス タイプによって決まります。あるチャネル

のカード タイプを変更すると、すべてのチャネルのカード タイプが自動的に変更されます。

• Src.Client Intf. ― ドロップダウン リストから適切な起点クライアント インターフェイスを選択

します。使用できるオプションは、選択したカード タイプによって決まります。

• Dst.Client Intf. ― ドロップダウン リストから適切な終点クライアント インターフェイスを選択

します。使用できるオプションは、選択したカード タイプによって決まります。

ステップ 4 新しいチャネルを追加する場合は、Edit Point to Point Demand ダイアログボックスの右側で、Create

a new circuit アイコンをクリックします。新しいローが表示されます。必要なだけステップ 3 を繰

り返し、新しいチャネルのパラメータを入力します。

ステップ 5 既存チャネルを削除する場合は、ローを選択し、Edit Point to Point Demand ダイアログボックスの右

側で、Remove the selected circuit アイコンをクリックします。

ステップ 6 [Ok] をクリックし、チャネルの変更を保存して、Edit Point to Point Demand ダイアログボックスを

閉じるか、または [Cancel] をクリックし、変更を保存しないでダイアログボックスを閉じます。

2.6.7　P リング デマンドの編集

P リング サービス デマンドのサービス配信を変更する手順は、次のとおりです。

ステップ 1 Project Explorer で、ネットワーク フォルダを右クリックし、ショートカット メニューから Expand

を選択します。

ステップ 2 Project Explorer で、P リング デマンドを右クリックし、ショートカット メニューから Edit を選択

します。Edit P-Ring Demand ダイアログボックスが表示されます（図 2-42）。
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図 2-42 Edit P-Ring Demand ダイアログボックス

ステップ 3 Edit P-Ring Demand ダイアログボックスで必要な情報を入力し、P リングを変更します。

• Service Type ― ドロップダウン リストから適切なサービス タイプを選択します。

• WDM Card Type ― ドロップダウン リストから適切なカード タイプを選択します。使用できる

オプションは、選択したサービス タイプによって決まります。

• WDM Interface ― ドロップダウン リストから適切なカード インターフェイス タイプを選択し

ます。使用できるオプションは、選択したカード タイプによって決まります。

Edit P-Ring Demand ダイアログボックスの Circuits エリアに、必要な情報を入力します。

• Ring ― （表示のみ）P リング名が表示されます。

• Forecast ― 現在のチャネルを将来のチャネルに変更する場合に選択します。

• Wavelength ― ドロップダウン リストから適切な波長タイプを選択します。Auto を選択した場

合は、他の制約に与えるコストが最小になるように、Cisco MetroPlanner がチャネルに波長を割

り当てます。

Edit P-Ring Demand ダイアログボックスの Sections エリアに、必要な情報を入力します。

• Src ― （表示のみ）セクションの起点サイト名が表示されます。

• Dst ― （表示のみ）セクションの終点サイト名が表示されます。

• Opt.Bypass ― ドロップダウン リストから、現在のデマンドに関連するチャネルを光学的に廃棄

するサイトを選択します。オプションとして使用できるのは、このセクションのパス上にあり、

起点サイトから終点サイトまでの間にあるサイトだけです。

• Src.Client Intf. ― ドロップダウン リストから適切な起点クライアント インターフェイスを選択

します。使用できるオプションは、選択したカード タイプによって決まります。

• Dst.Client Intf. ― ドロップダウン リストから適切な終点クライアント インターフェイスを選択

します。使用できるオプションは、選択したカード タイプによって決まります。

ステップ 4 新しい P リングを追加する場合は、Edit Point to Point Demand ダイアログボックスの左側で、Create

a new P-Ring circuit アイコンをクリックします。新しいローが表示されます。必要なだけステップ

3 を繰り返し、新しい P リングのパラメータを入力します。

ステップ 5 P リングから既存チャネルを削除する場合は、ローを選択し、Edit P-Ring Demand ダイアログボッ

クスの左側で、Remove the selected P-Ring cirucuit アイコンをクリックします。
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ステップ 6 [Ok] をクリックし、チャネルの変更を保存して、Edit P-Ring Demand ダイアログボックスを閉じる

か、または [Cancel] をクリックし、変更を保存しないでダイアログボックスを閉じます。

2.6.8　ROADM デマンドの編集

ROADM サービス デマンドのサービス配信を変更する手順は、次のとおりです。

ステップ 1 Project Explorer で、ネットワーク フォルダを右クリックし、ショートカット メニューから Expand

を選択します。

ステップ 2 ROADM トラフィック グループを右クリックし、ショートカット メニューから Edit を選択します。

Edit ROADM Demand ダイアログボックスが表示されます（図 2-43）。

図 2-43 Edit ROADM Demand ダイアログボックス

ステップ 3 ドロップダウン リストからトラフィック パターン タイプ（Hub または Meshed）を選択します。

Hub を選択した場合は、First Site ドロップダウン ボタンが使用可能になります。Meshed を選択し

た場合は、ステップ 5 に進みます。

ステップ 4 トラフィック タイプが Hub の場合、First Site ドロップダウン リストから起点サイトを選択します。

ステップ 5 Connectivity type ドロップダウン リストから接続タイプを選択します。選択肢は Protected、

Unprotected Minimum Hop、Unprotected Optimum Path、および Unprotected Subnet です。接続タ

イプの選択肢の詳細については、「1.5.3　ROADM トラフィック デマンド」（p.1-11）を参照してく

ださい。

ステップ 6 Service Types ペインで、ROADM デマンドに対応するクライアント サービス タイプのボックスを 1

つ以上選択します。右側のペインに、各サービス タイプをサポートするクライアント インターフェ

イスが表示されます。
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ステップ 7 クライアント インターフェイスの詳細を定義するために、右側のペインのローごとに、次のオプ

ションを入力します。グレー表示のチェックボックスは、クライアント インターフェイスの選択に

は使用できません。

• Yes/No ― このカードでサービス タイプを実装する場合に選択します。

• Client Interface ― 選択したサービス タイプに対応するカード タイプが表示されます。

• Y-Cable ― 接続タイプが Protected であり、Y 字型ケーブルで保護する場合に選択します。

• 1+1 Protected ― 接続タイプが Protected であり、1+1 方式で保護する場合に選択します。

• Fiber Switched ― 接続タイプが Protected であり、光ファイバ スイッチングによって保護する場

合に選択します。

• Supported Service ― カードでサポートされるサービス タイプが表示されます。

同じサービス タイプをサポートするクライアント インターフェイスを複数選択できます。デフォ

ルトでは、Cisco MetroPlanner によって、各サービスのサポートに最適なクライアント インターフェ

イスが選択されます。

ステップ 8 [Ok] をクリックして、デマンドの変更を保存します。

2.6.9　トラフィック デマンドの削除

トラフィック デマンドを削除するには、トラフィック デマンドが Unlocked ステートになっていな

ければなりません。トラフィック デマンドを削除する手順は、次のとおりです。

ステップ 1 Project Explorer で、ネットワーク フォルダを右クリックし、ショートカット メニューから Expand

を選択します。

ステップ 2 デマンドが Unlocked ステートになっていることを確認します。詳細については、「2.7.4　ネット

ワーク設計のパラメータ ロック解除」（p.2-93）を参照してください。

ステップ 3 Project Explorer で削除するデマンドを右クリックし、ショートカット メニューから Delete を選択し

ます。または、Tasks Pane で [Delete] をクリックします。
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2.6.10　光ファイバ スパン、ペア、および光ファイバ パラメータの編集

Properties ペインを使用すると、光ファイバ スパン、光ファイバ ペア、および個々の光ファイバを

管理できます。光ファイバ ペアは、2 本の異なる光ファイバ（右回りおよび左回り）で構成されて

います。表 2-25 に、光ファイバ スパン、ペア、または光ファイバに関して、変更できるプロパティ

を示します。

光ファイバ スパン、ペア、および光ファイバのパラメータを編集する手順は、次のとおりです。

ステップ 1 Project Explorer で、Fibers フォルダを右クリックし、ショートカット メニューから Expand を選択

します。

ステップ 2 Project Explorer ツリーで、次のいずれか 1 つをクリックします。Properties ペインで編集に使用でき

るオプションは、選択によって異なります。

• 光ファイバ スパンを編集する場合は、ダクト ID をクリックします。

• 光ファイバ ペアを編集する場合は、光ファイバ ペア ID をクリックします。

• 個々の光ファイバを編集する場合は、光ファイバ ID をクリックします。

ステップ 3 Properties ペインで、必要に応じて次のパラメータを編集します。光ファイバ スパン、光ファイバ

ペア、または個々の光ファイバに関して変更できるプロパティについては、表 2-25 を参照してくだ

さい。

• Name ― 光ファイバ スパン、ペア、または光ファイバに対応する、適切な名前を入力します。

• Ageing loss ― EOL エージング損失値を入力します。スパン当りの EOL 損失値は、ネットワー

クの光ファイバごとに、End Of Life（EOL; 耐用命数）に加算されます（たとえば、スプライス

の場合は EOL マージンを加算）。エージング係数を設定した場合、エージング損失を設定する

必要はありません。

• Ageing factor ― 光ファイバのエージング係数を入力します。この係数に、コネクタを含まない

SOL 総スパン損失を掛け合わせます。エージング損失を設定した場合、エージング 係数を設定

する必要はありません。

• Type ― ネットワークの各スパンについて、光ファイバ タイプを選択します。

• Length ― スパン長を入力します。表示される単位は、Span Measurements Units フィールドから

取得されます。

表 2-25 編集可能な光ファイバ プロパティ

プロパティ 光ファイバ スパン 光ファイバ ペア 光ファイバ

Name Yes Yes No

Ageing loss Yes No No

Ageing factor Yes No No

Fiber type Yes Yes No

Fiber length Yes Yes Yes

Length-based loss Yes Yes Yes

Connector loss (per site) Yes Yes Yes

Absolute loss without connectors Yes Yes No

CD factor Yes Yes No

PMD factor Yes Yes No

Loss Yes Yes Yes
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• Length Based Loss ― 光ファイバ損失を絶対値として指定する場合に選択します。光ファイバ損

失をスパン長から引き出す場合は、未選択にしておきます。

• Connector loss [Site 1] ― スパンの終わりの集中コネクタ損失を入力します。

• Connector loss [Site 2] ― スパンの終わりの集中コネクタ損失を入力します。

• Abs loss w/o conn [dB] ― コネクタ集中損失を含まない、各スパンにおける Start of Life（SOL）
リンク光ファイバ損失を入力します。コネクタを含まない総 SOL 損失は、損失係数に長さを掛

け合わせた値になります。Length Based モデルでは、この値が自動的に計算されます。

• CD ― 光ファイバ CD 係数を入力します。デフォルト値は、選択した光ファイバ タイプによっ

て異なります。入力した値は、光ファイバ タイプを変更するたびに消去されます。波長分散は

必ず、ps/nm/km 形式で入力します。光ファイバの波長分散は、波長帯域の中央で定義されま

す。C バンドは 1545.3 nm で定義され、L バンドは 1590.4 nm で定義されます。

• PMD ― PMD 係数を入力します。デフォルト値は、選択した光ファイバ タイプによって異なり

ます。入力した値は、光ファイバ タイプを変更するたびに消去されます。PMD は必ず、ps/nm/km
形式で入力します。

• Loss ― 各ネットワーク スパンの損失を計算するために使用する、キロメートル当りの SOL 光
ファイバ損失の値を入力します。光ファイバ損失係数は必ず、dB/km の形式で入力します。

ステップ 4 必要に応じて、光ファイバ スパン、光ファイバ ペア、または個々の光ファイバについて、Properties

ペインで次の合計を確認します。

• Loss BOL ― （表示のみ）算出された Beginning of Life（BOL）の合計損失が表示されます。

（注） BOL は SOL ともいいます。

• Loss EOL ― （表示のみ）計算された EOL の合計損失が表示されます。

• CD ― （表示のみ）総波長分散が表示されます。

• PMD ― （表示のみ）総 PMD が表示されます。

2.6.11　Fibres Dialog による光ファイバ スパン、ペア、および光ファイバの編集

Fibres Dialog には、ネットワーク内のすべての光ファイバ スパン、ペア、および光ファイバが表示

されます。Fibres Dialog ボックスから光ファイバ パラメータを表示して編集する手順は、次のとお

りです。

ステップ 1 Project Explorer ツリーで、該当するネットワークの Fibers フォルダを右クリックし、ショートカッ

ト メニューから Fibres Dialog を選択します。Fibres Dialog が表示されます（図 2-44）。
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図 2-44 Fibres Dialog

表 2-26 で、Fibres Dialog の各カラムについて説明します。

表 2-26 Fibres Dialog のカラム

カラム 内容

Name 光ファイバ スパン（Duct）、ペア（Couple）、または光ファイバの名前が

表示されます。Duct 名の横のプラス（+）記号をクリックすると、リス

トが展開され、Couple 名が表示されます。Couple 名の横のプラス（+）

記号をクリックすると、リストが展開され、個々の光ファイバの名前が

表示されます。

Src. 光ファイバ スパン、ペア、または光ファイバの起点サイトまたはイン

ターフェイスの名前が表示されます。

Dst. 光ファイバ スパン、ペア、または光ファイバの終点サイトまたはイン

ターフェイスの名前が表示されます。

Type ネットワークの各スパンについて、光ファイバ タイプが表示されます。

G652-SMF、E-LEAF、または True Wave です。

Length スパン長が表示されます。表示される単位は、Span Measurements Units

フィールドから取得されます。

Loss SOL 算出された Start of Life（SOL）の総損失が表示されます。

Loss EOL 算出された End of Life（EOL）の総損失が表示されます。

CD C-Band C バンドの総波長分散が表示されます。

CD L-Band L バンドの総波長分散が表示されます。

PMD 総 PMD が表示されます。

QD C-Band C バンドの二次分散が表示されます。

QD L-Band L バンドの二次分散が表示されます。

RD ランダム分散値が表示されます。
2-84
Cisco MetroPlanner DWDM オペレーション ガイド

OL-10358-01-J



第 2 章      Cisco MetroPlanner によるネットワーク設計

2.6　プロジェクトの編集
ステップ 2 光ファイバ スパン、ペア、または光ファイバを編集するには、Fibres Dialog で該当するアイテムを

クリックします。Fibres Dialog 右側の Properties ペインに、選択したアイテムのプロパティが表示さ

れます。

ステップ 3 Properties ペインで、必要に応じて次のパラメータを編集します。光ファイバ スパン、光ファイバ

ペア、または個々の光ファイバに関して変更できるプロパティについては、表 2-25 を参照してくだ

さい。

• Name ― 光ファイバ スパン、ペア、または光ファイバに対応する、適切な名前を入力します。

• Ageing loss ― EOL エージング損失値を入力します。スパン当りの EOL 損失値は、ネットワー

クの光ファイバごとに、End Of Life（EOL; 耐用命数）に加算されます（たとえば、スプライス

の場合は EOL マージンを加算）。エージング係数を設定した場合、エージング損失を設定する

必要はありません。

• Ageing factor ― 光ファイバのエージング係数を入力します。この係数に、コネクタを含まない

SOL 総スパン損失を掛け合わせます。エージング損失を設定した場合、エージング 係数を設定

する必要はありません。

• Type ― ネットワークの各スパンについて、光ファイバ タイプを選択します。G652-SMF、
E-LEAF、または True Wave です。

• Length ― スパン長を入力します。表示される単位は、Span Measurements Units フィールドから

取得されます。

• Length Based Loss ― 光ファイバ損失を絶対値として指定する場合に選択します。光ファイバ損

失をスパン長から引き出す場合は、未選択にしておきます。

• Connector loss [Site 1] ― スパンの終わりの集中コネクタ損失を入力します。

• Connector loss [Site 2] ― スパンの終わりの集中コネクタ損失を入力します。

• Abs loss w/o conn [dB] ― コネクタ集中損失を含まない、各スパンにおける Start of Life（SOL）
リンク光ファイバ損失を入力します。コネクタを含まない総 SOL 損失は、損失係数に長さを掛

け合わせた値になります。Length Based モデルでは、この値が自動的に計算されます。

• CD ― 光ファイバ CD 係数を入力します。デフォルト値は、選択した光ファイバ タイプによっ

て異なります。入力した値は、光ファイバ タイプを変更するたびに消去されます。波長分散は

必ず、ps/nm/km 形式で入力します。光ファイバの波長分散は、波長帯域の中央で定義されま

す。C バンドは 1545.3 nm で定義され、L バンドは 1590.4 nm で定義されます。

• PMD ― PMD 係数を入力します。デフォルト値は、選択した光ファイバ タイプによって異なり

ます。入力した値は、光ファイバ タイプを変更するたびに消去されます。PMD は必ず、ps/nm/km
形式で入力します。

• Loss ― 各ネットワーク スパンの損失を計算するために使用する、キロメートル当りの SOL 光
ファイバ損失の値を入力します。光ファイバ損失係数は必ず、dB/km の形式で入力します。

Cisco MetroPlanner によって、新しい値で Fibres Dialog ボックスが更新されます。

ステップ 4 必要に応じて、光ファイバ スパン、光ファイバ ペア、または個々の光ファイバについて、Properties

ペインで次の合計を確認します。

• Loss BOL ― （表示のみ）算出された Beginning of Life（BOL）の合計損失が表示されます。

（注） BOL は SOL ともいいます。

• Loss EOL ― （表示のみ）計算された EOL の合計損失が表示されます。

• CD ― （表示のみ）総波長分散が表示されます。

• PMD ― （表示のみ）総 PMD が表示されます。
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ステップ 5 [Ok] をクリックします。

2.6.12　ネットワークの光ファイバ スパン、ペア、および光ファイバのエクスポート

ネットワークのすべてのスパン、ペア、および個々の光ファイバを XLS フォーマットでエクスポー

トする手順は、次のとおりです。

ステップ 1 Project Explorer ツリーで、該当するネットワークの Fibers フォルダを右クリックし、ショートカッ

ト メニューから Fibres Dialog を選択します。Fibres Dialog が表示されます（図 2-44）。

ステップ 2 Export をクリックします。Fibres Export ダイアログボックスが表示されます。

ステップ 3 適切なディレクトリに移動し、XLS ファイルの名前を入力して、[Save] をクリックします。

2.6.13　光ファイバ スパンの削除

ネットワーク設計から光ファイバ スパンを削除する手順は、次のとおりです。

ステップ 1 Project Explorer で、ネットワーク フォルダを右クリックし、ショートカット メニューから Expand

を選択します。

ステップ 2 Project Explorer で、削除するダクトを右クリックし、ショートカット メニューから Delete を選択し

ます。または、Tasks Pane で [Delete] をクリックします。

ステップ 3 [Yes] をクリックして、光ファイバの削除を確認します。

2.6.14　サイトの配置

サイトは 4 種類の構成に合わせて配置できます。構成に合わせてサイトを配置する、または Cisco

MetroPlanner ウィンドウに表示されるように、すべてのサイトを移動させる手順は、次のとおりで

す。

ステップ 1 NtView < 名前 > タブをクリックします。

ステップ 2 Arrange Sites ドロップダウン リストをクリックし、次のいずれか 1 つを選択します。

（注） 形状はすべて近似法によります。

• Fit to visible rectangle view ― NtView < 名前 > タブのすべてのサイトが表示されるようにズーム

します。

• Arrange to an ellipse ― すべてのサイトを楕円形に並べ替えます（図 2-45）。
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図 2-45 楕円形

• Arrange to a squre ― サイトが正方形上で右回りになるように、すべてのサイトを正方形に並べ

替えます（図 2-46）。この配置方式の場合、完全な正方向にするために、4 つ以上のサイトが必

要です。

図 2-46 正方形
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• Arrange to a snake ― NtView < 名前 > タブを右から左、左から右へ、直線的に蛇行するように、

すべてのサイトを並べ替えます（図 2-47）。

図 2-47 蛇行
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• Arrange to a double ring ― デュアル リングの形にサイトを並べ替えます（図 2-48）。

図 2-48 デュアル リング形
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2.7　ネットワーク設計の管理
ネットワークを設計して分析したあとで、カスタマー サイトにその設計を導入できるように準備す

る必要があります。ネットワークの導入後、再度分析して問題があれば修正できます。

ネットワーク設計にはステート（状態）がいくつもあります。

• Design ― 新規ネットワーク設計の最初の状態。ネットワーク設計のあらゆる要素を追加、削

除、または変更できます。Design ステートではロックは存在しません。設計の分析後、Tasks
Pane で Design を選択すると、再び Design ステートに戻して変更できます。

• Design-Analyzed ― ネットワーク アナライザ実行後のネットワーク設計の状態。すべてのレ

ポートが利用可能であり、更新されます。ネットワーク設計のどの要素についても変更できま

せん。グローバル ディスカウントやスペア部品を変更するなど、BoM は変更可能です。ネッ

トワークの分析後、Tasks Pane で Design を選択すると、Design ステートに戻せます。

• Copy ― ネットワークのコピー。ネットワークのコピーはどのステートでも作成できます。コ

ピーは、さまざまな設計オプションをテストするときに便利です。コピーは、ネットワークを

分析する前でもあとでも作成できます。コピーしたネットワークは、元のネットワークで定義

された一連のプロジェクト オプションを引き継ぎます。詳細については、「2.7.1　ネットワー

クのコピー作成」（p.2-91）を参照してください。

• Install ― ネットワークは最初、理論上の光ファイバ値（損失、長さなど）を使用して設計され

ます。ネットワークを実際に導入したときに、実際の光ファイバ パラメータ値を入力して確認

できるように、ネットワークを Install ステートに変更できます。Install ネットワークを作成で

きるのは、Design-Analyzed または Upgrade-Analyzed ステートのネットワークからです。Install
ステートのネットワークは、分析したネットワークで定義されていた一連のプロジェクト オプ

ションを引き継ぎます。Install ネットワークのサイトはすべてロックされます。スパン パラ

メータと（ロックされていないサイトの）増幅器を除き、ネットワーク設計のどの要素も変更

できません。ただし、BoM は変更できます。ルーティングされた回線はすべて固定され、この

ステートの間は変更できません。詳細については、「2.7.2　Install ステートのネットワークの作

成」（p.2-91）を参照してください。

• Install-Analyzed ― ネットワーク アナライザ実行後の Install ネットワーク設計の状態。すべての

レポートが利用可能であり、更新されます。ネットワークが Install-Analyzed ステートのときは、

すべてのサイト、デマンド、および装置がロックされます。

• Upgrade ― ネットワーク設計時に、現時点で実装するチャネル数と将来（予測）実装するチャ

ネル数を定義します。ネットワークの導入後、予測した回線を実装するかどうかを決定できま

す。その場合は、Upgrade ネットワークを作成し、実装する予測またはトラフィック デマンド

サービスを選択します。Upgrade ネットワークを作成できるのは、Design-Analyzed または

Install-Analyzed ステートのネットワークからです。特定のパラメータのロックを解除して、予

測チャネルおよびトラフィック デマンドが組み込まれるように設計を変更できます。Upgrade
ステートのネットワークは、分析したネットワークで定義されていた一連のプロジェクト オプ

ションを引き継ぎます。詳細については、「2.7.3　Upgrade ネットワークの作成」（p.2-92）を参

照してください。

• Upgrade-Analyzed ― ネットワーク アナライザ実行後の Upgrade ネットワーク設計の状態。すべ

てのレポートが利用可能であり、更新されます。ネットワークが Upgrade ステートのときは、

すべてのサイト、デマンド、および装置がロックされます。

ここで説明する各手順を実行するには、プロジェクトを開き、ネットワークをロードしておく必要

があります。「2.1.1　プロジェクトの開き方」（p.2-3）および「2.1.2　ネットワークのロードおよび

アンロード」（p.2-4）を参照してください。
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2.7.1　ネットワークのコピー作成

ネットワークのコピーを作成するには、ステートに関係なく、ネットワークを右クリックして、

ショートカット メニューから Copy を選択します。Network Mgmt Tree タブに新しいコピーが表示

されます。

2.7.2　Install ステートのネットワークの作成

Install ステートのネットワークを作成する手順は、次のとおりです。

ステップ 1 ネットワークをまだ分析していない場合は、「2.4　ネットワークの分析」（p.2-41）の手順を実行し

ます。

ステップ 2 Networks Mgmt Tree タブをクリックします。

ステップ 3 ネットワークを右クリックし、ショートカット メニューから Install を選択します。Networks Mgmt

Tree に、Install ステートの新しいネットワークが表示されます。分析したネットワークからすべて

の結果が Install ネットワークにインポートされ、Locked モードにされます。

ステップ 4 必要に応じて、Install ネットワークを変更します。編集できる光ファイバ パラメータは、光ファイ

バ損失値、光ファイバ CD、光ファイバ PMD、および光ファイバ長です。「2.6.10　光ファイバ スパ

ン、ペア、および光ファイバ パラメータの編集」（p.2-82）を参照してください。サイト パラメー

タのロックを解除して変更することもできます。サイト パラメータを変更する場合には、「2.6.3　

サイト パラメータの編集」（p.2-71）を参照してください。

ステップ 5 Networks Mgmt Tree ビューで、ツールバーの Analyzed Network アイコンをクリックします。Cisco

MetroPlanner アイコンの詳細については、付録 A「GUI 情報およびショートカット」を参照してく

ださい。MetroPlanner Analyzer status ウィンドウに、進行状況が表示されます。または、Tasks Pane

で [Analyze] をクリックします。Cisco MetroPlanner の分析ステータス バーで、ネットワーク分析が

完了したことがわかります。ネットワークは Install-Analyzed ステートで表示されるようになりま

す。

（注） 現在のネットワーク レイアウトと矛盾するようなパラメータ変更を行った場合（増幅器が

到達できない出力傾き値を設定するなど）、ネットワーク分析中に Analyzer Messages ペイン

にエラー メッセージが表示され、問題を引き起こしているパラメータが示されます。警告

およびエラー メッセージを手がかりに、現在の設計に関連する問題を突き止めることがで

きます。すべてのシステム メッセージを網羅したリストについては、付録 C「システム メッ

セージ」を参照してください。

ステップ 6 ネットワークを分析して結果に問題がない場合は、ネットワークの各サイトに、新しく生成された

インストール パラメータをインポートします。詳細については、「2.5.2　NE Update ファイルの保

存」（p.2-44）を参照してください。
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2.7.3　Upgrade ネットワークの作成

Upgrade ネットワークで、次の作業を行います。

• 光ファイバ スパンのプロパティ（長さ、分散、PMD 係数、超過損失、エージングなど）を変

更します。

• トラフィックを追加または削除します。

• 将来のトラフィックを現在のトラフィックに変換します。

• ROADM トラフィックを現在のトラフィックに変換します。

• ノード タイプを変更します。

• カードまたはモジュール（増幅器、OSC モジュール、OADM カード、および DCU モジュール）

の存在または不在を強制的に適用します。

Upgrade ネットワークでは、特定のインストール パラメータを強制的に適用できます。

• Amplifier per-channel output power setpoint

• Amplifier output tilt setpoint

• OADM card aggregate output power setpoint

• Full multiplexer/demultiplexer or ROADM output power setpoint

Upgrade ステートでは、次のパラメータは変更できません。

• Node input channel fail threshold

• Node OSC channel fail threshold

• Preamplifier input power threshold

• OADM card aggregate input power setpoint

• Full muxponder/demuxponder or ROADM input power setpoint

• Channels drop power

ネットワークを Upgrade ステートにする手順は、次のとおりです。

ステップ 1 ネットワークをまだ分析していない場合は、「2.4　ネットワークの分析」（p.2-41）の手順を実行し

ます。

ステップ 2 Networks Mgmt Tree タブをクリックします。

ステップ 3 分析済みネットワークを右クリックし、ショートカット メニューから Upgrade を選択します。

Network Mgmt Tree タブに新しい Upgrade ネットワークが表示されます。分析したネットワークか

らすべての結果が Upgrade ネットワークにインポートされます。

ステップ 4 必要に応じて、Upgrade ネットワークを変更します。詳細については、「2.6.10　光ファイバ スパン、

ペア、および光ファイバ パラメータの編集」（p.2-82）および「2.6.3　サイト パラメータの編集」

（p.2-71）を参照してください。

ステップ 5 Networks Mgmt Tree ビューで、ツールバーの Analyzed Network アイコンをクリックします。Cisco

MetroPlanner アイコンの詳細については、付録 A「GUI 情報およびショートカット」を参照してく

ださい。MetroPlanner Analyzer status ウィンドウに、進行状況が表示されます。または、任意のビュー

の Tasks Pane で [Analyze] をクリックします。Cisco MetroPlanner の分析ステータス バーで、ネット

ワーク分析が完了したことがわかります。ネットワークは Upgrade-Analyzed ステートで表示される

ようになります。
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（注） 現在のネットワーク レイアウトと矛盾するようなパラメータ変更を行った場合（増幅器が

到達できない出力傾き値を設定するなど）、ネットワーク分析中に Analyzer Messages ペイン

にエラー メッセージが表示され、問題を引き起こしているパラメータが示されます。警告

およびエラー メッセージを手がかりに、現在の設計に関連する問題を突き止めることがで

きます。すべてのシステム メッセージを網羅したリストについては、付録 C「システム メッ

セージ」を参照してください。

2.7.4　ネットワーク設計のパラメータ ロック解除

Locked ステートが生じるのは、パラメータに値を設定（強制適用）しないで、代わりに Auto を選

択した場合です。ネットワーク分析時に、Cisco MetroPlanner は Auto が設定された各パラメータに

値を割り当て、それらのパラメータを Locked ステートにします。Locked ステートは、次回、ネッ

トワークを分析したときに、アナライザが値を変更できないことを意味します。サイトをロックす

ると、以前のアナライザ実行結果としてサイトまたはネットワークが必要とするすべてのプリアン

プ、ブースタ、分岐挿入（add/drop）フィルタ、および DCU カードについて、存在または不在が強

制的に適用されます。ロックされた要素は、Project Explorer では閉じた南京錠のアイコンで示され

ます（図 2-49）。Auto、Forced、および Locked ステートの詳細については、「1.6　Auto、Forced、お

よび Locked パラメータ」（p.1-12）を参照してください。

図 2-49 Project Explorer に表示されたロック状態のサイト

ネットワーク コンポーネントのロックを解除してパラメータを編集するには、Project Explorer で該

当する要素を右クリックし、ショートカット メニューから Unlock を選択します。

2.7.5　ネットワーク設計の JPEG 作成

ネットワーク設計のスナップショットを JPEG フォーマットで作成する手順は、次のとおりです。

ステップ 1 NtView < 名前 > タブをクリックします。

ステップ 2 必要に応じて「2.6.14　サイトの配置」（p.2-86）を実行し、ネットワーク内のサイトが適切な配置

でタブに表示されるようにします。

ステップ 3 ツールバーの Save network view image アイコンをクリックします。

ステップ 4 Save network view image ダイアログボックスで、適切なディレクトリに移動します。

ステップ 5 File Name フィールドにファイル名を入力し、[Save] をクリックします。
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2.8　BoM の作成
BoM を作成できるのは、ネットワークが Install ステートまたは Upgrade ステートの場合、または

ネットワーク設計の分析が正常に完了したあとです。BoM は、プロジェクト作成時に選択した価格

データベースを使用して作成されます。

ここで説明する各手順を実行するには、プロジェクトを開き、ネットワークをロードしておく必要

があります。「2.1.1　プロジェクトの開き方」（p.2-3）および「2.1.2　ネットワークのロードおよび

アンロード」（p.2-4）を参照してください。

2.8.1　BoM レポートの合計表示

BoM レポートの合計を表示する手順は、次のとおりです。

ステップ 1 Networks Mgmt Tree タブをクリックし、ネットワークをクリックします。

ステップ 2 Tasks Pane で Bill of Material をクリックします。Bill of Material タブが表示されます。または、Project

Explorer ツリーの Reports フォルダから Bill of Materials を選択して、このレポートにアクセスする

こともできます。

BoM タブの上部セクション（Net ビュー、Site ビュー、および Spare サブタブ）に、次の情報が表

示されます。

• BoM total discounted ― BoM に含まれるアイテムごとに、（スペア部品を除く）ネットワーク全

体の価格が表示されます。Use global discount を選択した場合は、Global discount percentage
フィールドの割り引きが合計に含まれます。

• Spare total discounted ― ネットワーク全体について、すべてのメンテナンス センタのすべての

推奨スペア部品に相当する価格が表示されます。これは、割り引き価格を使用した、各スペア

アイテムの合計です。合計が表示されるのは、Spare Part Report チェックボックスを選択してか

らです。

• BoM + Spare total discounted ― BoM の合計割り引き価格とスペアの合計割り引き価格を合算し

た値が表示されます。

• Price List ― プロジェクト用に選択した価格表データベースの名前が表示されます。

• Price List last update ― 選択した価格表の最終更新日が表示されます。

• Currency ― 選択した価格表データベースで指定されている、各価格の通貨が表示されます。

ステップ 3 BoM の作成時に、個々のアイテムではなく、Multishelf Management Integrated Kit バンドルを使用す

る場合は、Use MSM Buldle を選択します。

ステップ 4 レポートの合計にスペア部品を含める場合は、Spare Part Report を選択します。

（注） Spare Part Report チェックボックスを選択できるのは、ネットワークが Design モードの場合

に限られます。

ステップ 5 Global discount percentage フィールドに、Default Project Options ウィンドウの Global Discount

Percentage オプションから取得したパーセントが表示されます。ネットワーク全体のグローバル

ディスカウントを変更するには、Use global discount を選択し、Global discount percentage フィー

ルドにパーセント形式で新しいグローバル ディスカウントを入力します。グローバル ディスカウ

ントは BoM のすべてのコンポーネントに適用され、Global Price List で指定された割り引きが上書

きされます。
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2.8.2　ネットワーク BoM の作成

ネットワークの BoM を作成する手順は、次のとおりです。

ステップ 1 Networks Mgmt Tree タブをクリックし、ネットワークをクリックします。

ステップ 2 Tasks Pane で Bill of Material をクリックします。Bill of Material タブ（図 2-50）が表示されます。デ

フォルトで、Net View サブタブが選択されます。検出されなかったアイテムは、BoM ではイエロー

で表示されます。

図 2-50 Bill of Material タブ、Net View サブタブ

表 2-27 で、Net View サブタブのカラムについて説明します。ウィンドウ上部のデータ、チェック

ボックス、およびフィールドについては、「2.8.1　BoM レポートの合計表示」（p.2-94）を参照して

ください。

表 2-27 BoM Net View のカラム

カラム ラベル 内容

Product ID シスコに BoM を発注するときに使用する発注コードが表示されます。

Description 製品の説明が表示されます。

Quantity BoM における特定の製品の数量が表示されます。

Unit price 各装置の価格が表示されます。価格が表示されない場合は、Invalid が表

示されます。この現象が発生するのは、価格表が一度も更新されていな

いために、アイテムに対して「NaN」（Not a Number）がレポートされた

場合です。無効なアイテムはリストにレッドで表示されます。CCO に

よって更新されていないアイテムは、イエローで表示されます。
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ステップ 3 Bill of Material レポートを閉じるには、Bill of Material タブの右隅の X をクリックします。

2.8.3　サイト BoM の作成

サイト BoM には、目的のサイトでシステムを設計どおりに動作させるために必要な、すべてのハー

ドウェアおよびソフトウェア部品が表示されます。サイトの BoM を作成する手順は、次のとおり

です。

ステップ 1 NtView < 名前 > タブをクリックして、サイトをクリックします。

ステップ 2 Tasks Pane で Bill of Material をクリックします。デフォルトで、Site View サブタブが選択されます

（図 2-51）。価格表に含まれないアイテムは、レッドで表示されます。

図 2-51 Bill of Material タブ、Site View サブタブ

Unit Discount Global Discount Percentage フィールドに指定した、装置当りの割り引き額

が表示されます。このフィールドをブランクにしておくと、Price List デー

タベースのデフォルト値が表示されます。

Total price 割り引き適用前の、製品の合計価格が表示されます。

Discounted Total Price 割り引き適用後の、製品の合計価格が表示されます。

Site # 特定のサイトに割り当てる製品数が表示されます。Site カラムの数は、

ネットワーク内のサイト数と一致します。

表 2-27 BoM Net View のカラム（続き）

カラム ラベル 内容
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表 2-28 で、Site View サブタブのカラムについて説明します。ウィンドウ上部のデータ、チェック

ボックス、およびフィールドについては、「2.8.1　BoM レポートの合計表示」（p.2-94）を参照して

ください。

ステップ 3 Bill of Material レポートを閉じるには、Bill of Material タブの右隅の X をクリックします。

2.8.4　Spare Parts レポートの作成

BoM の作成後、次の手順で、ネットワークに必要なスペア部品を調べることができます。ネット

ワークが Upgrade ステートの場合、レポートには実装するサービスおよび新しく追加された現在の

サービスをサポートするために必要な部品が含まれます。スペア部品のレポートを作成するには、

ネットワーク分析の前に、サイトとメンテナンス センタを対応付ける必要があります。詳細につい

ては、「2.6.3　サイト パラメータの編集」（p.2-71）を参照してください。

ステップ 1 Networks Mgmt Tree タブをクリックし、ネットワークをクリックします。

ステップ 2 Tasks Pane で Bill of Material をクリックします。Spare サブタブをクリックします（図 2-52）。

表 2-28 BoM Site View のカラム

カラム ラベル 内容

Name サイト名が表示されます。プラス（+）記号をクリックすると、サイトが

展開され、カテゴリが表示されます。プラス（+）記号をクリックする

と、各カテゴリが展開され、BoM アイテムが表示されます。

Product ID シスコに BoM を発注するときに使用する発注コードが表示されます。

Quantity BoM における特定のアイテムの数量が表示されます。

Unit price 各装置の価格が表示されます。価格が表示されない場合は、Invalid が表

示されます。この現象が発生するのは、価格表が一度も更新されていな

いために、アイテムに対して「NaN」（Not a Number）がレポートされた

場合です。無効なアイテムはリストにレッドで表示されます。CCO に

よって更新されていないアイテムは、イエローで表示されます。

Unit Discount Global Discount Percentage フィールドに指定した、装置当りの割り引き額

が表示されます。このフィールドをブランクにしておくと、Price List デー

タベースのデフォルト値が表示されます。

Total Price 割り引き適用前の、製品の合計価格が表示されます。

Discounted Total Price 割り引き適用後の、製品の合計価格が表示されます。
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図 2-52 Bill of Material タブ、Spare サブタブ

表 2-29 で、Spare サブタブのカラムについて説明します。ウィンドウ上部のデータ、チェックボッ

クス、およびフィールドについては、「2.8.1　BoM レポートの合計表示」（p.2-94）を参照してくだ

さい。

表 2-29 BoM Spare サブタブのカラム

カラム ラベル 内容

Name サイトのアイテム名が表示されます。メンテナンス センタを右クリック

して、ショートカット メニューから Expand All を選択すると、すべて

のスペア部品が表示されます。

Product ID シスコに BoM を発注するときに使用する発注コードが表示されます。

Quantity BoM における特定のアイテムの数量が表示されます。

Unit price 各装置の価格が表示されます。価格が表示されない場合は、Invalid が表

示されます。この現象が発生するのは、価格表が一度も更新されていな

いために、アイテムに対して「NaN」（Not a Number）がレポートされた

場合です。無効なアイテムはリストにレッドで表示されます。CCO に

よって更新されていないアイテムは、イエローで表示されます。

Unit Discount Global Discount Percentage フィールドに指定した、装置当りの割り引き額

が表示されます。このフィールドをブランクにしておくと、Price List デー

タベースのデフォルト値が表示されます。

Total Price 割り引き適用前の、部品の合計価格が表示されます。

Discounted Total Price 割り引き適用後の、部品の合計価格が表示されます。
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ステップ 3 Bill of Material レポートを閉じるには、Bill of Material タブの右隅の X をクリックします。

2.8.5　BoM のエクスポート

XML、Excel スプレッドシート、HTML、またはテキスト形式で外部ファイルに BoM をエクスポー

トする手順は、次のとおりです。

ステップ 1 Networks Mgmt Tree タブをクリックし、ネットワークをクリックします。

ステップ 2 Tasks Pane で Bill of Material をクリックします。Bill of Material タブが表示されます。

ステップ 3 Export をクリックします。BoM export ダイアログボックスが表示されます。

ステップ 4 BoM export ダイアログボックスで、ファイル名を入力し、ドロップダウン リストからファイル タ

イプ（.xls および .html）を選択して、適切なフォルダに移動します。[Save] をクリックします。
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2.9　価格表の管理
価格表はプロジェクトごとに定義し、BoM の作成時に使用します。Cisco MetroPlanner では、複数

の価格表を管理できます。プロジェクトの設定後にプロジェクトの価格表を変更することも可能で

す。Master Price リストは、米ドルで示された Global Price List です。CCO から新しい価格表をダウ

ンロードできます。

選択した価格だけがプロジェクトに保存され、実際の価格データベースはプロジェクトには保存さ

れません。保存されたプロジェクト（たとえば、別の設計者から受け取ったプロジェクトなど）を

開いた場合は、関連付けられた価格データベースを利用できないこともあります。この場合、Master

Price リストを使用することが Cisco MetroPlanner から通知されます。

メモリを保存する場合、Cisco MetroPlanner は現在のプロジェクトに選択された価格表だけを自動的

にロードします。

2.9.1　新しい価格表の作成

CCO から価格表をダウンロードする手順は、次のとおりです。CCO から価格表をダウンロードで

きるのは、現在開いているプロジェクトがない場合です。

ステップ 1 プロジェクトが開いている場合は、閉じてください。「2.1.5　プロジェクトの終了」（p.2-6）を参照

してください。

ステップ 2 Tools メニューから Price List Mgmt を選択します。Price Manager ダイアログ ボックスが表示され

ます（図 2-53）。

図 2-53 Price Manager ダイアログボックス
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ステップ 3 Price Manager ダイアログボックスで、PriceDBManager を右クリックし、ショートカット メニュー

から New Price DB を選択します。

ステップ 4 Create a New Price DB ダイアログボックスに、価格表の名前を入力します。

ステップ 5 ドロップダウン リストから、適切な CCO 価格表を選択します。

ステップ 6 [OK] をクリックします。

ステップ 7 [OK] をクリックして、CCO から更新します。

ステップ 8 CCO User Name/Password ダイアログボックスに、自分のユーザ名とパスワードを入力し、[OK] を

クリックします。Cisco MetroPlanner によって、CCO の価格表がダウンロードされます。

ステップ 9 更新が完了したら、[OK] をクリックして確認用ダイアログボックスを閉じます。PriceDBManager

ツリーに新しい価格表が表示されます。

ステップ 10 [Close] をクリックして、Price Manager ダイアログボックスを閉じます。

2.9.2　価格表の表示

価格表を表示してフィルタリングする手順は、次のとおりです。

ステップ 1 Tools メニューから Price List Mgmt を選択します。Price Manager ダイアログ ボックスが表示され

ます（図 2-53）。

PriceDB Manager ツリーに、作成されたすべての価格表が表示されます。メモリを保存する場合、

Cisco MetroPlanner はユーザが要求しないかぎり、現在のプロジェクトに選択された価格表だけを自

動的にロードします。L は、メモリに価格表がロードされ、使用可能であることを表します。U は、

価格表がメモリに現在ロードされていないので、利用できないことを意味します。

ステップ 2 価格表をロードまたはアンロードするには、価格表を右クリックし、ショートカット メニューから

Load または Unload を選択します。

ステップ 3 PriceDBManager ツリーで、該当する価格表 ID の下の PriceList をクリックします。Price Manager ダ

イアログボックス右側のペインに、リストが表示されます。Price Manager ダイアログボックス左下

に、価格表のプロパティが表示されます。

• Last update ― この価格表を CCO から最後にダウンロードした日付です。Never が表示されてい

る場合は、CCO からダウンロードするのではなく、ユーザが価格表を作成したことを意味しま

す。

• Updated by ― 価格表の更新方法が表示されます。

価格表には、次のカラムが表示されます。

• Price List ID ― 内部用

• Major Parent ID ― プラットフォームが表示されます。

• Minor Parent ID ― 装置タイプが表示されます。

• Product ID ― 特定の装置に対応する発注コードが表示されます。
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• Description ― アイテムの詳細が表示されます。

• Service Category ― 将来の使用

• List Price ― アイテムの価格が表示されます。このフィールドに NaN（Not a Number）が表示さ

れた場合、リストは一度も更新されていません。

• Major ID ― 内部用

• Minor ID ― 内部用

• Update Status ― アイテムに対する前回の更新方法が表示されます。

－ None ― 価格表が一度も更新されていないことを表します。

－ local_file ― 価格表がローカル ファイルから更新されたことを表します。

－ cco ― 価格表が CCO から更新されたことを表します。

－ user ― ユーザが価格表を直接編集することによって、価格表が手動で更新されたことを表

します。ユーザは Discount フィールドを変更できます。

• Discount ― 割引が適用される場合に、割り引き率がパーセントで示されます。このフィールド

を変更するには、新しいパーセント値を入力します。

ステップ 4 価格表で特定のアイテムを検索するには、リスト上部の Search フィールドに該当するアイテムを入

力します。入力すると、Cisco MetroPlanner によって、検索項目に合わせてリスト項目がフィルタリ

ングされます。検索オプションを選択するには、Search フィールド左側の Search Tool アイコンをク

リックし、次のいずれか 1 つを選択します。

• Column name ― 検索文字列として指定されたカラムだけを検索します。All オプションを使用

すると、すべてのカラムが検索されます。

• Case sensitive ― 検索文字列の大文字と小文字を一致させます。

• Case sensitive ― 検索文字列の大文字と小文字を無視します。

• Match from start ― カラム テキストの先頭に検索文字列があるものだけを検索します。

• Match any where ― 価格表の位置を問わず、検索文字列と一致するものを検索します。

ステップ 5 価格表のアイテムを並べ替える場合は、並べ替えの基準にするカラムをクリックします。

ステップ 6 [Close] をクリックして、Price Manager ダイアログボックスを閉じます。

2.9.3　価格表のロードおよびアンロード

メモリを保存する場合、Cisco MetroPlanner は現在のプロジェクトに選択された価格表だけを自動的

にロードします。Price Manager ダイアログボックスの価格表の横に「L」が表示されている場合は、

価格表がロードされていることを意味します。Price Manager ダイアログボックスに「U」がある場

合は、価格表がロードされていないことを表します。Cisco MetroPlanner で価格表をロードまたはア

ンロードする手順は、次のとおりです。

ステップ 1 Tools メニューから Price List Mgmt を選択します。Price Manager ダイアログ ボックスが表示され

ます（図 2-53）。

ステップ 2 価格表を右クリックし、ショートカット メニューから Load または Unload を選択します。
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2.9.4　CCO から価格表を更新する場合

CCO からまたはローカル ファイルから特定の価格表を更新する手順は、次のとおりです。現在ロー

ドされていないものを含め、すべての価格表を更新することもできます。CCO から価格表を更新で

きるのは、現在開いているプロジェクトがない場合です。

ステップ 1 プロジェクトが開いている場合は、閉じてください。「2.1.5　プロジェクトの終了」（p.2-6）を参照

してください。

ステップ 2 Tools メニューから Price List Mgmt を選択します。Price Manager ダイアログ ボックスが表示され

ます（図 2-53）。

ステップ 3 PriceDBManager ツリーで適切な価格表 ID を右クリックし、ショートカット メニューから Expand

を選択します。

ステップ 4 展開されたツリーで適切な価格表を右クリックし、ショートカット メニューから UpdateFromCCO

を選択します。

ステップ 5 Update from CCO ダイアログボックスで、Update single price list を選択し、特定の価格表に対応す

るデータをダウンロードするか、または Update all price lists を選択し、すべての価格表の最新デー

タをダウンロードします。

ステップ 6 CCO User Name/Password ダイアログボックスに、自分のユーザ名とパスワードを入力し、[OK] を

クリックします。Cisco MetroPlanner によって、価格表がダウンロードされます。

ステップ 7 更新が完了したら、[OK] をクリックして確認用ダイアログボックスを閉じます。

ステップ 8 [Close] をクリックして、Price Manager ダイアログボックスを閉じます。

2.9.5　価格表のコピー

既存の価格表をコピーすることによって新しい価格表を作成する手順は、次のとおりです。新しい

価格表には、元の価格表の属性および値（Updated By、Last Update、unit price、disounts など）がす

べて含まれます。価格表をコピーできるのは、現在開いているプロジェクトがない場合です。

ステップ 1 プロジェクトが開いている場合は、閉じてください。「2.1.5　プロジェクトの終了」（p.2-6）を参照

してください。

ステップ 2 Tools メニューから Price List Mgmt を選択します。Price Manager ダイアログ ボックスが表示され

ます（図 2-53）。

ステップ 3 PriceDBManager ツリーで適切な価格表を右クリックし、ショートカット メニューから Copy を選択

します。

ステップ 4 新しい価格表の名前を入力し、[Ok] をクリックします。PriceDBManager ツリーに新しい価格表が

表示されます。

ステップ 5 [Close] をクリックして、Price Manager ダイアログボックスを閉じます。
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2.9.6　価格表の削除

価格表を削除する手順は、次のとおりです。Master Price List またはプロジェクトで使用中の価格表

は削除できません。価格表を削除できるのは、現在開いているプロジェクトがない場合です。

ステップ 1 プロジェクトが開いている場合は、閉じてください。「2.1.5　プロジェクトの終了」（p.2-6）を参照

してください。

ステップ 2 Tools メニューから Price List Mgmt を選択します。Price Manager ダイアログ ボックスが表示され

ます（図 2-53）。

ステップ 3 PriceDBManager ツリーで適切な価格表を右クリックし、ショートカット メニューから Delete を選

択します。

ステップ 4 [Close] をクリックして、Price Manager ダイアログボックスを閉じます。

2.9.7　メンテナンス契約の表示

メンテナンス契約の表示手順は、次のとおりです。

ステップ 1 Tools メニューから Price List Mgmt を選択します。Price Manager ダイアログ ボックスが表示され

ます（図 2-53）。

ステップ 2 Maintenance Contracts を右クリックし、ショートカット メニューから Expand を選択します。

ステップ 3 ContractsList をクリックします。Contract PID カラムに、Cisco MetroPlanner が使用するハードウェ

アおよびソフトウェア部品のサービス契約 ID が表示されます。Contract Category カラムに、サービ

ス プログラムの説明が表示されます。

ステップ 4 MapPidsContracts をクリックします。PID カラムに製品 ID が表示されます。Contracts カラムに、

サービス契約 ID が表示されます。

ステップ 5 [Close] をクリックして、Price Manager ダイアログボックスを閉じます。
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	ステップ 6 Platform Parameters エリアで、次の情報を入力します。
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	ステップ 5 Notes ウィンドウを閉じるには、ウィンドウ右上の X をクリックします。
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	ステップ 1 次のいずれかの手順を実行します。
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	ステップ 4 個々のパラメータを使用してクエリーを実行する場合は、Query Definition エリアのドロップダウン リストから該当するパラメータを選択します。画面最下部の Query Preview エリア...
	表2-14 Query Dialog のフィールド

	ステップ 5 必要に応じて、次のいずれかを選択します。
	ステップ 6 Traffic Matrix レポートを閉じるには、タブの右隅の X をクリックします。
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	ステップ 4 消費電力のデータをエクスポートするには、[Export] をクリックします。Layout table export ダイア ログボックスが表示されます。ファイル名を入力し、適切なフォルダに移動しま...
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	2.5.8　 Link Availability レポートの表示
	ステップ 1 次のいずれかの手順を実行します。
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	図2-33 Optical Results タブ
	表2-18 Optical Results タブのカラム
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	ステップ 1 Networks Mgmt Tree タブをクリックし、分析するネットワークをクリックします。
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	2.6.2　 ネットワーク パラメータの編集
	ステップ 1 Project Explorer または Networks Mgmt Tree でネットワークをクリックします。
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	表2-24 サイト設計ルール

	ステップ 4 バンド パラメータを変更するには、適切なサイト インターフェイスに対応する Project Explorer で、 C-Band または L-Band をクリックします。Properties ペインに、適切な出力を入力...
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	ステップ 6 OADM パラメータを変更する場合は、該当するサイト インターフェイスに対応する Project Explorer で Add/Drop をクリックします。Properties ペインに、必要な情報を入力します。

	2.6.4　 サイトの削除
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	ステップ 3 NtView <名前> タブで、Site アイコンをクリックし、Tasks Pane から Delete を選択します。Cisco MetroPlanner アイコンの詳細については、付録 A「GUI 情報およびショートカット」を参照...
	ステップ 4 [Yes] をクリックして、サイトを削除します。

	2.6.5　 メンテナンス センタの作成
	ステップ 1 Project Explorer で、ネットワーク フォルダを右クリックし、ショートカット メニューから Expand を選択します。
	ステップ 2 Project Explorer を下にスクロールして、Maintenance Center フォルダを右クリックし、ショートカッ ト メニューから New Maintenance Center を選択します。
	ステップ 3 Project Explorer で新しいメンテナンス センタを反転表示します。
	ステップ 4 Properties ペインに、必要な情報を入力します。
	ステップ 5 メンテナンス センタとサイトの対応付けについては、「2.6.3　サイト パラメータの編集」（p.2-71） を参照してください。

	2.6.6　 ポイントツーポイント デマンドの編集
	ステップ 1 Project Explorer で、ネットワーク フォルダを右クリックし、ショートカット メニューから Expand を選択します。
	ステップ 2 Project Explorer で、ポイントツーポイント デマンドを右クリックし、ショートカット メニューから Edit を選択します。Edit Point to Point Demand ダイアログボックスが表示されます（...
	図2-41 Edit Point to Point Demand ダイアログボックス

	ステップ 3 各チャネルの情報を変更する場合は、必要な情報を入力します。
	ステップ 4 新しいチャネルを追加する場合は、Edit Point to Point Demand ダイアログボックスの右側で、Create a new circuit アイコンをクリックします。新しいローが表示されます。必要なだけス...
	ステップ 5 既存チャネルを削除する場合は、ローを選択し、Edit Point to Point Demand ダイアログボックスの右 側で、Remove the selected circuit アイコンをクリックします。
	ステップ 6 [Ok] をクリックし、チャネルの変更を保存して、Edit Point to Point Demand ダイアログボックスを 閉じるか、または [Cancel] をクリックし、変更を保存しないでダイアログボックスを...

	2.6.7　 P リング デマンドの編集
	ステップ 1 Project Explorer で、ネットワーク フォルダを右クリックし、ショートカット メニューから Expand を選択します。
	ステップ 2 Project Explorer で、P リング デマンドを右クリックし、ショートカット メニューから Edit を選択 します。Edit P-Ring Demand ダイアログボックスが表示されます（図2-42）。
	図2-42 Edit P-Ring Demand ダイアログボックス

	ステップ 3 Edit P-Ring Demand ダイアログボックスで必要な情報を入力し、P リングを変更します。
	ステップ 4 新しい P リングを追加する場合は、Edit Point to Point Demand ダイアログボックスの左側で、Create a new P-Ring circuit アイコンをクリックします。新しいローが表示されます。必要なだ...
	ステップ 5 P リングから既存チャネルを削除する場合は、ローを選択し、Edit P-Ring Demand ダイアログボッ クスの左側で、Remove the selected P-Ring cirucuit アイコンをクリックします。
	ステップ 6 [Ok] をクリックし、チャネルの変更を保存して、Edit P-Ring Demand ダイアログボックスを閉じる か、または [Cancel] をクリックし、変更を保存しないでダイアログボックスを閉じ...

	2.6.8　 ROADM デマンドの編集
	ステップ 1 Project Explorer で、ネットワーク フォルダを右クリックし、ショートカット メニューから Expand を選択します。
	ステップ 2 ROADM トラフィック グループを右クリックし、ショートカット メニューから Edit を選択します。 Edit ROADM Demand ダイアログボックスが表示されます（図2-43）。
	図2-43 Edit ROADM Demand ダイアログボックス

	ステップ 3 ドロップダウン リストからトラフィック パターン タイプ（Hub または Meshed）を選択します。 Hub を選択した場合は、First Site ドロップダウン ボタンが使用可能になります。Mes...
	ステップ 4 トラフィック タイプが Hub の場合、First Site ドロップダウン リストから起点サイトを選択します。
	ステップ 5 Connectivity type ドロップダウン リストから接続タイプを選択します。選択肢は Protected、 Unprotected Minimum Hop、Unprotected Optimum Path、および Unprotected Subnet です。接続タ イプの選択...
	ステップ 6 Service Types ペインで、ROADM デマンドに対応するクライアント サービス タイプのボックスを 1 つ以上選択します。右側のペインに、各サービス タイプをサポートするクライア...
	ステップ 7 クライアント インターフェイスの詳細を定義するために、右側のペインのローごとに、次のオプ ションを入力します。グレー表示のチェックボックスは、クライアント イン...
	ステップ 8 [Ok] をクリックして、デマンドの変更を保存します。

	2.6.9　 トラフィック デマンドの削除
	ステップ 1 Project Explorer で、ネットワーク フォルダを右クリックし、ショートカット メニューから Expand を選択します。
	ステップ 2 デマンドが Unlocked ステートになっていることを確認します。詳細については、「2.7.4　ネット ワーク設計のパラメータ ロック解除」（p.2-93）を参照してください。
	ステップ 3 Project Explorer で削除するデマンドを右クリックし、ショートカット メニューから Delete を選択し ます。または、Tasks Pane で [Delete] をクリックします。

	2.6.10　 光ファイバ スパン、ペア、および光ファイバ パラメータの編集
	表2-25 編集可能な光ファイバ プロパティ
	ステップ 1 Project Explorer で、Fibers フォルダを右クリックし、ショートカット メニューから Expand を選択 します。
	ステップ 2 Project Explorer ツリーで、次のいずれか 1 つをクリックします。Properties ペインで編集に使用でき るオプションは、選択によって異なります。
	ステップ 3 Properties ペインで、必要に応じて次のパラメータを編集します。光ファイバ スパン、光ファイバ ペア、または個々の光ファイバに関して変更できるプロパティについては、表...
	ステップ 4 必要に応じて、光ファイバ スパン、光ファイバ ペア、または個々の光ファイバについて、Properties ペインで次の合計を確認します。
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	ステップ 1 Project Explorer ツリーで、該当するネットワークの Fibers フォルダを右クリックし、ショートカッ ト メニューから Fibres Dialog を選択します。Fibres Dialog が表示されます（図2-44）。
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	表2-26 Fibres Dialog のカラム


	ステップ 2 光ファイバ スパン、ペア、または光ファイバを編集するには、Fibres Dialog で該当するアイテムを クリックします。Fibres Dialog 右側の Properties ペインに、選択したアイテムのプ...
	ステップ 3 Properties ペインで、必要に応じて次のパラメータを編集します。光ファイバ スパン、光ファイバ ペア、または個々の光ファイバに関して変更できるプロパティについては、表...
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	ステップ 1 Project Explorer ツリーで、該当するネットワークの Fibers フォルダを右クリックし、ショートカッ ト メニューから Fibres Dialog を選択します。Fibres Dialog が表示されます（図2-44）。
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	2.6.13　 光ファイバ スパンの削除
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	ステップ 3 [Yes] をクリックして、光ファイバの削除を確認します。
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